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Summary

Audience

Preface

This section provides supporting information for the Oracle Financial Services
Enterprise Case Management Application Pack (OFS ECM) Installation Guide and
includes the following topics:

¢  Summary

e Audience

e Related Documents
e Conventions

e Abbreviations

You can find the latest copy of this document in OTN Library which includes all the
recent additions/revisions (if any) done till date.

Before you begin the installation, ensure that you have access to the Oracle Support
Services Portal with the required login credentials to quickly notify us of any issues at
any stage. You can obtain the login credentials by contacting Oracle Support Services.

Oracle Financial Services Enterprise Case Management Pack Installation Guide is
intended for administrators and implementation consultants who are responsible for
installing and maintaining the Application Pack components.

Prerequisites for the Audience
The following are the prerequisites from the administrators installing OFS ECM:

This document assumes that you have experience in installing Enterprise components
and basic knowledge about the following;:

¢ OFS ECM pack components
e OFSAA Architecture

e UNIX Commands

e Database Concepts

* Web server/ Web application server
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Related Documents
This section identifies additional documents related to OFS ECM.

OFSAAI Related Documents
Following documents are available in OHC.

®  Oracle Financial Services Advanced Analytical Applications Infrastructure
Applications Pack Installation and Configuration Guide

®  Oracle Financial Services Analytical Applications Infrastructure Environment
Check Utility Guide

®  Oracle Financial Services Analytical Applications Infrastructure Administration
Guide

®  Oracle Financial Services Analytical Applications Infrastructure User Guide
OFS ECM Application Related Documents

Following documents are available in OHC.

®  Oracle Financial Services Enterprise Case Management Administration Guide
®  Oracle Financial Services Enterprise Case Management User Guide

®  Oracle Financial Services Enterprise Case Management Configuration Guide
®  Oracle Financial Services Enterprise Case Management Release Notes

The following documents are available in My Oracle Support (MOS). You should have
SSO credentials to access MOS.

®  Oracle Financial Services Analytical Applications Infrastructure Security Guide

Conventions

The following text conventions are used in this document:

Table 0-1 Conventions used in this guide

Convention Meaning

boldface Boldface type indicates graphical user interface elements
associated with an action, or terms defined in text or the
glossary.

italic Italic type indicates book titles, emphasis, or placeholder

variables for which you supply particular values.

monospace Monospace type indicates commands within a paragraph,
URLSs, code in examples, text that appears on the screen, or
text that you enter.

Abbreviations

The following table lists the abbreviations used in this document:

Table 0—2 Abbreviations and their meaning

Abbreviation Meaning

ECM Enterprise Case Management

GUI Graphical User Interface

HTTPS Hypertext Transfer Protocol Secure
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Table 0—2 Abbreviations and their meaning

Abbreviation Meaning

J2C J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

LDAP Lightweight Directory Access Protocol

LHS Left Hand Side

MOS My Oracle Support

OFSAA Oracle Financial Services Analytical Application
OFSAAI Oracle Financial Services Analytical Application Infrastructure
OLAP On-Line Analytical Processing

oS Operating System

SFTP Secure File Transfer Protocol

URL Uniform Resource Locator

Web Archive WAR

XML Extensible Markup Language
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About OFSAA and OFSAA Applications Packs

This chapter provides complete details about Enterprise Case Management (ECM)
Application Pack.

This chapter includes the following topics:
e About OFSAA

* Introduction to OFS ECM Application
e About OFSAA Infrastructure

About OFSAA

In today's turbulent markets, financial institutions require a better understanding of
their risk-return, while strengthening competitive advantage and enhancing long-term
customer value. Oracle Financial Services Analytical Applications (OFSAA) enable
financial institutions to measure and meet risk adjusted performance objectives,
cultivate a risk management culture through transparency, lower the costs of
compliance and regulation, and improve insight into customer behavior.

OFSAA uses industry-leading analytical methods, shared data model and applications
architecture to enable integrated risk management, performance management,
customer insight, and compliance management. OFSAA actively incorporates risk into
decision making, enables to achieve a consistent view of performance, promote a
transparent risk management culture, and provide pervasive intelligence.

With the help of OFSAA, the financial services organizations can achieve,
management excellence with a lower total cost of ownership, due to our integrated,
architecture, combining performance and risk applications into a single, seamlessly
integrated framework.

OFSAA delivers a comprehensive and integrated suite of financial services analytical
applications for both banking and insurance domain.

The Figure 1-1 depicts the various Applications Pack that are available across the
OFSAA Banking and Insurance domains:
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Introduction to OFS ECM Application

Figure 1-1 OFSAA Applications Packs
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Introduction to OFS ECM Application

OFS ECM Application Pack includes the following applications:

Oracle Financial Services Analytical Applications Infrastructure (OFSAAI)
powers the Oracle Financial Services Analytical Applications family of products to
perform the processing, categorizing, selection and manipulation of data and
information required to analyze, understand and report on specific performance,
risk, compliance and customer insight issues by providing a strong foundation for
the entire family of Oracle Financial Services Analytical Applications across the
domains of Risk, Performance, Compliance and Customer Insight.

Oracle Financial Services Inline Processing Engine (OFS IPE) provides real-time
monitoring, detection and interdiction of single and complex fraud events across
multiple channels and lines of business.

Oracle Financial Services Enterprise Case Management (OFS ECM) supports
the investigation and resolution of ML, KYC, Customer Screening, and third party
events. A newly created case passes through various statuses as part of
investigation and reaches closure through resolution actions. Enterprise Case
Management supports the modification of the case details and the associated
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business data. Investigation workflows can vary based upon the type of case
being investigated. The case investigation and resolution are supported by various
actions, which may be specific to the case type. Access to types of cases and
actions are controlled based on the user role and access permissions. Cases are
generated from various sources and cases are also manually created in the ECM.
Enterprise Case Management supports product default case types that drive the
Investigation workflow. Case types are configurable and can be defined by firms
to meet their business need. ECM allows to design workflows using Process
Modelling Framework.

About OFSAA Infrastructure

Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) powers the
Oracle Financial Services Analytical Applications family of products to perform the
processing, categorizing, selection and manipulation of data and information required
to analyze, understand and report on specific performance, risk, compliance and
customer insight issues by providing a strong foundation for the entire family of
Oracle Financial Services Analytical Applications across the domains of Risk,
Performance, Compliance, and Customer Insight.

Components of OFSAAI

The OFSAA Infrastructure includes frameworks that operate on and with the Oracle
Financial Services Analytical Applications Data Model and form the array of
components within the Infrastructure.

The OFSAA Infrastructure components/ frameworks are installed as two layers:
primarily the metadata server and Infrastructure services run on one layer, and the Ul
and presentation logic runs on the other. The Ul and presentation layer is deployed on
any of the supported J2EE Servers.

The Figure 1-2 depicts the various frameworks and capabilities that make up the
OFSAA Infrastructure:

Figure 1-2 Components of OFSAAI

“FormsaWorkflow T Wommgtswes

Forms Manager Open Machine Leaming

Workflow Manager Modeling Sandbox

Business Dimension Maps Scenarios & Stress Testing

ser Secu ccess ]

Run Framework

Conditional Execution

Baseline & Simulation Run

Enterprise Batch Mar

thp onalﬁg;'-ne

Business Processors
Hierarchy-Node Execution

In Data Execution

- " MartManagement |

Users Groups & Roles
550 Integration

Hierarchy Mode Anchors

Relational Mart Builder

| InRDEMS & HDFS

w

Technical Data Quality

& Movement
DataAsset Registry & Maps
Data Joins & Movement Business Data Integrity

Aggregation & Computation Data Quality Reporting

T Vetadatamgmt

Behavior Detection

Data Model & Mapping
Framework Entity Registry

Browsing Tracing Security

Open Scenarie Definitions

Streaming Data

Shared Batch/RT Engine

About OFSAA and OFSAA Applications Packs 1-3



About OFSAA Infrastructure

OFSAA Infrastructure High Availability

The current release of the OFSAA Infrastructure supports only "Single Instance"
installation for the Infrastructure components. However, the High Availability (HA)
for the Database Server and/or the Web application server clustering and deployment
are supported in this release.

This release supports Active-Passive model of implementation for OFSAAI
components. For more information, see Oracle Financial Services Analytical Applications
Configuration for High Availability- Best Practices Guide.
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2

Understanding OFS ECM Application Pack

Installation

This chapter includes the following topics:

Installation Overview

Deployment Topology

Hardware and Software Requirements
Verifying System Environment

Understanding the Installation Mode

Installation Overview

This release (8.0.5.0.0) of the OFS ECM Application Pack allows the users/
Administrators to install a new OFS ECM Application Pack 8.0.5.0.0 instance.

Figure 2-1 shows the order of procedures required to follow to install a new OFS ECM
Application Pack 8.0.5.0.0 instance.

Understanding OFS ECM Application Pack Installation 2-5



Deployment Topology

Figure 2-1 Installation Overview
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Table 2-1 provides additional information and links to specific documentation for
each task in the flowchart.

Table 2-1 OFS ECM Application Pack Installation Tasks and Descriptions

Tasks Details and Documentation

Verify Systems To verify that your system meets the minimum necessary

Environment requirements for installing and hosting the OFS ECM
Application Pack, see Verifying System Environment.

Obtain the software To access and download the OFS ECM Application Pack, see
Obtaining Software.

Configure and Execute the =~ To create the database schemas, see Configuring and Executing

Schema Creator Utility Schema Creator Utility.

Install OFS ECM Pack To install the OFS ECM Application Pack, see Installing the OFS
ECM Application Pack.

Configure OFS ECM Pack  To configure the OFS ECM Application Pack post installation,
after installation see Post Installation Configuration.

Deployment Topology

The Figure 2-2 shows the logical architecture implemented for OFS ECM Application
Pack.
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Figure 2-2 Deployment Topology
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Hardware and Software Requirements

This section describes the various Operating Systems, Database, Web server, and Web
application server versions, and other variant details on which this release of the OFS
ECM Application Pack has been qualified.

Note:

OFS ECM Application Pack installation can be performed on both Virtual and
Physical servers.

The following tables show the minimum hardware and software requirements for
installing OFS ECM Application Pack.

Configurations supported for Java 7

Table 2—-2 Configurations Supported for Java 7

Operating System

Understanding OFS ECM Application Pack Installation 2-7
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Table 2-2 (Cont.) Configurations Supported for Java 7

Oracle Linux / Red Hat e QOracle Linux Server release 6.1 and above - 64 bit

Enterprise Linux (x86-64) e QOracle Linux Server release 7.1 and above - 64 bit

Note: Same version of RHEL is supported

Oracle Solaris (SPARC) ®  Oracle Solaris v5.10 Update 11 and above - 64 bit
*  Oracle Solaris v5.11 update 3 and above - 64 bit

Shell e KORN Shell (KSH)

Note:

e If the operating system is RHEL, install the package Isb_release with one of the following
commands by logging in as root user:

e vyum install redhat-lsb-core

® vyum install redhat-1sb

Java Runtime Environment

Oracle Linux / Red Hat e Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit
Enterprise Linux

Oracle Solaris

Oracle Database Server and Client

®  Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0+) - 64 bit RAC/
Non-RAC with/ without partitioning option

®  Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1+)- 64 bit RAC/
Non-RAC with/ without partitioning option

e Oracle Database Server 12c Release 2 (12.2.0.1+)

* Enterprise Edition with Oracle Database client 12c Release 1 (v12.1.0.1+)
* Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

e Oracle Client 12¢ Release 1 (12.1.0.1+) - 64 bit

®  Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

e Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

®  Oracle R Distribution version 2.15.1, 2.15.2 or 2.15.3.(Optional)

® Oracle R Enterprise (Server) version 1.4. (Optional)

Note:

Ensure that the following patches are applied:
e Oracle Server 12¢, v12.1.0.1 -17082699

e Oracle Server 12¢, v12.1.0.2 - 20698050

e Also for latest information, see http://support.oracle.com/ , 12.1.0.2 Bundle Patches for
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

*  Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/
12.1.0.1

OLAP

Oracle Hyperion Essbase e V11.1.2.1+ (Server and Client) with Oracle 11g Database
e V11.1.2.3+ (Server and Client) with Oracle 12c Database

Oracle OLAP * V11.2.0.3+ with Oracle 11g Database
eV 12.1.0.1+ with Oracle 12¢ Database
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Hardware and Software Requirements

Table 2-2 (Cont.) Configurations Supported for Java 7

Note:

*  Oracle Hyperion Essbase and Oracle OLAP is required only if you are using the OLAP
feature of OFSA AL For Oracle OLAP, ensure that you have configured the Oracle
Database server with OLAP option.

Web server/ Web application server

Oracle Linux / Red Hat Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM
Enterprise Linux / IBM HTTP Server

AIX ® Oracle WebLogic Server 12.1.x and 12.2.x - 64 bit

Oracle Solaris e IBM WebSphere Application Server 8.5.5.9+ (Full Profile)
with IBM Java Runtime - 64 bit

*  Apache Tomcat 8.0.x - 64 bit

Note:

e OFSAA Infrastructure web component deployment on Oracle WebLogic Server with
Oracle JRockit is not supported.

Desktop Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1

Oracle Java plug-in 1.7.0+* (64- bit)

Turn off Pop-up blocker settings. For more information, see
Configuring Internet Explorer Settings

Browser e Microsoft Internet Browser 11.x, Chrome 57.x, FireFox 52.x

Office Tools e MS Office 2007/2010/2013
e  Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280%1024

Other Software

Directory Services OFSAALl is qualified on both OPEN LDAP 2.2.29+ and Oracle
Internet Directory v 11.1.1.3.0. However, it can be integrated
with other directory services software such as MS Active
Directory.

Note:

¢ Configuration of Directory services software for OFSAAI installation is optional. For
more information on configuration, see Setting Infrastructure LDAP Configuration.

*  Open LDAP must be installed on MS Windows Server machine.

Configurations supported for Java 8

Table 2-3 Configurations Supported for Java 8

Operating System

Oracle Linux / Red Hat e  Oracle Linux Server release 6.1 and above - 64 bit

Enterprise Linux (x86-64) e QOracle Linux Server release 7.1 and above - 64 bit

Note: Same version of RHEL is supported

Oracle Solaris (SPARC) ®  Oracle Solaris v5.10 Update 11 and above - 64 bit
*  Oracle Solaris v5.11 update 3 and above - 64 bit
Shell e KORN Shell (KSH)
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Table 2-3 (Cont.) Configurations Supported for Java 8

Note:

e If the operating system is RHEL, install the package Isb_release with one of the following
commands by logging in as root user:

e vyum install redhat-lsb-core

® vyum install redhat-1sb

Java Runtime Environment

Oracle Linux / Red Hat e Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit
Enterprise Linux

Oracle Solaris

Oracle Database Server and Client

Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0+) - 64 bit RAC/ Non-RAC
with/ without partitioning option

Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1+)- 64 bit RAC/
Non-RAC with/ without partitioning option

e Oracle Database Server 12c Release 2 (12.2.0.1+)

* Enterprise Edition with Oracle Database client 12c Release 1 (v12.1.0.1+)
* Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

e Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

®  Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

e Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

e Oracle R Distribution version 2.15.1, 2.15.2 or 2.15.3.(Optional)

*  Oracle R Enterprise (Server) version 1.4 (Optional)

Note:

Ensure that the following patches are applied:
e Oracle Server 12¢, v12.1.0.1 - 17082699

* Oracle Server 12¢, v12.1.0.2 - 20698050

e Also for latest information, see http://support.oracle.com/ , 12.1.0.2 Bundle Patches for
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

*  Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/
12.1.0.1

OLAP

Oracle Hyperion Essbase e V11.1.2.1+ (Server and Client) with Oracle 11g Database
e V11.1.2.3+ (Server and Client) with Oracle 12c Database

Oracle OLAP *  V11.2.0.3+ with Oracle 11g Database
eV 12.1.0.1+ with Oracle 12¢ Database

Note:

¢ Oracle Hyperion Essbase and Oracle OLAP is required only if you are using the OLAP
feature of OFSAAL For Oracle OLAP, ensure that you have configured the Oracle
Database server with OLAP option.

Web server/ Web application server
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Hardware and Software Requirements

Table 2-3 (Cont.) Configurations Supported for Java 8

Oracle Solaris

Oracle Linux / Red Hat
Enterprise Linux/ IBM AIX

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM
HTTP Server

Oracle WebLogic Server 12.1.x and 12.2.x - 64 bit

IBM WebSphere Application Server 8.5.5.9+ with bundled
IBM Java Runtime - 64 bit

Apache Tomcat 8.0.x - 64 bit

Note:

*  OFSAA Infrastructure web component deployment on Oracle WebLogic Server with
Oracle JRockit is not supported.

*  For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and
install patch 18729264 from http://support.oracle.com/.

Desktop Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1

Browser Microsoft Internet Browser 11.x, Chrome 57.x, FireFox 52.x
Oracle Java plug-in 1.7.0+* (64- bit)
Turn off Pop-up blocker settings. For more information, see
Configuring Internet Explorer Settings

Office Tools e MS Office 2007/2010/2013

Adobe Acrobat Reader 8 or above

Screen Resolution

1024*768 or 1280*1024

Other Software

Directory Services

OFSAALl is qualified on both OPEN LDAP 2.2.29+ and Oracle
Internet Directory v 11.1.1.3.0. However, it can be integrated
with other directory services software such as MS Active
Directory.

Note:

* Configuration of Directory services software for OFSAAI installation is optional. For
more information on configuration, see Setting Infrastructure LDAP Configuration.

*  Open LDAP must be installed on MS Windows Server machine.

Note:

see Appendix O.

To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8,

Table 2—4 provides the recommended software combinations for OFS ECM

Application Pack deployment.

Table 2-4 Recommended Software Combinations

Operating System | Database Web application server | Web server

Oracle Linux 5.3 up | Oracle Database Oracle WebLogic Server | Oracle HTTP Server/
to 5.10/ 6.0 and /Apache Tomcat Server | Apache HTTP Server
above

Oracle Solaris 5.10/ | Oracle Database Oracle WebLogic Server | Oracle HTTP Server/
511 /Apache Tomcat Server | Apache HTTP Server
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Verifying System Environment

Verifying System Environment

To verify your system environment meets the minimum requirements for the
installation, a Pre-Install Check utility is available within the Install Kit archive file.
This utility can also be obtained separately by contacting Oracle Support Services.

Though the system environment verification is an integral and automated part of the
installation of this software product, Oracle strongly recommends running this utility
prior to beginning the installation as part of your organization's "Installation
Readiness Verification Process".

Note: For more details on download and usage of this utility, see
Oracle Financial Services Analytical Applications Infrastructure
Environment Check Utility Guide given in the Related Documents
section.

Understanding the Installation Mode
The following modes of installation are available for the OFS ECM Application Pack.

¢ Installing in GUI Mode
¢ Installing in Silent Mode

Installing in GUI Mode

This mode launches the product installation in a Graphical User Interface (GUI)
mode. You must enter the required information on various panels within the Ul in a
user interactive format at various stages.

Note: For more information on configuration required for GUI
mode installation, see Configuring for GUI Mode Installation.

Installing in Silent Mode

This mode mandates updating the installation configuration files with required details
and performs installation in a "Silent" non user interactive format.
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Preparing for Installation

This chapter provides necessary information to review before installing the Oracle

Financial Services Enterprise Case Management (OFS ECM) Application Pack
v8.0.5.0.0.

This chapter includes the following topics:
* Installer and Installation Prerequisites
* Obtaining Software

® Performing Common Pre-Installation Tasks

Installer and Installation Prerequisites

Table 3-1 provides the list of prerequisites required before beginning the installation
for OFS ECM application. The Environment Check utility notifies you if any
requirements are not met.
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Table 3-1 Prerequisite Information

Category

Sub-Category

Expected Value

Environment
Settings

User Permission

User to have 755 permission on the directory
identified for installation (FIC_HOME).

Note: User to have 755 permission on the .profile

file

Java Settings

PATH in .profile file must be set to include
the Java Runtime Environment absolute path.
The path should include Java version (7 or 8)
based on the configuration.

Note:

Ensure that the absolute path to JRE/bin is set
at the beginning of PATH variable.

For example,
PATH=/usr/java/jrel.7 /bin:$ORACLE_
HOME /bin:$PATH

Ensure that no SYMBOLIC links to JAVA
installation are not set in the PATH variable

Oracle Database
Settings

TNS_ADMIN must be set in.profile file
pointing to appropriate tnsnames.ora file.

ORACLE_HOME must be set in .profile file
pointing to appropriate Oracle Client
installation.

PATH in .profile file must be set to include
appropriate SORACLE_HOME/bin path.

Ensure that an entry (with SID/ SERVICE
NAME) is added in the tnsnames.ora file on the
OFSAA server.
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Installer and Installation Prerequisites

Table 3-1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value
OS/File System OS Level Settings | You must set your locale to UTF-8 locale (LANG,
Settings NLS_LANG to be set in.profile). Specifying a locale

depends on your data and the operating system
installed on your system.

For example,
e  For Linux OS: export LANG=en_US.utf8

You can determine the locale on your system using
the locale -a command

export NLS_LANG=AMERICAN_

AMERICA.AL32UTEF8
File Descriptor Greater than 15000
Settings
Total Number of ~ |Greater than 4096

Process Settings

tmp space Prior to installation, ensure that sufficient free temp
space (minimum 1 GB free) is available in /tmp
directory of unix server hosting OFSECM.

Port Settings Default port numbers to be enabled on the system
are 6500, 6501, 6505, 6507, 6509, 6510, 6666, 9999,
and 10101.

Staging Area/ A directory to hold the application metadata

Metadata artifacts and additionally act as staging area.The

Repository directory should exist on the same system as the

OFSAA Infrastructure (can be configured on
different mount). However, the owner of the
installation directory mentioned above should have
RWX (read, write, and execute) permissions on this
folder.

Set 775 permission on this folder.

Note: This directory is also referred as FTPSHARE
folder.
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Table 3-1 (Cont.) Prerequisite Information

Category

Sub-Category

Expected Value

Installation
Directory

A directory where the product files will be installed.

Assign User permission to 755 on the installation
directory.

Temporary
Directory

Default temporary directory where installation files
are stored for a short period of time to support
faster installation.

e  For installation on UNIX OS, your UNIX
administrator must give you the required
read-write permissions for the /tmp directory
and disable the NOEXEC option

¢ Configure adequate space on the /tmp
directory. It is recommended that you allocate
more than 10 GB of space.

Note: If NOEXEC is enabled, the extraction of files
by the installer into the /tmp directory is prevented
and the binaries will not execute in the directory,
which will fail the installation.

Download
Directory

A directory where the product installer file will be
downloaded/ copied.

Ensure user permission is set to 755 on the
Download directory.

OS Locale

. Linux: en_US.utf8
L4 AIX: EN_US.UTF-8
. Solaris: en_US.UTF-8

To check the locale installed, execute the following
command:

locale -a | grep -i 'en US.utf'

Database Settings

Database Instance
Settings

e NLS_CHARACTERSET to be AL32UTF8
e NLS_LENGTH_SEMANTICS to be BYTE

e AVAILABLE OPEN CURSORS limit to be
greater than 4096

For an Oracle Database installation, set your Oracle
NLS_LANG environment variable to an
appropriate UTF-8 character set.

For example, setenv NLS_LANG AMERICAN_
AMERICA.AL32UTEF8

Note: For other database tunable parameters
required for OFS ECM, see Appendix Q, "Tunable
Database Parameters".

Ensure that the OLAP_USER role is available in the
database.
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Table 3-1 (Cont.) Prerequisite Information

Category

Sub-Category

Expected Value

Web application
server

WebSphere/
WebLogic/
Tomcat

Web application server should be installed and
profile/domain created.

You are prompted to enter the WebSphere Profile
path, WebLogic Domain path, or Tomcat
Deployment path during OFSAAI installation.

Note:

* See Appendix A for WebSphere Profile and
WebLogic Domain creation.

*  For deployment on Oracle WebLogic Server
12.1.3+ (64 bit) with Java 8, download and
install

18729264 from http:/ /support.oracle.com/.

Web server

Apache HTTP
Server/ Oracle
HTTP Server/

IBM HTTP Server.

This is an optional requirement. HTTP Server
Installation to be present. You are prompted to
enter the Web server IP/Hostname and Port details
during installation.

Note: See Appendix A for Web server installation.

Operating System

Solaris 11

Solaris 10

Upgrade to Oracle Solaris 11.3 with SRU09 or
higher. See https://docs.oracle.com/cd/E53394_
01/html/E54845/index.html to upgrade to SRU09
if you have a lower SRU version. Additionally,
install the required runtime libraries. For more
information, see Installing Only the Runtime
Libraries on Oracle Solaris 11.

Install the required OS patches. For more
information, see Installing the Required Oracle
Solaris 10 Patches. Additionally, install the required
runtime libraries. For more information, see
Installing Only the Runtime Libraries on Oracle
Solaris 10.

Note: In an OFSAA instance where multiple
OFSAA application packs have been installed /
deployed, it is mandatory to upgrade all OFSAA
application packs to 8.0.5.0.0 release. You should
start the upgrade of OFS ECM Application pack,
only after confirming that all of the application
packs in your OFSAA instance are available for
upgrade to 8.0.5.0.0 version. For information on
availability of the required OFSAA Application
Packs, see 2246606.1.
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Obtaining Software

Table 3-1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value

Mandatory ECM Download the following mandatory consolidated
One-off Patches one-off patches from

https:/ /support.oracle.com/
27072674 (ECM 8.0.5.0.1)
27223024 (ECM 8.0.5.0.2)
27272820 (ECM 8.0.5.0.3
27539743 (ECM 8.0.5.0.4)
27737720 (ECM 8.0.5.0.5)
27651495 (ECM 8.0.5.0.6)
27898247 (ECM 8.0.5.0.7)
27621836 (ECM 8.0.5.0.8)
27997498 (ECM 8.0.5.0.9)
28281576 (ECM 8.0.5.0.10)
28301367 (ECM 8.0.5.0.11)

Note: You must also download and apply patch 25777667 from
https:/ /support.oracle.com/.

Obtaining Software

The 8.0.5.0.0 release of OFS ECM Application Pack can be downloaded from the
Oracle Software Delivery Cloud (https://edelivery.oracle.com). You must have a
valid Oracle account to download the software.

Performing Common Pre-Installation Tasks

The common pre-installation activities that you must carry out before installing the
OFS ECM Application Pack are:

Identifying the Installation, Download and Metadata Repository
Downloading and copying the OFS ECM Application Pack Installer
Configuring for GUI Mode Installation

Extracting the Software

Setting Up Web application server

Identifying the Installation, Download and Metadata Repository
To install OFSAA Application packs, create the following directories:

OFS ECM Download Directory (Optional) - Create a download directory and
copy the OFS ECM Application Pack Installer File (archive). This is the directory
where the downloaded installer/patches can be copied.

OFS ECM Installation Directory (Mandatory) - Create an installation directory
and copy the installation files. Perform the installation from this directory. Set the
variable FIC_HOME variable in the .profile file to point to the OFS ECM Installation
Directory.
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* OFS ECM Staging/Metadata Directory (Mandatory) - Create a Staging/Metadata
Directory to copy data loading files, save data extracts and so on. Additionally,
this directory also maintains the OFSAA metadata artifacts. This directory is also
referred to as "FTPSHARE".

Note:
Assign 755 user permission to the Installation and Download Directory.

Assign 755 user permission to the Staging Directory.

Downloading and copying the OFS ECM Application Pack Installer
To download and copy the OFS ECM Application Pack Installer, follow these steps:

1. To download the OFS ECM Application Pack, log in to the Oracle Software
Delivery Cloud (https:/ /edelivery.oracle.com) with a valid Oracle account.

2. Copy the downloaded installer archive into the Download Directory (in Binary
mode) in the setup identified for OFS ECM installation.

Configuring for GUI Mode Installation

To install OFS ECM Application Pack in GUI mode, ensure that the following software
and configurations are available:

1. Install and configure any PC X Server software such as Open Text Exceed
(formerly Hummingbird Exceed) on the user desktop system from which the
installation is triggered.

2. Configure the DISPLAY variable.

Ensure to set the DISPLAY variable on the system on which the OFS ECM
will be installed, to point to the user desktop system where the PC X
Server software is installed.

Syntax:
export DISPLAY=hostname:n.nl

where hostname is the IP Address/Host Name of the user desktop sys-
tem and n is the sequence number (usually 0).

For example, 10.11.12.13:0.0 or myhostname:0.0

Extracting the Software

Note:

You must be logged in to the UNIX operating system as a non-root
user.

1. Download the unzip utility (OS specific) unzip_<os>.z and copy it in Binary mode
to the directory that is included in your PATH variable. If you already have the
unzip utility to extract the contents of the downloaded archive, skip this step.

2. Uncompress the unzip installer file with the command:

uncompress unzip_<os>.Z
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Note:

If an error message "uncompress: not found [No such file or
directory]" is displayed when the package is not installed, contact
your UNIX administrator.

3. Assign EXECUTE permission to the file with the command:
chmod 751 unzip_<0S>
For example, chmod 751 unzip_sparc

4. Extract the contents of the OFS ECM Application Pack 8.0.5.0.0 installer archive
file in the download directory with the following command:

unzip OFS_ECM_PACK.zip

Note

Do not rename the Application Pack installer folder name on
extraction from the archive.

5. Navigate to the download directory and assign execute permission to the installer
directory with the following command:

chmod -R 755 OFS_ECM_PACK

Setting Up Web application server

For setting up the environment based on your selected Web application server, see
Configuring Web application servers.
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Installing OFS ECM Application Pack

This chapter describes the steps to be followed to install the OFS ECM Application
pack depending on the offline and online modes of installation.

Note: If you are installing an Application Pack on an environment, where another
Applications Pack is already installed, you may sometimes get a warning message
such as Object Already Exists. This message can be ignored.

This chapter includes the following sections:

* About Schema Creator Utility

¢ Configuring and Executing Schema Creator Utility
¢ Installing the OFS ECM Application Pack

* Verifying Installation

About Schema Creator Utility

Creating database users/schemas is one of the primary steps in the complete OFS
ECM installation. This release of OFSAA provides a utility to quickly get started with
the OFSAA 8.0.5.0.0 installation by allowing easier and faster creation of database
User(s)/ Schema(s), assign the necessary GRANT(s), and so on. Additionally, it also
creates the required entities in the schemas and so on.

The schema creator utility must be configured and executed before installation of any
OFSAA Application Pack.

This section includes the following topics:
¢ Configuring Schema Creator Utility
* Selecting Execution Modes in Schema Creator Utility

* Selecting Execution Options in Schema Creator Utility

Configuring Schema Creator Utility

The schema creator utility should be configured and executed mandatorily every time
prior to installation of any OFSAA Applications Pack.

The types of schemas that can be configured are:

* CONFIG - This schema holds the entities and other objects required for OFSAA
setup configuration information.
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Note: There can be only one CONFIG schema per OFSAA instance.

e ATOMIC - This schema holds the data model entities. One ATOMIC schema is
attached to one Information Domain.

Note: There can be multiple ATOMIC schemas per OFSAA Instance
and an Information Domain can have only one ATOMIC schema.

Selecting Execution Modes in Schema Creator Utility

Schema creator utility supports the following modes of execution:

® Online Mode: In this mode, the utility connects to the database and executes the
Data Definition Language (DDL) for User, Entities, and GRANTS.

Note: To execute the utility in Online mode, you need to connect as
"<User> AS SYSDBA".

e Offline Mode: In this mode, the utility generates an SQL script with all the
required DDLs for User, Entities and GRANTS. This script must be executed by
the DBA on the appropriate database identified for OFSAA usage.

Note: For running the sql script generated in offline mode, the script
should reside in the same directory where the 'SQLScripts' directory is
available.

Note:

1. To execute the utility in Offline mode, you must connect as a user
with the following GRANTS (alternatively, you can also connect
as a user with SYSDBA privileges):

e SELECT ON DBA_ROLES

e SELECT ON DBA_USERS

e SELECT ON DBA_DIRECTORIES
e SELECT ON DBA_TABLESPACES
e CREATE SESSION

2. Do not modify the OFS_ECM_SCHEMA_OUT . XML file generated after
the execution of this utility

3. If there are any errors during the SQL script execution,
reconfigure the OFS_ECM_SCHEMA_IN.xml file and execute the
utility. This regenerates the scripts with corrected information. See
Configuring OFS_ECM_SCHEMA_IN.xml File.

4. Do not keep any backup files of xml's in the download directory.

4-22 Oracle Financial Services Enterprise Case Management Application Pack



Configuring and Executing Schema Creator Utility

Selecting Execution Options in Schema Creator Utility

Depending on the option selected to run the OFSAA Applications Pack installer, you
must select the appropriate schema creator utility execution option. To run the OFSAA
Applications Pack installer in Silent mode, it is mandatory to execute the schema
creator utility with -s option.

Note: If the schema creator utility is executed without the option -s,
it is mandatory to run the OFSAA Applications Pack Installer in GUI
mode.

Configuring and Executing Schema Creator Utility

This section includes the following topics:

Prerequisites

Prerequisites

Configuring Schema Creator Utility
Executing the Schema Creator Utility
Veritying the Schema Creator Log Files

Note: If you intend to use Oracle OLAP feature, execute the below
grant on all ATOMIC schema(s): grant olap_user to &database_
username.

The prerequisites you must have before configuring the Schema Creator Utility are:

Oracle User ID/Password with SYSDBA privileges
JDBC Connection URL for RAC/Non RAC database
HOSTNAME/IP of the server on which OFSAA is being installed.

TNSNames.ora should have entry for the database planning to install the Database
objects.

Configuring Schema Creator Utility

This section explains the steps to configure the Schema Creator Utility.

Note: The extracted media pack folder name must not be changed.

To configure the Schema Creator Utility, follow these steps:

1.

2
3.
4

Log in to the system as non-root user.
Navigate to the following path: OFS_ECM_PACK/schema_creator/conf directory.
Edit the OFS_ECM_SCHEMA_IN.xml file in a text editor.

Configure the following elements as described in the section Configuring OFS_
ECM_SCHEMA_IN.xml File:

Save the OFS_ECM_SCHEMA IN.xml file.
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Note: On successful execution of the utility, the entered passwords
in the OFS_ECM_SCHEMA_IN.xml file are nullified.

Do not clean up the OFS_ECM_SCHEMA_OUTPUT.xml file
post-installation as it would be required in future patch installations
and upgrades.

Note: While editing the OFS_ECM_SCHEMA_IN.xml, ensure only the
values/tag attributes mentioned in must be modified and none of
other tags should be modified.

Do not modify the following list of attributes:

e APP_PACK_ID

e SCHEMA. APP_ID

e SCHEMA. DEFAULTTABLESPACE
e SCHEMA.TYPE

e TABLESPACE.NAME

Executing the Schema Creator Utility

You can execute the schema creator utility in Online mode or Offline mode. This
section includes the following topics:

Executing the Schema Creator Utility in Online Mode
Executing the Schema Creator Utility in Offline Mode
Executing the Schema Creator Utility with -s Option

Executing the Schema Creator Utility while Installing Subsequent Applications
Pack

Executing the Schema Creator Utility in Online Mode

In Online mode, the Schema Creator Utility creates all the Schemas, Schema Objects,
and GRANTS in the database during the execution process.

To execute the schema creator utility in Online mode, follow these steps:

1.
2.
3.

Log in to the system as non-root user.
Navigate to the following path: OFS_ECM_PACK/schema_creator/bin/
Execute the osc. sh file using the following command:

./osc.sh

The following message is displayed: You have chosen ONLINE mode. Triggering
the utility in ONLINE mode will execute the DDLs directly on the Database. Do
you wish to proceed? (Y/y or Nin).

Enter Y/ y to proceed with the script generation.
Enter the DB Username with SYSDBA Privileges. For example: SYS as SYSDBA.

Enter the User Password.
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Figure 4-1 Schema Creation - Online Mode

Note: On successful execution of Schema Creator utility, the console displays
the following status message:

Schema Creator executed successfully. Please proceed with the installation.

See log file in OFS_ECM_PACK/schema_creator/logs directory for
execution status. If there are any errors, contact Oracle Suport
Services.

Executing the Schema Creator Utility in Offline Mode

In Offline Mode, the Schema Creator Utility creates an output in the SQL file format.
This script must be executed manually by logging as database user with SYSDBA
privileges. The SQL file contains the creation of Schemas, Schema Objects, and Roles.

Prerequisites:

To execute the utility in Offline mode, you must connect a database user with the
following GRANTS (Alternatively, you can also connect as a user with SYSDBA
privileges):

e SELECT ON DBA_ROLES

¢ SELECT ON DBA_USERS
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[ )

[ )

[ )

SELECT ON DBA_DIRECTORIES
SELECT ON DBA_TABLESPACES

CREATE SESSION

Note: Explicit GRANTS to the user are required. GRANTS assigned
through Roles are not supported

To execute the schema creator utility in Offline mode, follow these steps:

1.
2.
3.

Log in to the system as non-root user.

Navigate to OFS_ECM_PACK/schema_creator/bin directory.
Execute the osc.sh file using the following command:
./osc.sh -o

Enter Y /y to generate the script.

The following message is displayed: You have chosen OFFLINE mode. Triggering
the utility in OFFLINE mode will generate the script. Do you wish to proceed?
(Yly or Nin).

Enter the DB Username with SELECT privileges.

Enter the User Password.

Figure 4-2 Schema Creation - Offline Mode

The console runs the initial validation checks and displays the following message:
You have chosen to install this Applications Pack on <Name of the Atomic
Schema>ATOMIC schema. Do you want to proceed? (Y/N).

Enter Y/y to start the script generation. The following message is displayed. You
have chosen to install this Applications Pack on <Name of the Infodom>. Do you
want to proceed? (Y/N)).
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Note: On successful execution of schema creator utility, the console displays
the following status message:

Success. Please execute OFS_ECM_PACK/schema_creator/sysdba_
output_scripts.sql before proceeding with the installation.

Figure 4-3 Schema Creation - Offline Mode

10. Navigate to the directory:
OFS_ECM_PACK/schema_creator

11. Open the sysdba_output_scripts.sql file and modify SET PAGESIZE 0 FEEDBACK
OFF VERIFY OFF HEADING OFF ECHO OFF to SET PAGESIZE 0 FEEDBACK OFF
VERIFY OFF HEADING OFF ECHO OFF SQLBLANKLINES ON.

12. Login to SQLPLUS with a user having SYSDBA Privileges.
13. Execute the sysdba_output_scripts.sql file using the following command:

SQL>@sysdba_output_scripts.sqgl

Figure 4—-4 Schema Creator - Offline Mode

Alternatively, you can copy the sysdba_output_scripts.sql file and
SQLScripts directory to a remote server and execute sysdba_output_scripts.sql
file.
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Note: See log sysdba_output_scripts.log file for execution status.
If there are any errors, contact Oracle Support Services. SQL Scripts
folder and SQI file should reside in the same folder.

14. Once the above file gets executed, a warning is displayed as shown in the above
screen.

15. Run the following scripts in config schema:
1. Navigate to the <OFS_ECM_PACK>/schema_creator/SQLScripts/oracle folder.
2. Connect to the config schema through sqlplus
3. Execute the @compile_objects.sgl command.
4

Commit the change.

Executing the Schema Creator Utility with -s Option

If you want to run the OFS ECM Application Pack Installer in Silent mode, it is
mandatory to execute the schema creator utility with -s option.

To execute the utility with -s option, follow these steps:

1. Edit the file OFS_ECM_PACK/schema_creator/conf/0OFS_ECM_SCHEMA_IN.xml in text
editor.

2. Set the value for attribute "INFODOM" of <SCHEMA> tag(s) to specify a specific
Information Domain name. By default, the value is empty and the utility derives
the Information Domain name. If the attribute value is set, the utility/ installer
configures the Information Domain against this <SCHEMA>.

3. Execute the utility with -s option.

For example . /osc.sh -s

Figure 4-5 Schema Creator with - s option

Note: If the utility is executed without the -s option, it is mandatory
to launch the OFSAA Application Pack Installer in GUI mode.
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Note: To execute the utility in OFFLINE mode with Silent option, type
./osc.sh -0 -s

Executing the Schema Creator Utility while Installing Subsequent
Applications Pack

While executing the schema creator utility for subsequent Applications Pack, you can
choose to install the pack either on the same Information Domain/Atomic Schema or
on a new Information Domain/Atomic Schema. You can execute the Schema Creator
Utility either in Online or Offline mode.

To execute the schema creator utility while installing OFS ECM Pack over an existing
Application Pack, follow these steps:

1. Perform the steps 1 to 5 from the Executing the Schema Creator Utility section.

Note: On successful execution of Schema Creator utility, the console
displays the following status message:

Success. Please proceed with the installation.

See the log file in OFS_ECM_PACK/schema_creator/logs directory for
execution status, if scripts are executed in online mode.

See the log sysdba_output_scripts.log for execution status, if
executed in offline mode.

If there are any errors, contact Oracle Support Services.

Verifying the Schema Creator Log Files

You can verify the log files for any errors faced during the schema creation process in
the following location: OFS_ECM_PACK/schema_creator/logs.

Installing the OFS ECM Application Pack

This section prvides instructions to install the OFS ECM Application Pack depending
on the mode of installation.

¢ Installing in Silent Mode
¢ Installing in GUI Mode

Installing in Silent Mode

In the Silent Mode Installation you must configure the product XML files and follow
instructions in the command prompt.

Configuring OFSAAI_InstallConfig.xml

Follow these instructions to configure OFSAA_InstallConfig.xml file:
1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the
following:

FIC_HOME=< OFSAA Installation Directory >
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export FIC_HOME
Execute the user .profile.
Navigate to the file: OFS_ECM_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml

Configure the OFSAAI_InstallConfig.xml as mentioned in the section
Configuring OFSAAI_InstallConfig.xml file. Set the InteractionVariable parameter
values manually as mentioned in the table. If a value is not applicable, enter NA
and ensure that the value is not entered as NULL.

Configuring InstallConfig.xml
To configure the InstallConfig.xml file, follow these steps:

1. Navigate to the file: OFS_ECM_PACK/OFS_ECM/conf/InstallConfig.xml
2. Enter the details mentioned in the tags (<!-- Start: User input required for silent
installer. --> and <!-- End: User input required for silent installer. -->) as
mentioned in the following table.
Table 4-1 InstallConfig.xml Parameters
Placeholder Name Significance and Expected Value Mandatory
#OFS_ECM_BASE _ ISO country code to use during data ingestion to record Yes
COUNTRY## institution-derived geography risk on parties on transactions
that are internal to the OFSECM client.
For example: base_country=US
base_country=US
##OFS_ECM_ Jurisdiction to assign the derived entities and derived addresses. |Yes
DEFAULT_ For example:
JURISDICTION## ple

default_jurisdiction=AMEA

##OFS_ECM_SMTP_
HOST##

Hostname of the e-mail gateway to be used by the application for |Yes
e-mail notifications.

For example:
smtp_host=mailhost.domain.com

smtp_host=mailhost.domain.com

#OFS_ECM_NLS_

#OFS_AML_NLS_LENGTH_SEMANTICS#NLS_LENGTH_ Yes

LENGTH_ SEMANTICS database variable for executing the DDL scripts.
SEMANTICS# Applicable values are CHAR/BYTE.

Note: Recommendation to go with CHAR.
##OFS_ECM_ Name of the Analyst Data source used for Admin Tools Yes
ANALYST_DATA_ Configurations.
SOURCE##

For example: Create a data source with name ANALYST

##OFS_ECM_MINER _
DATA_SOURCE##

Name of the Miner Data source used for Admin Tools Yes
Configurations

For example: Create a data source with name MINER

#OFS_ECM_
CONFIGURE_OBIEE##

Mention flag as “1” to configure OBIEE URL. Yes

Otherwise mention as ‘0’

##OFS_ECM_OBIEE_
URL#H#

In case ##O0FS_AMI,_CONFIGURE_OBIEE_URL## mentioned as Yes
‘1"...provide the URL in the pattern
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Table 4-1 (Cont.) InstallConfig.xml Parameters

Placeholder Name Significance and Expected Value Mandatory
#OFS_ECM_CS_ If the data is from same database then pass the schema name: Yes
SOURCE## .

For example, Atomic Schema : CS_ATOM
##OFS_ECM_CS_ then
LOADTYPE##</ 4

<Variable name="CSSOURCE">CS_ATOM</Variable>
<Variable name="'"CSLOADTYPE''></Variable>

If the data is from different database then pass the DBLINK_
NAME'.....LOADTYPE = DBLINK

For example,
<Variable name="AMLSOURCE">AMLDBL</Variable>
<Variable name="AMLLOADTYPE">DBLINK</Variable>

Similarly, configure the following placeholders depending on
your requirement:

##OFS_ECM_AML_SOURCE##
#H#OFS_ECM_AML_LOADTYPE##
##OFS_ECM_KYC_SOURCE##

#H#OFS_ECM_KYC_LOADTYPE##

Running the installer in Silent Mode

To install the OFSAA Infrastructure in Silent mode for java 7 and java 8, follow these
steps:

1. Navigate to the OFS_ECM_PACK/bin folder.
2. Execute the command in the console:

./setup.sh SILENT

Completing the installation in Silent Mode

On launching the installer in silent mode, the environment check utility is executed.
Enter the required information to execute the utility as explained:

Note: The above table item is asked if environment check utility is
executed in the standalone mode.
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Note:

¢  Enter the Infrastructure FIP/SFIP password value, when prompted at
the command prompt to access Product Staging/Metadata repository directory in
the application server.

* Enter Always, when prompted to add host key fingerprint.

1. The OFSAAI License Agreement is displayed as shown in the figure:
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Figure 4-6 OFSAAI License Agreement Page

Start of Environment Checks

/ecratch/ofsaadb/inataller/OFS ECM PACK/QFS ECM/conf

File log4j.xml not found. Using default logging settings

Required JAVA ion is

ersion validation status: 5

0687
00 ¥B

ISE SPACE.

hecking
ble Temp Space is 25032 MB
Temp Space i
n for categor

KRR R KRR R KRR R R RRE KRR R AR KRR R AR KRR R AR KRR R AR KA AR AR AR ARRRRRRARRRRRRR AR A RRRRRAR
APEYn AOOTTALTTAN DURT T TATVET AT -
OFSAA RPPLICATION PACE LICENSE AGREEMENT
R R R AR R AR AR R AR AR R AR R AR R AR R AR R AR R AR R AR R R AR A AR R AR KA AR AR AR AR AR AR RRAR

# Qracle Financial 3ervices Analytical Applications (CFSAR) application packs are groups of CFSAA
cation pack containg OFSAA applications that address specific functional domains.*
application pack also includes the following OFSAR inf

products packaged together into & single installer. Each ap

installed by every application pack ins

1. Oracle Finan
. Oracle Fin
3. Oracle Fi

. Oracle F.

[ ]

is the base infrastructure for all OFSAR applications and is therefore automat

if any application that

ical Applications Infrastructure, Oracle Financial Services

ial Services Big Data Processing are individually licensable app
lication options.*

# Application products once enabled
uct License(s)" feature of the platform.*

"Manage CFSAA Prod

2. Enter Y/y to accept the License Agreement.

Note: SYSADMN and SYSAUTH are the two default OFSAAI
administrative users created.
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R RRRR R AR AR R AR R R AR AR AR AR R AR R R AR R R R R AR R AR AR R AR AR AR AR R AR AR AR R R R R R AR AHR
Are you accepting the terms and conditions mentioned above? [Y/N]:
Starting installation...
g to install...
the installation resources from the installer archive...
g the installer for this system's environment..

g instal

Preparing SILENT Mode Installation...

nfrastructure (created with InstallAnywhere

Installation Complete.
.profile executed
.profile executed

R R R R R R R R R R R AR R AR R R AR AR R AR R R AR R AR R AR R RN RR AR RN

Welcome to OF5 ECM PACK Installation

OFSRA Service...

g the installer for this system's e

Preparing SILENT Mode Installation...

pack installsilent (created with InstallAnywhere

Installation Complete.
.profile executed

Note: The installation process continues on the console. Do not close
the console until the installation process is complete.

Execute .profile from user home directory after the installation is
completed.
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3. Perform steps mentioned in the Verifying Installation section.

Installing in GUI Mode

Note: Ensure that you have followed the steps as mentioned in the
Configuring for GUI Mode Installation section prior to proceeding with
the next steps.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the
following:

FIC_HOME=<OFSECM Installation Directory>
export FIC_HOME
3. Execute the user .profile file.

4. Navigate to the OFS_ECM_PACK/bin folder.

5. Execute ./setup.sh GUI in the console.

Note: If the Precheck is successful, the installation begins. Else the
installation aborts.

Figure 4-7 License Agreement

License Agreement

Welcome to the OFSAA Application Pack Installation

(O Frelnstall Setup This program will guide you through the installation of OFSAX Application Pack,
(D Installation..

[O Install Complete

Copyright © 1993, 2017, Oracle and / or its affiliates. All rights reserved,

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by
intellectual property laws, Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate,
hroadcast, modify, license, transmit, distribute, exhibit, perform, publish or display any part. in any form, or by any means. Reverse engineering,
disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be errorfree, If you find any errors, please report them
to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following
notice is applicable:

U.S. GOVERMMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, andfor
documentation, delivered to U.S. Government end users are "commercial computer software” pursuant to the applicable Federal Acquisition Regulation
and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any
operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license
restrictions applicable to the programs. Mo other rights are granted to the U.S. Government,

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in
any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in
dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe
use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

This software or hardware and docurnentation may provide access to or information on content, products, and services from third parties. Oracle
Corporation and its sffiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and
services, Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of
third-party content, products, or services.

ORACLE
FIANCIAL SERVICES

(1 1 accept the terms of the License Agreement

@) | do HOT accaptthe terms of the License Agreement

6. Select I accept the terms if the License Agreement option.
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7. Click Next.

The Financial Services Enterprise Case Management Application Pack details
window is displayed.

Figure 4-8 Financial Services Enterprise Case Management Applications Pack Details

Financial Services Behavior Detection Applications Pack

Application Pack ID : OFS_BD_PACK .
|9 Preinstall Setup - ORrRACLE
[D Installation.. Application Pack Hame : Financial Services Behavior Detection Applications Pack “FINANCIAL SERVICES
[D Install complate ANALYTICAL APPLICATIONS

Application Pack Version :5.0.4.0.0
The following products are available in this application pack:
Financial Services Analytical Applications Infrastructure
Financial Services Inline Processing Engine
Financial Services Anti Money Laundering
Financial Services Fraud
Financial Services Fraud Enterprise Edition
Financial Services Trader Compliance
Financial Services Trade Blotter
Financial Services Personal Trading Approval
Financial Services Broker Compliance
Financial Services Energy and Commodity Trading Compliance
Financial Services Enterprise Case Management
Financial Services Know Your Customer
Financial Services Currency Transaction Reporting
Financial Services Foreign Account Tax Compliance Act Management

Financial Services Common Reporting Standard

ORACLE
FIVANCAL SERVICES

Notes:
1. Select the productis you have licensed and click “Mext" to proceed

2. Product Analytical Applications Infrastructure does not needto be sslectad explictly. This product is the base infrastructure and gets installed automatically.

3. Product Erterprise Maodeling Option would get enabled / inatalled automatically if ather productis) has dependert license.

Erevious

Note: Financial Services Analytical Applications Infrastructure is
selected by default.

8. Select the product for which you have already obtained the license(s).
9. Click Next. The License Agreement page is displayed.
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Figure 4-9 Financial Servcies Enterprise Case Management Application Pack License
Agreement Window

Financial Services Behavior Detection Applications Pack License Agreement

Installation and use of Financial Services Behavior Detection Applications Pack Installer requires acceptance of the following license
QFSAA APPLICATION PACK LICENSE AGREEMENT

| Freinstall Setup
(D Installation.,
(2 Install cComplete

Oracle Financial Services Analytical Applications (OFSAA) application packs are groups of OFSAA products packaged tegether into a single installer,
Each application pack contains OFSAL applications that address specific functional domains,

Ewvery application pack also includes the following OFSAL infrastructure application options which are automatically installed by every application pack
installer:

1. Oracle Financial Services Analytical Applications Infrastructure

2. Oracle Financial Services Enterprise Modeling

3. Oracle Financial Services In-line Processing Engine

4. Oracle Financial Services Big Data Processing
Oracle Financial Services Analytical Applications Infrastructure (OFS AAl) is the base infrastructure for all OFSAL applications and is therefore
autornatically installed and enabled by the application pack installer.

The application pack installer always installs Oracle Financial Services Enterprise Modeling, Oracle Financial Services In-line Processing Engine and
Oracle Financial Services Big Data Processing application options aleng with the application pack applications, but enables them only if any application
that requires their functionality is enabled.

Any OFSAA application that is enabled must be licensed for use, Oracle Financial Services Analytical Applications Infrastructure, Oracle Financial
Services Enterprise Modeling, Oracle Financial Services In-line Processing Engine and Oracle Financial Services Big Data Processing are individually
licensable application options.

Application products once enabled cannot be disabled. Application products not enabled on installation, may later be enabled using the "Manage
0FSAA Product License(s)” feature of the platform.

ORACLE
FIVANCAL SERVICES

(@) | accept the terms of the License Agreement

i) 1 do NOT accept the terms of the Licenss Agreement

m

Erevious

10. Select I accept the terms of the License Agreement option.
11. Click Next.

The Pre Installation Summary window is displayed.
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Figure 4-10 Pre Installation Summary

Pre Installation Summary

Please review the following before continuing:

D Preinstall Setup

(3 Installation.. Application Pack ID
OF5_BD_PACK
[ Install Complete
Application Pack Name
Financial Senvices Behavior Detection Applications Pack

Application Pack Version
80400

Below products are selected to be enabled:

Financial Senvices Analytical Applications Infrastructure
Financial Services Inline Processing Engine

Financial Services Anti Money Laundering

Financial Services Fraud

Financial Services Fraud Enterprise Edition

Financial Senvices Trader Compliance

Financial Services Trade Blotter

Financial Services Personal Trading Approval

Financial Services Broker Compliance

Financial Services Energy and Commodity Trading Compliance
Financial Senvices Enterprise Case Management

Financial Services Know Your Customer

Financial Services Currency Transaction Reporting

Financial Services Foreign Account Tax Compliance Act Management
Financial Services Common Reporting Standard

ORACLE
FIVANCIAL SERVICES

Cance| Previous

12. Click Next.
The Manage Information Domains window is displayed.

Note: See Table 4-1 and provide appropriate values in the screen. All fields are
mandatory.
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Figure 4-11 Manage Infodoms

Manage Information Domains

DB Schema

Information Domain Description

Application Name

Information Domain N...

2 Prelnstall Setup
(© Installation..
(D Install Complete

ORACLE

FINANCIAL SERVICES

13. Edit the Information Domain Name if it is a new Information domain or if you
want to change the name of the information domain name.

Note: In case of subsequent Applications Pack installation on the
same Information Domain, you cannot edit the name Permissible
length is 16 characters and only alphanumeric characters allowed. No
special characters allowed.
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Figure 4-12 Pre-Pack Panel Template

Pre-Pack Panel Template

Enter Base Country

us
& Preinstall Setup

(O Installation.,
[ Install complete

Enter Default Jurisidiction
(AME A

Enter SMTF Host
mailhost.us.oracle.com

Enter RMI Port for Scenario Wizard

18100
Select Partition Date Format
[DO-MM-Y
(Configure OBIEE server URL(Select 1 for Yes/O for Mo) A
Enter OBIEE Server Url(Ex:=protocol=://=<ipaddress==<port=)
Select NLS_LEMGTH_SEMANTICS
- = ICHAR

Select Week End Holiday Pattern
[Saturday, Sunday

Enter Current Business Day OR Initial Business Day For Data To Load(in dd/mmtnyyy format, Ex 10/12/2009) hanom01s

Enter Date Of Saturday After Friday Of Current Business Week OR Initial Business Week For Data To Be Loaded(in
ddimmiyyyy format, Ex 1941 2/2000] 19/12/2015

Enter Date of Mext Business Month {in ddimmnny format, Ex 01/01/2010)

01/01/20186
Enter the Analyst Data source name

lanalyst
Enter the Miner Data source name

miner

Enter the User Id for Services
[fest

Enter the Password for Services
betex

ORACLE
FIANCIAL SERVICES

FPrevious

14. Click Next. The License Agreement window is displayed.
Figure 4-13 License Agreement Window

License Agreement

Welcome to the OF5AA] Installation

This programwill gquide you through the installation
Installation. . of OFSAM Infrastructure,

Install C let
Tl e Copyright ® 1993, 2017, Oracle and / or its
affiliates. All rights reserved.

This software and related documentation are
provided under a license agreament containing
restrictions on use and disclosure and are protected
byintellectual property laws, Except as exprassly
permitted in your license agreement or allowed by
law, wou may not use, copy, reproduce, translate,
ORACLE broadcast, modify, license, transmit, distribute,

FINANCIAL SERVICES @ | acceptthe terms of the License Agreement
D | do HOT acceptthe terms of the License Agreement

15. Select I accept the terms of the License Agreement option.

16. Click Next. The License Details page is displayed.
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Figure 4-14 License Details Page

License Details

Product Name:
OFSAAInfrastructure

Installation

Install Complete

Version
8.0.5.0.0

Operating System
Linux

Relational Database
QOracle

Licensed Locale

ORACLE’ en_US
FINANCIAL SERVICES

InstallAnywhere

17. Click Next. The User Installation Directory window is displayed.

Figure 4-15 User Installation Directory

User Installation Directory

i License User Installation Directory
3 Prelnstall Setup Jscratchfofsaadh; OFSAL|

() Installation..
Install Complete

ORACLE’
FINANCIAL SERVICES

Install A

Note: The User Installation Directory path is auto-populated from the
path you have set in the user .profile file in step 2.

18. Click Next. The OFSAA Infrastructure Server Details window is displayed.
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Figure 4-16 OFSAA Infrastructure Server Details

OFSAA Infrastructure Server Details

License Enter requested information :

=@ Prelnstall Setup
Mote: If the |DBC_URL is of RAC type then DB Server

D Installation.. IP/Hostname field name should be MA,
Install Complete

OF5AAl Server IP f Hostname :
|whf00b|s.in.0rac|e.com

Database Server IP f Hostname :
|wthDari.in.0racIe.com

ORACLE’
FINANCIAL SERVICES

Installanywhere
Frevious

19. Enter the IP address or hostname of the OFSAAI server and Database server.

20. Click Next. The Web application server window is displayed.
Figure 4-17 Web application server

Web Application Server

) License Choose the Web Application Server tyoe
= Prelnstall Setup
L) Installation..

() Install Complete

2 Tomcat

® [WehSphere
) Wehlogic

ORACLE
FINANCIAL SERVICES

|1t ere

21. Select the appropriate Web Application server type. The options are Tomcat,
WebSphere, and WebLogic.

22. Click Next. Based on the selection, corresponding screens are displayed.

For WebSphere: The WebSphere Setup Details window is displayed.
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Figure 4-18 WebSphere Setup Details

WebSphere Setup Details

P License Enter Weh3phere installation Path up to the Host name directony
=¥ Prelnstall Setup For Ex:- fdaraz jtestf/WekhspherefAppServerfprofilesf <Profile_MNa

() Installation me = finstalledAappsf <cellMame >

[ Install Complete

,.fscratchjwas?,leM;WebSphere;AppServerjprofiles;Profsa?B3|

ORACLE’
FINANCIAL SERVICES

23. Enter the installation path (up to the host name directory) of the WebSphere. The
format is <WebSphere profile directory>/installedApps/<NodeCellName>.

For Tomcat: The Absolute Tomcat Path window is displayed.

Figure 4-19 Absolute Tomcat Path

Absolute Tomcat Path

) License Enter absolute Tomcat Installation path where Oracle Financial
=¥ Prelnstall Setup Senvices Anabdical Applications Infrastructure is to be deploved.

Installation:: Example: - fhomefdatal ftomcat-7.0. 19 fwebapps

() Install Complete

ORACLE’
FINANCIAL SERVICES

Prewious

24. Enter the Tomcat installation path (till/webapps) where OFSAAI will be
deployed.

For WebLogic: The WebLogic Home window is displayed.
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Figure 4-20 WebLogic Home

Weblogic Home

License Enter Weblogic Home
= Preinstall Setup For Bx: /homesweblogic/heaiweblogic 10.3.5.0

() Installation..
[ Install Complete

/scratch/wll 2.1, 3/0racle/Middleware/Oracle_Homefwlserver] |

ORACLE’
FINANCIAL SERVICES

InstallAnywhe

25. Enter the WebLogic home directory path.

Figure 4-21 WebLogic Setup Details

Weblogic Setup Details

P License Enter Weblogic Domain Home
= Prelnstall Setup For Ex: /homefweblogic/bea/user projectsi/domains/mydornain

() Installation..
Install Complete

IracIeIMiddIewareforacle_Homefuser_projectsfdomainsIBDEIClzl|

ORACLE"
FINANCIAL SERVICES

K

[=]

26. Enter the path of the WebLogic domain home directory and click Next. The OLAP
Details window is displayed.

Install =]
Cancel
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Figure 4-22 OLAP Details

OLAP Datails

d Licenze Mote :

=¥ Prelnstall Setup 1 = Enahkled 0=Disabled
If walue is 1 then ARBORPATH, HYPERION_HOME & ESSEASEPATH

Instalfation.. wariahles should be set in . profile before installation.

(L) Install Complete

CONFIGURE OFS5AAI OLAP FEATURE :
0

ORACLE’
FINANCIAL SERVICES

Installamawhere

27. OFSAAI OLAP feature should be set to 0.
28. Click Next. The Web server Details window is displayed.

Figure 4-23 Web server Details

Web Server Details

d License |Note : Context name will be used in your Application URL
=3 Prelnstall Setup il"rttp:,.f} <WebServerlP > <Serdet por s f<contextnamea > flogin. jsp
@) 1her 2iiailai |Example;= hitp://10.80.50.206: 2080 /myapp flogin. jsp

[#] EMABLE HTTPS

WER SERVER PORT
9061

WEE APP SERVER IP
11.12.13.14

Context name for deployment
Profsa733

ORACLE
FINANCIAL SERVICES

WEE LOCAL PATH
Jscratchfwebsphere Mipshare

Erevious

29. By default, ENABLE HTTPS is selected. If you want to install without HTTPS
enabled, click the checkbox to remove the selection and proceed with the
installation. Enter the Web Server (HTTP Server) Port, Context name for
deployment, and Local path to any folder on the Web Application Server
(Tomcat/Websphere/Weblogic).

30. Click Next. The Database Details window is displayed.
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Figure 4-24 Database Details

Database Details

MOTE:

Specify the Database user name which is the user created for
s configuration database schema. For example; configuser

' ” Specify the Database driver path as < ORACLE_HOME fjdbcflib
Install Camplete where <ORACLE_ HOME:> should be replaced with ORAZLE HOME
walue.

The ABSQLUTE DRIVER. PATH refers to the |DEC driver files path.

ORACLE SID / SERVICE_NAME :
| OFSQADE

JDEC URL:
| jdhcaracle:thin @ 11.12.13.14.1516: 0F5 Q806

CONFIG SCHEMA USER ID :
| DOCT22CONF

Oracle Configuration Schema Password

ORACLE
FINANCIAL SERVICES

ABSOLUTE DRIVER PATH :
| | fecratchforaclefappforaclefproductf 112 G fclient_1fjdbc flib |

Installa Br

Wty

31. Enter Oracle SID/Service Name.

Eestore Default H Choose. . |

Note:

¢ The JDBC URL, CONFIG SCHEMA USER ID, Oracle Configuration
Schema Password, and ABSOLUTE DRIVER PATH are auto-populated.

e ABSOLUTE DRIVER PATH can be the path where Oracle DB client is
installed or JDBC driver is installed. For example,
/scratch/oracle/app/oracle/product/11.2.0/client_
1/jdbc/1ib

32. Click Next. The Ports Configuration window is displayed.
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Figure 4-25 Ports Configuration

d License

=¥ Prelnstall Setup
(D) Installation..

() Install Complete

ORACLE
FINANCIAL SERVICES

Ports Configuration

Enter reguired information :

Mote: Ports must have unigue value.

Java Port

| 9933

Mative Port

66686

Agent Port

6510

ICC Server Port

6507

ICC Mative Port

6509

Previous

Note:

The Port, Native Port, Agent Port, ICC Server Port, and ICC

Native Port fields are auto-populated. You can also configure the
Ports settings.

33. Click Next. The Ports Configuration window is displayed.

Figure 4-26 Ports Configuration

f License

=¥ Prelnstall Setup
(D) Installation..

() Install Complete

ORACLE
FINANCIAL SERVICES

stalld 1=

Ports Configuration

Enter reguired information :
Mote: Ports must have unigue value.

Java Port

| 9933

Mative Port

66686

Agent Port

6510

ICC Server Port

6507

ICC Mative Port

Previous
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34.

Note: The OLAP Port, Message Server Port, Router Port, and AM Port
details are auto-populated. You can also configure the Ports settings.

Click Next. The SFTP Details window is displayed.

Figure 4-27 SFTP Details

& License
(s

Installatian.
Install Complete

ORACLE’

=3 Prelnstall Setup For enable SFTP : If value is 1 then SFTP will be enabled . If value is

SFTP Details

Mate

O then FTP will be enabled

ENABLE SFTP
[1

FILE TRANSFER PORT :
|22

FINANCIAL SERVICES

he

Cancel

35.
36.

37.

38.

re

Note:

e ENABLE SFTP and FILE TRANSFER PORT details are auto-populated.

¢ Ensure that the system, on which the OFSAA Infrastructure is installed,
has FTP or SFTP enabled.

Click Next. The OFSAAI Post Install Details window is displayed.

Enter the FTPSHARE path. This is same as the OFSAA Staging/ Metadata
directory.

Enter the FTP/SFTP User ID and Password for FTPSHARE directory access.

Note: The transfer of data (files) between the OFSAAI Server and the
Web application server happens through FTP/SFTP. Ensure the
necessary host configurations are made for a successful handshake.

Click Next. The Pre Installation Summary window is displayed.
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Figure 4-28 Pre Installation Summary

Pre-installation Summary

License Please review the following before continuing:
= Prelnstall Setup

() Installation.. Product Name:
OFsAsInfrastructure

() Install Complete

Yersion
8.0.4.0.0

Installation
Folder
/scratchfofsaaweb/BDB02/BDS0OR

Required Space
990 MegaBytes
ORACLE’

FINANCIAL SERVICES

Available Space
102419 MegaBytes

Installamy

R R R R R R SRR R R R R R
Cancel Help Previous Install

39. Click Install. The Installing OFSAA Infrastructure window is displayed.

Figure 4-29 Installing OFSAA Infrastructure

Installing OFSAAInfrastructure

o License

¥ Freinstall Setup
& nstallation..,

[© Install Complete

&

ORACLE Installation is in progress...
This process may take several minutes. Please Wail.
FINANCIAL SERVICES

Installing... Execute Script/Batch file: AdminConf

Install&mawhere

Cancel

Anytime during the installation you can click Cancel to stop the installation. Once
completed, the INSTALLATION SUMMARY window is displayed.
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Figure 4-30 INSTALLATION SUMMARY

INSTALLATION SUMMARY

b License INST ALLATION SUMMARY:
o Preinstall Setup
P Installation. . -0
¥ nstall Complete #OEBUG STATEMENTS. 666

HNFORMATIONS = ===~ 283
HWARNINGS .

Please see the installation log under
fscratchfofsaaapp/OFs_AAAl PACK/OFS _adlflogs fOFSAAIE log and
Jscratchfofsaaapp,/ AAAIPACK FOFSAAINTrastructure_Install.log for
rmore details.

Click on Mext to continue,

ORACLE
FINANCIAL SERVICES

Previous

The Summary window displays the number of Fatal Errors, Errors, Debug
Statements, Informations, and Warnings along with the location of log files.

40. Click Next. The Installation Complete window is displayed.

Figure 4-31 Installation Complete

Installation Complete

Congratulations! Financial Services Behavior Detection Applications Pack has been successfully installed,
o) Preinstall Setup
B Installation Click on "Done” to exit the installer. Please do not close the console. Post Install activites will be performed in console..

& Install Complete

ORACLE
FAANCILSERES
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Note: If the installation is successful with some warnings, you can
navigate to the installation log for more details and address them.

41. Click Done. The following message is displayed: Please wait, pack_install is
being configured for your system. This may take a moment.

Figure 4-32 Checking OFSAAI Services

Please Wait

B Prainstas Seup
5]
b

Fleasew g Chacking OF5AA Senvice ar system. This may take a moment_
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FINANCIAL SERVICES

Figure 4-33 Installation Summary

INSTALLATION SUMMARY

INSTALLATION SUMMARY:
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7 . #FATAL ERRORS - 0
Installation.. . 0

S hstall Complete #DEBUG STATEMENTS: 462

#INFORMATIONSG - 56

HWARNING S --meemme : 0

Hote:

Flease see the installation log under jscratchjofsaaweh/BD802/Installer/OFS_BD_PACK/logsiPack_Install.log

Click on Next to continue,
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Figure 4-34 Installation Complete

Installation Complet:

Congratulations! Financial Services Behavior Detection Applications Pack has been successfully installed,

@ Preinstall Setup
& Installation..

Click on "Done" to exit the installer. Please do not close the console. Post Install activites will be performed in console..

S Install Complete

ORACLE
FIANCIAL SERVICES

Cancel Help Previous

42. Click Done.

Note: The installation process continues on the console. Do not close
the console until the installation process is complete.

43. Perform steps mentioned in the Post Installation Configuration section.

Verifying Installation
Verify the following logs files for more information:
* See the Pack_install . log file in the folder: /OFS_ECM_PACK/logs
* See the OFSAA logs under /OFS_ECM_PACK/OFS_AAI/logs

e See the ECM_log files located in the folder: /0FS_ECM_PACK/OFS_ECM/logs for OFS
ECM Application Pack Installation log file.

Note: If there are any errors, do not proceed with further installation
and contact Oracle Support Services.
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Note: If ECM and FSDF are in different Infodom, follow these steps:

1. Run the following scripts in FSDF schema present in the path
<download_dir>/0FS_ECM_PACK/OFS_ECM: FSDFAlterTimezone.sql

2. Run the following script in ECM schema after replacing placeholder
##FSDF_USER## with FSDF User name:
INGESTUSERSYNONYMFORFSDFSTGSCHEMAOWNER. sql.

3. Run the following script in FSDF schema after replacing placeholder

##DATA_LOADER## with Data Loader Role:
FsdfStgSchemaOwnergrant.sqgl
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Post Installation Configuration

On successful installation of the Oracle Financial Services Enterprise Case
Management Application Pack, see the following post installation sections:

This chapter includes the following sections:

* Deploying OFS ECM Application Pack

* Deploying Analytic Reports and Threshold Analyzer
* Configuring Resource Reference

¢ Configuring Web application server

¢ Configurations for Java 8

¢ Configuring FSDF

Note: Ensure to clear the application cache prior to the deployment of
Applications Pack Web Archive. This is applicable to all Web servers
(WebSphere, WebLogic, and Tomcat). For more information, see the Clearing
Application Cache section.

Note: Download and apply the following patches before proceeding
further:

¢ ECMS.0.5.0.1
e ECMS8.05.0.2
e ECMS8.0.5.0.3
e ECMS8.05.04
¢ ECMS8.0.5.0.5
e ECMS8.05.0.6

Deploying OFS ECM Application Pack
To create and deploy the Applications Pack web archive, follow these steps:
1. Navigate to the $SFIC_WEB_HOME directory.
2. Execute the command:
./ant.sh

3. This will trigger the creation of EAR/WAR file - <contextname>.<extn>. Here
<contextname> is the context name given during installation.
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Note: Creating ear/war files are done by the installer automatically. If
the files are not created, user can execute these steps.

4. On completion of the EAR/WAR files creation, the "BUILD SUCCESSFUL" and
"Time Taken" message is displayed and you are returned to the prompt.

5. The EAR/WAR file - <contextname>.<extn> -is created under "$FIC_WEB_HOME"
directory.

Note: This process overwrites any existing version of EAR/WAR file in the
path. If the web application server is Apache Tomcat, the file created
would be <contextname>.war.

6. Deploy the generated EAR/WAR file on to the web application server. For
detailed information, see Deploying EAR/WAR File.

Deploying Analytic Reports and Threshold Analyzer

This section explains how to deploy Analytics on Oracle Business Intelligence
Enterprise Edition (OBIEE) and integrate Analytic Reports and Threshold Analyzer in
the OFSECM UL

This section includes the following topics:

¢ Installing OBIEE Server

¢ Installing OBIEE Windows Administration Client

¢ Disabling the Cache Feature in OBIEE Server

* Change Default Repository Password

¢ Configuring OBIEE Connection Pool

¢ Deploying OFS ECM Report Analytics

* Creating Application Role (Only for OBIEE 11.1.1.9.0)
® Accessing Reports through OFS ECM Application

Installing OBIEE Server

To install the Oracle Business Intelligence Enterprise Edition (OBIEE) server, see
Fusion Middleware Installing and Configuring Oracle Business Intelligence
(12.2.1.0.0). After installation, get the Enterprise Manager URL, Username, Password,
and OBIEE installed directory from the system administrator. For OBIEE server
11.1.1.9.0, see Oracle® Business Intelligence Applications Installation Guide 11g
Release 1 (11.1.1.9.0).

Installing OBIEE Windows Administration Client

To install the OBIEE repository administration client for Windows machine, see
Fusion Middleware Installing and Configuring Oracle Business Intelligence
(12.2.1.0.0). For OBIEE server 11.1.1.9.0, see Oracle® Business Intelligence Applications
Installation Guide 11g Release 1 (11.1.1.9.0).
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The OBIEE repository administration client can be downloaded from running OBIEE
setup from the following URL:

<protocol>:/ /<OBIEE Server Name>:<OBIEE Analytics port>/analytics

From LHS menu, click Download BI Desktop tools under the Most Popular section.

Disabling the Cache Feature in OBIEE Server

OBIEE 12.2.1.0.0:

Login to the Enterprise Manager and perform the following steps:

1. Click the Target Navigation icon =

Expand the Business Intelligence section and then click biinstance.

2
3. Click the Configuration tab.
4

Click the Lock icon |1 F| and then click Lock & Edit to enable the Cache Enabled
check box.

5. Under the Enable BI Server Cache section, deselect the Cache Enabled check box
and make the required changes

6. Click the Lock icon |} ﬂ and then click Release Configuration to save the
changes made.

Figure 5-1 Disabling the Cache Feature in OBIEE Server (12.2.1.0.0)

AL Entrpriss Darsger -t wiaean com 1 I Vitlog Doman v wedege =

== biinstance O

hf) Butinest Intaigance Inttane (E) | Dec 14, 2006 247:10 PM 15T

& Confirmatian L
The edit session lock has been acquired. No pending changes exist

i Information
Al configuration changes require the Bl Inslance restart to lake effect.

Configuration  Dragrostics  Secunty
General  Perh

Performance Options Apply A

Use this page io hume e perfomance of ihis B1 Instance.

Enable BI Server Cache User Session Expiry
Enat Fles

Expary Time et W

Maximum Number of Rows Processed when Rendering a Table View
Trig s

mits 3 5 el & Se wocessed
e e

Global Cache

Numnber OF Rows. 65000 A w
Tiesé S6MtigS apely 00 The cache when the BI sener (s clustered
Global cache path Maximum Numbar of Rows to Download
Global cache size B v |

Number Of Hows. 200 | A w

RPD Updates

OBIEE 11.1.1.9.0:

Login to the Enterprise Manager and perform the following steps:

1. Expand the Business Intelligence section and then click coreapplication.
2. Click the Capacity Management tab.

3. Under that tab, click the Performance tab.
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Clear the Cache Enabled checkbox.
Click Apply.

© N o 0 &

Click Close.

Click Lock and Edit Configuration to disable the Cache feature.

Click Activate Changes. The confirmation window is displayed.

Figure 5-2 Disabling the Cache Feature in OBIEE Server (11.1.1.9.0)
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Change Default Repository Password

OBIEE 12.2.1.0.0:

Copy FCCM805 . rpd from $FI1C_HOME/OBIEE/Repository to the Windows
machine where the OBIEE Windows administration client is installed.

To change the default password for the repository follow these steps:

1. Open the Repository using the OBIEE Windows administration client from
Windows machine. From the File menu, select Open and click Offline. Browse to
the Repository on Windows machine. The Oracle BI Administration Tool -

FCCM805 . rpd windows is displayed.

2. Enter default Repository password: FCCM$805

To change the default password, follow these steps:

1. From File menu, choose Change Password.

2. Enter the new password and click OK.

OBIEE 11.1.1.9.0:

Copy FCCM805.rpd from $FIC_HOME/OBIEE/Repository to the Windows machine
where the OBIEE Windows administration client is installed.
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To change the default password for the repository, follow these steps:

1.

2.

Open the Repository using the OBIEE Windows administration client from
Windows machine. From the File menu, select Open and click Offline. Browse to
the Repository on Windows machine. The Oracle BI Administration Tool -
FCCM805.rpd windows is displayed.

Enter default Repository password: FCCM$805

To change the default password, follow these steps:

1.
2.

From File menu, choose Change Password.

Enter the new password and click OK.

Configuring OBIEE Connection Pool

OBIEE 12.2.1.0.0:

To configure the Connection Pool of the repository, follow these steps:

1.

© N o o

10.

Open the same Repository (as in the previous step) on the Windows machine. The
Oracle BI Administration Tool - FCCM805 . rpd windows is displayed.

Expand the FCCM folder in the Physical section.
Double-click Connection Pool to open the Connection Pool Properties window.

Enter the following in the Data Source Name text box of the Connection Pool
Properties window after modifying <Database Server Host Name> and <Database
Name> Data Source Name =
(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database Server
HostName>)(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED)
(SERVICE_NAME=<Database Name>)))

Enter the Atomic Schema user in the User name text box.
Enter the Atomic Schema user password in the Password text box.
Click OK.

Expand the folder and test connection for any one table name by Right Click >
view data.

Perform similar changes in the Connection Pools for all remaining folders in the
Physical Layer by providing the following schema details for all Connection Pools:

¢ KYC Analytics >Atomic Schema

Note: Initial block and connection pool: both should point towards
the atomic schema.

e UIC_73 > CaseMng connection pool ->Atomic Schema
e UIC_73 > Security connection pool->Atomic Schema

e TA > Atomic Schema

e CTRBI-> Atomic Schema

¢ ORCL->Atomic Schema

Select Save option from the File menu. The following message is displayed: Do
you want to check global consistency?.
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11.

12.

Click Yes. The following message is displayed: Consistency check didn’t find any
errors, warning or best practices violations.

Click OK.

OBIEE 11.1.1.9.0:

To configure the Connection Pool of the repository, follow these steps:

1.

© N o u

10.

11.

12.

Open the same Repository (as in the previous step) on the Windows machine. The
Oracle BI Administration Tool - FCCM805 . rpd windows is displayed.

Expand the FCCM folder in the Physical section.
Double-click Connection Pool to open the Connection Pool Properties window.

Enter the following in the Data Source Name text box of the Connection
PoolProperties window after modifying <Database Server Host Name> and
<Database Name> Data Source Name
=(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database Server
HostName>)(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED)
(SERVICE_NAME=<Database Name>)))

Enter the Atomic Schema user in the User name text box.
Enter the Atomic Schema user password in the Password text box.
Click OK.

Expand the folder and test connection for any one table name by Right Click >
View data.

Perform similar changes in the Connection Pools for all remaining folders in the
Physical Layer by providing the following schema details for all Connection Pools:

e KYC1.1DEV-179 >Atomic Schema

Note: Initial block and connection pool: both should point towards
the atomic schema.

e UIC_73 > CaseMng connection pool ->Atomic Schema
e UIC_73 > Security connection pool->Atomic Schema

e TA > Atomic Schema

e CTRBI-> Atomic Schema

¢ ORCL->Atomic Schema

Select Save option from the File menu. The following message is displayed: Do
you want to check global consistency?.

Click Yes. The following message is displayed: Consistency check didn’t find any
errors, warning or best practices violations.

Click OK

Deploying OFS ECM Report Analytics

OBIEE 12.2.1.0.0:
To deploy Analytic Reports, follow these steps:
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© © N o o

10.

11.

Change the value in Ngsconfig. ini file located at <FMW_HOME>/user_
projects/domains/bi/config/fmwconfig/biconfig/0OBIS

From EVALUATE_SUPPORT_LEVEL = 0;

To EVALUATE_SUPPORT_LEVEL =2;

Copy the FCCM805. rpd file in the working directory.

Navigate to the working directory and execute the following script:

<obiee_home>/user_
projects/domains/bi/bitools/bin/data-model-cmd.sh uploadrpd
-1 FCCM805.rpd -SI ssi -U <user> -P <password>

Restart OBIEE server from Enterprise Manager by following these steps: (see
figure Restarting OBIEE Server)

Click the Target Navigation icon E
Expand the Business Intelligence section and then click biinstance.
Click the Availability tab.

Click Stop All.

Copy the file FCCM_ANALYTICS.bar in the same working directory and execute
the following script:

<obiee_home>/oracle_common/common/bin/wlst.sh
A new prompt wls:/oFfline> is displayed. Execute the following script:

importServicelnstance("<obiee_home>/user_
projects/domains/bi*,"ssi”, "<Working directory>/FCCM_
ANALYTICS.bar", importRpd=false, importWebcat=true, importJazn=t
rue, includeCredentials=None)

Click Start All.

Figure 5-3 Restarting OBIEE Server
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OBIEE 11.1.1.9.0:
To deploy Analytic Reports, follow these steps:

1.

10.
11.
12.
13.

Stop Oracle Process Manager and Notification Server (OPMN) services by
executing the following command from <OBIEE Installed
Directory>/instances/instancel/bin

-/opmnctl stopall

Change the value in Ngsconfig. ini file located at <FMW_
HOME>/instances/instancel/config/OracleBlServerComponent/core
application_obisl/ directory

From EVALUATE_SUPPORT_LEVEL = 0;
To EVALUATE_SUPPORT_LEVEL=2;

Login into Enterprise Manager, click the Business Intelligence folder on the left
hand side and select coreapplication, and then click the Deployment tab.

Click the Repository tab.

Click the Lock and Edit Configuration tab. The confirmation window is
displayed.

Click Close.

In the Upload BI Server Repository Section, browse the repository file from the
Windows machine.

Enter the new repository password in the Repository Password and Confirm
Password text boxes.

In BI Presentation Catalog section, provide the Catalog Location as <OBIEE
Installed
Directory>/instances/instancel/bifoundation/OracleBlPresentat
ionServicesComponent/coreapplication_
obipsl/catalog/ANALYTICS REPORT

Click Apply.
Click Activate Changes. The confirmation window is displayed.
Click Close.

Modify <obiee_home>/user_
projects/domains/bi/config/fmwconfig/biconfig /OBIPS/instanceconfig.xml as
the following

From
<Security>

<!--This Configuration setting is managed by Oracle Enterprise Manager
Fusion Middleware Control-->

<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
</Security>

To

<Security>

<!--This Configuration setting is managed by Oracle Enterprise Manager
Fusion Middleware Control-->
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14.

15.

16.

<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>

<InIFrameRenderingMode>allow</InIFrameRenderingMode>

</Security>

Open the Catalog Manager and access analytics URL as follows:
http:/ /<host>:<port>/analytics/saw.dll

Expand Catalog Root in LHS menu. Expand Shared Folders. Delete all the
contents under Shared Folders.

Navigate to File->Unarchive->Browse. Select FCCM_ANALYTICS.catalog from
window machine. Click OK.

Creating Application Role (Only for OBIEE 11.1.1.9.0)

This section is applicable only for OBIEE 11.1.1.9.0. Follow these steps for creating
Application Role:

1.

Login to OBIEE installed command prompt.

¢ Change the directory cd <<OBIEE Installation Path>>/Oracle_
Bl11/common/bin

For example, cd /scratch/Obieellg/Oracle_Bl1/common/bin

Copy CreateAppRoles.py to the aforementioned path and execute the
following command:

-/wlst._sh “CreateAppRoles.py” <<admin user>> <<admin
password>> t3://<<server ip or server host>>:<<console port>>

For example, ./wlst.sh "CreateAppRoles.py"™ WebLogic WebLogicl23
t3://0fss232465._ in.oracle.com:7001

Once the role has been created, remove the file CreateAppRoles.py.

Configuring TreeMap Graph
To configure the TreeMap Graph, follow these steps:

1.
2.

Login to OBIEE server.
Navigate to OBIEE Home.

Note: OBIEE Home is the OBIEE installed path.

Execute the following command:

cd <obiee_home>

Execute the following command to find the available treemap-canvas. js:
find -name treemap-canvas.js

Four different files, all named treemap-canvas. js are displayed.

Back up these four files.

Edit window.top.console to console in these four files and save.
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Accessing Reports through OFS ECM Application

For more information on Accessing Reports, see the Alert Management User Guide.

Configuring Resource Reference

This section describes the details for configuring the resource reference in WebSphere,
WebLogic, and Tomcat Application Servers. For detailed information, see Configuring
Resource Reference.

Configuring Web application server

This section describes the details to configure the different web application servers for
OFSAA Infrastructure deployment namely, IBM WebSphere, Oracle WebLogic, and
Apache Tomcat Servers. For detailed information, see Configuring Web application
servers.

Configurations for Java 8
Follow these steps to extract and apply the patch.
1. Follow the instructions given in the Readme to apply the patch.

2. If the Oracle Database version is 12c, copy ojdbc7.jar from $ORACLE_
HOME/Jjdbc/1ib to the following locations:

e SFIC_HOME/utility/OFSAAGenerateRepository/lib/

e SFIC_HOME/realtime_processing/WebContent/WEB-INF/1lib/
e SFIC_HOME/ficdb/lib/

e SFIC_HOME/ficapp/icc/lib/

e SFIC_HOME/ficapp/common/FICServer/lib/

e SFIC_HOME/FMStandalone/FormsManager/WEB-INF/1lib/

e SFIC_HOME/ficweb/webroot/WEB-INF/lib/

Note: If ojdbcé.jar is already present in any of the aforementioned
folders, you need to remove it.

3. If the Oracle Database version is 11g, copy ojdbc6 . jar from $ORACLE_
HOME/jdbc/11ib to the following locations:

e SFIC_HOME/utility/OFSAAGenerateRepository/lib/
e SFIC_HOME/realtime_processing/WebContent/WEB-INF/lib/
e SFIC_HOME/ficdb/lib/
e SFIC_HOME/ficapp/icc/lib/
e SFIC_HOME/ficapp/common/FICServer/lib/
e SFIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/
e SFIC_HOME/ficweb/webroot/WEB-INF/lib/
To install OFS ECM Application Pack for Java 7 and Java 8 follow these steps:
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Java 7:

¢ Navigate to the OFS_ECM_PACK/bin folder.
e Execute ./setup.sh GUI in the console.
Java 8:

* Navigate to the OFS_ECM_PACK/bin folder

e Execute ./setup.sh GUI in the console.

Configuring FSDF

This section covers following topics:
e Configuring FSDF in Same Infodom
e Configuring FSDF in Different Infodom (Pack on Pack Installation)

Configuring FSDF in Same Infodom
If ECM and FSDF are in same Infodom, follow these steps:

Run the following SQL files in Atomic schema present in the path <download_
dir>/0OFS_ECM_PACK/OFS_ECM.

® FSDFAlterTimezone.sqgl

e 8.0.2.0.0_Alter_Table_Script.sql.

Configuring FSDF in Different Infodom (Pack on Pack Installation)
If ECM and FSDF are in different Infodom, follow these steps:

® FSDFAlterTimezone.sqgl
e 8.0.2.0.0_Alter_Table_Script.sql

1. Run the following script in ECM schema after replacing placeholder ##FSDF_
USER## with FSDF User name INGESTUSERSYNONYMFORF SDFSTGSCHEMAOWNER . sql.

2. Run the following script in FSDF schema after replacing placeholder ##DATA_
LOADER## with Data Loader Role FsdfStgSchemaOwnergrant . sql

Note:

For pack on pack installation of 8.0.2.0.0 on 8.0.1.0.0, the following scripts
should not be executed after the installation of 8.0.1.0.0:

3. FSDFAlterTimezone Run the following scripts in FSDF schema present in the path
<download_dir>/0FS_ECM_PACK/OFS_ECM.

e .sqgl
® INGESTUSERSYNONYMFORFSDFSTGSCHEMAOWNER.sqgl

e FsdfStgSchemaOwnergrant.sqgl
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Post Deployment Configuration

This section provides detailed information about the Post Deployment Configurations.
lists the various configurations to be completed before you use the OFSAA
Applications.

* Creating Application Users

¢ Mapping Application User(s) to User Group

¢ Performing Administrative activities for OFS ECM

¢ Performing Configurations for OFS ECM

*  Setting OFS ECM UI as Home Page of OFSAAI for a Particular User

Creating Application Users
Create the application users in the OFSAA setup prior to use.

Note: This step may not be required if you have already setup users
in the OFSAA setup.

For more information see user creation section from the Oracle
Financial Services Analytical Applications Infrastructure User Guide.

Mapping Application User(s) to User Group

Starting the OFSAA 8.0 release, with installation of every OFSAA Applications Pack,
pre-configured application user groups are seeded. These user groups are unique to
every OFSAA Applications Pack and have application roles pre-configured.

User Groups seeded with the OFS ECM Application Pack are listed in Table 6-1.

Table 6-1 Seeded User Groups

Name Description

Modeler Group User mapped to this group have access to all the menu items for
Enterprise modeling, but do not have authorization rights for
sandbox population, model deployment and modeling
technique authorization.

Modeling Administrator User mapped to this group have access to all the menu items for

Group Enterprise modeling and authorization rights for sandbox
population, model deployment and modeling technique
authorization.
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Performing Administrative activities for OFS ECM

Table 6-1 Seeded User Groups

Name

Description

Inline Processing Admin
Group

User mapped to this group have access to all the menu items
and actions for Inline Processing module.

Business Administrator

User mapped to this group have access to all the menu items
and actions for advanced operations of metadata objects.

Business Authorizer

User mapped to this group have access to all the menu items
and actions for authorization of changes to metadata objects.

Business Owner

User mapped to this group have access to all the menu items
and actions to read and write metadata objects

Business User

User mapped to this group have access to all the menu items
and actions to access and read metadata objects.

Identity Administrator

User mapped to this group have access to all the menu items to

manage User entitlements, User Group Entitlements and Access

Management configurations.

Identity Authorizer

User mapped to this group have access to all the menu items to
authorize User entitlements, User Group Entitlements and
Access Management configurations.

System Administrator

User mapped to this group have access to all menu items to
manage the setup configurations.

Object Administrator User mapped to this group have access to all menu items to
manage object migration and metadata traceability using
metadata browser.

Guest Group User mapped to this group have access to certain menu items

with view only access privileges.

Map the application user(s) to the respective Application User Group(s) and
subsequently authorize the entitlements by logging in as SYSAUTH (System

Authorizer) user.

Note: In case the User Groups related to OFS ECM are not mapped,
ensure that you map it accordingly in OBIEE catalog for Statement

View report.

In order to view the MIS reports in ECM Standalone, map the Case
Analyst2 User Group in the Application.

For more information, see Mapping/Unmapping Users section from the Oracle
Financial Services Analytical Applications Infrastructure User Guide.

Performing Administrative activities for OFS ECM

Access the OFS ECM Ul as ECMAP Administrator and perform all the steps given in
the following sections of the Administration Guide.

¢ About Configuring Access Control Metadata

* Mapping Users To Access Control Metadata

¢ About Scenario Manager Login Accounts

¢ About Changing Passwords for System Accounts

¢ About Configuring File Type Extensions
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About Configuring File Size
About Configuring Status To User Role Table

Note: Once Security Attributes mapping is completed for the
ECMAP Administrator user, restart OFSAAI and Web Application
servers before accessing the Admin Tools application.

Performing Configurations for OFS ECM

Access the OFS ECM Ul as ECMAP Administrator and perform all the steps given in
the following sections of Configuration Guide.

Configuring the Base Time Zone
Configuring the Default Currency Code
Configuring E-mail

Configuring XML Export

Configuring Case Correlation Owner

Configuring Default Case Owner

Setting OFS ECM Ul as Home Page of OFSAAI for a
Particular User
To set OFS ECM Ul as home page of OFSAALI, follow these steps:

1.

2
3
4.
5

Log in as an ECM Administrator /Supervisor user.
Navigate to Home page.

Click on logged in user name in the right top corner.
Click Preferences and a new page is displayed.

Select Enterprise Case Management as your default page and click Save.
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Configuring Web server

This section covers the following topics:
¢ Configuring Web server

¢ Configuring Web application servers

Configuring Web server
This step assumes the installation of a Web server exists as per the prerequisites.

See the product specific installation guide to install and configure the Web server. If an
installation already exists, skip and proceed to the next step.

Note:

* Make a note of the IP Address/ Hostname and Port of the web
server. This information is required during the installation
process.

* Addumask 0027 in the .profile of the UNIX account which manages the
WEB server to ensure restricted access permissions

* See Oracle Financial Services Analytical Applications
Infrastructure Security Guide mentioned in the Related Documents
section for additional information on securely configuring your
Web server.

Configuring Web application servers

This step assumes an installation of a web application server exists as per the
prerequisites. To configure the Web application server for OFSAA Deployment see the
following sections.

This section includes the following topics:

¢ Configuring WebSphere Application Server for Application Deployment
¢ Configuring WebLogic for Application Deployment

¢ Configuring Apache Tomcat Server for Application Deployment
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Note:

e Make a note of the IP Address/ Hostname and Port of the web
application server. This information is required during the
installation process (required if Web server is not configured).

* See OFSAA Secure Configuration Guide/ Security Guide
mentioned in the Related Documents section for additional
information on securely configuring your Web server.

Configuring WebSphere Application Server for Application Deployment

You can deploy multiple OFSAA applications on different profiles of a stand-alone
WebSphere application server. To create multiple WebSphere "Profiles" in a
stand-alone server, use the command line option as explained in the following section.
A profile is the set of files that define the runtime environment. At least one profile
must exist to run WebSphere Application Server.

This section covers the following topics:

¢ Creating New Profile in WebSphere

* Managing IBM WebSphere SDK Java Technology Edition Versions
¢ Deleting WebSphere Profiles

¢ Configuring WebSphere HTTPS

¢ Configuring WebSphere Memory Settings

Creating New Profile in WebSphere

The Profile is created in WebSphere through command line using the
manageprofiles.sh that resides in the <WebSphere Install directory>/AppServer/bin
folder.

The command to create a profile without admin security through command line is as
follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
name> -hostName <host_name>"

Example:

$usr/home>. /manageprofiles.sh -create -profileName mockaix
-profilePath/WebSphere/webs64/Appserver/profiles/mockaix
-templatePath/WebSphere/webs64/Appserver/profileTemplates/default
-nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName
ipa020dor

The command to create a profile with admin security through command line is as
follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
name> -hostName <host_name> -enableAdminSecurity true -adminUserName
<Admin User Name> -adminPassword < Admin User Password> -samplespassword
<sample User Password>"

Example:
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Susr/home>. /manageprofiles.sh -create -profileName mockaix
-profilePath/WebSphere/webs64/Appserver/profiles/mockaix
-templatePath/WebSphere/webs64/Appserver/profileTemplates/default
-nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName
ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword
ofsaal -samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a
New Profile in WebSphere, you can also use "-validatePorts" to
validate if the specified ports are not reserved or in use. Additionally,
you can specify new ports with "-startingPort <base port>"which
specifies the starting port number to generate and assign all ports for
the profile. For more information on using these ports, see WebSphere

manageprofiles command.

Managing IBM WebSphere SDK Java Technology Edition Versions

By default, WebSphere Application Server V8.5.5.X uses the Java 6.0 SDK. You must
upgrade to Java 7.X SDK or JAVA 8.X SDK.

Prerequisites: Install the IBM WebSphere SDK Java Technology Edition Versions
1.7.X_64 or 1.8.X_64.

Perform the following steps to upgrade to Java 7.X SDK or JAVA 8.X SDK:

1. Enter the WebSphere URL in the format http:/ /HOST_NAME:PORT_
NUMBER/ibm/console (use https if SSL is enabled.). For example,
http://192.168.1.0:9000/ibm/console.

2. Login with your administrator user ID and password.
3. From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere
Enterprise Application Servers to view the Application servers window.

5. On Application servers window, click the required Application Server link. For
example, serverl in the following illustration:
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Figure A-1 Application Server - Java SDKs

Application servers 7 =

Application servers > serverl

Use this page to configure an application server. An application server is 2 sarver that provides sarvices required to run enterprise applications.

Runtime Configuration |
General Properties Container Settings
Lontainer Sethings
M
|ame | Session manzgement
serverl
SIP Container Settings
Node name

=]

Web Container Settings
|v.rh‘fDClaqr\cheD]. |

"

Portlet Container Sattings

| Run in development mode

]

EJB Container Settings

1 paraliel start

B

Container Services

=]

[ Business Process Services
I} Start components as needed

Access to internal server classes AEElications
Allow ¥

Installed applications

Server-specific Application Settings PR i e Al
Fasnas il el L]

Classloader policy
% IMassaging engines

ing_engine inbound transports

Class loading mode WebSphere MQ link inbound transports
Classes loaded with parent class loader first s

SI8 service

Server Infrastructure

| Apply || OK || Resel H Cancel Java and Process Management

Administration

Java SDKs

6. Click Java SDKs link from Server Infrastructure to view the list of Java SDKs.

Figure A-2 Application Server - List of Java SDKs

Application servers 7 E

Application servers > serverl > Java SDKs

This page lists the software development kits (SDKs) that are instzlled on the server. These SDKs are available to the servers.

Preferences

Make Default

Select‘ Hama & Version 7} Location £ Bits > Default

You can administer the following resources:

[ |16.64 1.6 £{WAS_INSTALL_ROOT}/java 64 false
[ |1.7_64 1.7 ${WAS_INSTALL_ROOT}fjava_1.7_64 | 64 false
7 |1.8.64 1.8 ${WAS_INSTALL_ROOT}/java_1.8_64 | 64 true
7

Total 3

7. Select either 1.7_64 or 1.8_64 based on the JVM version with which you plan to
install OFSAA or have installed with.
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8. Click Make Default button and save to master repository.

9. Restart the WebSphere Application Server to apply the changes to the IBM
application profile.

Managing Applications in WebSphere
To manage the installed applications in WebSphere, follow these steps:

1. Open the administrator console using the following URL:
http://<ipaddress>:<Administrative Console Port>/ibm/console

For example: http://10.111.222.333:9003/1ibm/console (https if SSL is
enabled.)

Note: Administrative Console Port value is available in
serverindex.xml file within <WebSphere Profile
Directory>/config/cells/<Node Cell>/nodes/<Node Name>
directory.

The Integrated Solutions Console Login window is displayed.

Figure 6-1 Integrated Solutions Console Login

Integrated Solutions Console

Log in to the console.
User ID:

upgs73
Password:

asssee

Log in

%,

‘ -~

2. Log on with the User ID provided with the admin rights.

3. From the LHS menu, expand the Applications > Application Type> WebSphere
Enterprise Applications.
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The Enterprise Applications screen is displayed.
Figure 6-2 Enterprise Applications

CoterpriseRoplications 7

Enterprive Applications
Use thes Dage to manage nstalied 30picatons. A single appicabion Can Do depioyed Onto MUtple servers
@ Preforences

S’.c‘;‘ Install |  Urunstald J Updete | Robout Update | Eemyve Fie | [-;-:-RJ Export DOL | Evport Fide |
eoT ¥
Select Name 2 Apphcation Status &
You can admrester the folowing resources:
r“n ;.-I,- ACT a
Retaukionbiatnn +»
[ utéen +
r +

This Enterprise Applications screen helps you to:
¢ Install new application
¢ Uninstall existing applications

e Start or Stop the installed applications

Configuring WebSphere Application Server to Use a Load Balancer or
Proxy Server

The configuration prevents the process server from redirecting to an internal port
when using a load balancer or proxy server.

The following steps describe the configuration:

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_
NUMBER/ibm/console (use https if SSL is enabled.). For example,
http://192.168.1.0:9000/1bm/console.

2. Login with your administrator user ID and password.
3. From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere
Enterprise Application Servers to view the Application servers window.

5. On Application servers window, click the required Application Server link. For
example, serverl in the following illustration:
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Figure A—3 Application Servers - Load Balancer Proxy Server

Applicalion seivers

Application servers > serverl > Web container > Custom properties

Use this page to speciy an aritrary name and value paic The value that is specified for the name and value pair = 3 string that can set
intemal system configuration properties.

¥ Preferences

i Mew... || Delete

| Salact | Mame £ | Value & Deccripbion )

| You can administer the following resources:

[ | com.ibm.ws.webcontainerextraciHostHeaderfort | true |
[ | trusthostheaderport | true i |
| Total2

6. Click Web Container Settings > Custom Properties.
7. Add the following properties:
e Name: trusthostheaderport
Value: true
e Name: com.ibm.ws.webcontainer.extractHostHeaderPort
Value: true

8. Restart the WebSphere Application Server to apply the changes.

Deleting WebSphere Profiles
To delete a WebSphere profile, follow these steps:

1. Select the checkbox adjacent to the required application and click Stop.
2. Stop the WebSphere profile to be deleted.
3. Navigate to WebSphere directory:
<WebSphere_Installation_Directory>/AppServer/bin/
4. Execute the command:
manageprofiles.sh -delete -profileName <profile_name>
5. Delete profile folder.

Example: <WebSphere_Installation_
Directory>/AppServer/profiles/<profile_name>

6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry

Configuring WebSphere HTTPS
To configure an HTTPS Transport on WebSphere, follow these steps:

1. Create a profile using the Profile Creation Wizard in WebSphere.
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Note: Note down the https port specified during this process and
use the same as servlet port or web server port during OFSAAI
installation.

2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS_
ENABLE" in OFSAAI_InstallConfig.xml for Silent mode OFSAALI installation.

Configuring WebSphere Memory Settings
To configure the WebSphere Memory Settings, follow these steps:

1. Navigate to WebSphere applications server > Application servers >
serverl > Process definition > Java Virtual Machine.

2. Change the memory setting for Java Heap:
Initial heap size = 512

Maximum heap size = 3072

Configuring WebLogic for Application Deployment

You can deploy multiple Infrastructure applications on different domains of a
stand-alone WebLogic application server. To create multiple WebLogic "Domains" in a
stand-alone server you can use the Domain Creation wizard. A domain is the set of
files that define the runtime environment. At least one domain must exist to run
WebLogic Application Server.

Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java
8, download and install patch 18729264.

Following configuration is required only if OFS Big Data Processing is
licensed and enabled in your OFSAA instance and OFSAA is
deployed on Oracle WebLogic Server version 12.2.x:

¢ The jersey-server-1.9 jar file should be copied to <HIVE_LIB_
PATH> path.

This section covers the following topics:

® Creating Domain in WebLogic Server

¢ Deleting Domain in WebLogic

e Configuring WebLogic Memory Settings

Creating Domain in WebLogic Server
To create a new domain using Configuration Wizard in WebLogic, follow these steps:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the
command:

./config.sh

The Welcome window of the Configuration Wizard is displayed.
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Figure 6-3 Welcome

n Fusion Middleware Configuration Wizard HHE

Walcome

oRrRACLE’

® Create a new WeblLogic domain

Create a YyebLogic domaln in your projects directory.

O Extend an existing WebLogic domain

Use this option to add new components 1o an existing domain and modify configuration setings.

[ e |[ b | [revous |[_nea ]

2. Select Create a new WebLogic domain option and click Next.

The Select Domain Source window is displayed.

Figure 6-4 Select Domain Source

Select Domain Source

ORACLE’

@ Generate a domain configured automatically to support the following products:

]

O Base this domain on an existing template

[Eronee |

B2 || uep | | Brevious | [ bt |
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3. Select the Generate a domain configured automatically to support the following

products option and click Next.

The Specify Domain Name and Location window is displayed.

Figure 6-5 Specify Domain Name and Location

) Fusion Middleware Configuration Wizard !in
Specify Domain Name and Location
ORACLE
Enter the name and location for the domain:
Domain name: | MockSol |
Darsain ocation: .Memognmemmmamef_projectsmmam | Browse |

4. Enter the Domain Name and Location. Click Browse to navigate and specify the

location. Click Next.

The Configure Administrator Username and Password window is displayed.

Figure 6-6 Configure Administrator Username and Password

l] Fusion Middleware Configuration Wizard Hlm
Configure Administrater User Name and Password
.
ORACLE
. Disgard Changes
"Lzer reame; mansger
*ser mswd [ LLLTELTET
*Confirm user password [ |
Description: | This wser is the defaut administrator
et |[ tew | | erevious | [ et ]

5. Enter the User name and User password to be assigned to the Administrator.

6.

Ensure that the password is of minimum 8 characters in length.

Re-enter the password for confirmation and add a brief Description. Click Next.
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The Configure Server Start Mode and JDK window is displayed.

Figure 6-7 Configure Server Start Mode and JDK

) Fusion Middleware Configuration Wizard

Configure Server Start Mode and JDK

ORrRACLE’

Before putting your domain info production, make sure that the production enmvironment is secure. For more information, see the topic "Securing &

Production Environment' in the WeblLogic Server documentation.

T use Weblogic JRockit in production, Cracle recommends developing and festing your applications with WebLogic JRockit early in the project cycle,

For information about WebLogic JRockE, see the WebLogic JRockR documentation.

VWeblLogic Domain Startup Mode

JOH Selection

@ Development Mode
Utlize boot properties for username and
password and poll for applications to deploy.
Sun JOK recommended for better startup
perionmance during terative development,

2 Production Mode
Require the entry of a usermame and password
andd do not poll 1o appications 1o deplay,
WiebLogic JRockit JOK recommended for better
Furtime periormance and management.

(®) Awailable JDKs

Sun SDK 1 6.0_18 @ Asrick! 5.0_18

O Other JOK

Location

| ea bel

Previous | [ next |

7. Select the following options:

In the WebLogic Domain Startup Mode section, select the required mode
(Development Mode or Production Mode).

In the JDK Selection section, select Other JDK. Click Browse and navigate to the

JDK location. Click Next.

The Select Optional Configuration window is displayed.

Configuring Web server A-11



Configuring Web application servers

Figure 6-8 Select Optional Configuration

E) Fusion Middieware Configuration Wizard

Select Optional Configuration

ORACLE’

Administration Server
Moty Settings
[ Managed Servers, Clusters and Machines
Add or Delets
Modity Settings
] RDBMS Security Store
Modity Settings

Ext tex

8. Select Administration Server. A WebLogic Server domain must have an
Administration Server. You can also select Manages Servers, Clusters and
Machines and RDBMS Security Store if required. Click Next.

The Configure the Administration Server window is displayed.
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Figure 6-9 Configure the Administration Server

E) Fusion Middleware Configuration Wizard !IE
Configure the Administration Server
ORACLE'
7 Disgard Changes
"Name: | AdminServer |
"Listen sddvess: | Al Local Addresses I-]
SS5L ksten port: | |
SSLenabledt [

9. Enter Administration Server details such as the Name, Listen address, Listen Port,

SSL listen port, and SSL enabled (for secure login using https) check box. Click
Next.

The Configuration Summary window is displayed.

Note: Make a note of the Listen Port or SSL Listen Port value (For
example, 7007), since the same has to be re-entered in the Servlet port
field during Infrastructure installation.
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Figure 6-10 Configuration Summary

E) Fusion Middleware Configuration Wizard
Configuration Summary
ORACLE
Domain Summary Chck on an @em in the Domain Summary pane on the left to inspect itz atiributes inthe
Summary View: Detaits pane below. You can make liméed adusiments by clicking Previous to return o a
Deployment |'| prior panel, I everything is satistactory, click Next.
"1 MockSal (weblogichwebi 01 3bealiser_projec i
3 2 sever (ot
D AdminSarvar Aftribege  Vahe
Name Basic WebLogic Server Domain
Description  Creste a basic Veblogic Server domain without instaling sample application
Author Oraclke Corporation
Location  Aweblogichvebl] 01 3beatwiserver 10 3icommaondemplatesidomainsids jar
[ ] ) [ []
Greste

10. Verify the configuration details of the WebLogic domain and click Create.

The Creating Domain window is displayed with the status indication of the
domain creation process.
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Figure 6-11 Creating Domain

E) Fusion Middleware Configuration Wizard !in

Creating Domain
orACLE

Progress:

| 100% |

Extracting Domain Contends .,

Creating Domain Security Information...
Saving the Domain Information...

Storing Domain Information...

String Substituting Domain Files...
Performing OS Specific Tasks...
Performing Post Domain Creation Tasks ..,
Doman Created Successiullyl

Domain Location: fveblogichwebl 01 3bealuser_projecisidomains MockSal
Admin Server URL: hitpc ipeg8rey: 7007

ORACLE"

[erevious ] [_pons

11. Click Done when complete. The domain server is created enabling the
deployment of multiple Infrastructure applications on a single WebLogic.

Note:

¢ Note down the HTTPS port specified during this process and use
the same as servlet port or web server port during OFSAAI
Installation.

To enable https configuration on Infrastructure, assign value 1 to
"HTTPS_ENABLE" in OFSAAI_ InstallConfig.xml for silent mode
OFSAAl installation

12. Add ajava option entry -DUseSunHt tpHandler=true in WLS_HOME/bin/
"setDomainEnv.sh" file (Required only if self signed certificate is used).

Deleting Domain in WebLogic
To delete a domain in WebLogic, follow these steps:

1. Navigate to the following directory:

<WebLogic Installation directory>/user_projects/domains/<domain
name>/bin

2. Execute stopWebLogic.sh to stop the WebLogic domain.
3. Delete the WebLogic domain.
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Configuring WebLogic Memory Settings
To configure the WebLogic Memory Settings, follow these steps:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in
setDomainEnv.sh file, which resides in the folder <DOMAIN_HOME>/bin and in
CommEnv.sh file which resides in the folder common/bin.

2. Edit this file for customizing memory settings and garbage collector settings
depending on the available hardware configuration.

Example 1:
if [ "${JAVA_VENDOR}" = "Sun" ] ; then
WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_64BIT
WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_32BIT
else
WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_64BIT
WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_32BIT
Example 2:
JAVA_VM=

MEM_ARGS="-Xms256m -Xmx1024m"

Configuring Apache Tomcat Server for Application Deployment

This section is applicable only when the Web application server type is Tomcat.
This section includes the following topics:

e Tomcat User Administration

¢ Configuring Tomcat to use JAVA 64 bit Executables

¢ Configuring Servlet Port

e Configuring SSL Port

e Configuring Apache Tomcat Memory Settings

¢ Configuring Axis API

e Configuring Tomcat for User Group Authorization

®  Uninstalling WAR Files in Tomcat

Tomcat User Administration

The Tomcat administration and manager application does not provide a default login.
You are required to edit "$CATALINA_HOME/conf/tomcat-users.xml" as instructed
below.

This file contains an XML <user> for each individual user, which will display the
username and password used by admin to log on to Tomcat, and the role names to
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which the admin user is associated with. For example, <user name="admin"
password="admin" roles="standard,manager" />

1.

Add the manager role to any one of the existing username/password combination
as shown in the preceding example.

Use the same username/password to which the manager role has been assigned to
access the Tomcat Application Manager.

If the Tomcat server is already running, it requires a re-start after the above
configuration is done.

Configuring Tomcat to use JAVA 64 bit Executables
To configure Tomcat to use JAVA 64 bit, follow these steps:

1.
2
3

Navigate to the $CATALINA_HOME/bin folder.
Edit the setclasspath.sh file as follows:
Replace the following block of text

# Set standard commands for invoking Java.
_RUNJAVA="SJRE_HOME" /bin/java

if [ "$0s400" != "true" ]; then
_RUNJDB="$JAVA_HOME" /bin/jdb

With:

# Set standard commands for invoking Java.
_RUNJAVA="S$JAVA_BIN"/java

if [ "$0s400" != "true" ]; then
_RUNJDB="$JAVA_BIN"/jdb

If the Tomcat server is already running, it requires a re-start after the above
configuration is done.

Note: In case tomcat is installed under different Unix profile, set
JAVA_BIN environment variable in .profile to include the Java
Runtime Environment absolute path.

For example:
export JAVA_BIN /usr/java6_64/jre/bin

export JAVA_BIN = /usr/javaé6_64/jre/bin//sparcv9 for Solaris
Sparc

Configuring Servlet Port

The default servlet port configured for the Tomcat installation is 8080. Ignore this
section if you need to use the default port.

If you need to use a different port number, you must first configure the port in the
server .xml file in the conf directory of Tomcat Installation directory.

To configure the Servlet Port, follow these steps:

1.

Navigate to SCATALINA_HOME/conf. Open server.xml and locate the tag:
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"Define a non-SSL HTTP/1.1 Connector on port 8080 "

Against this tag, a parameter is specified 'Connector port = "8080" . Edit this
value to the new port number that was used during the Infrastructure installation
process.

2. Save your changes in the server.xml file.

Note: Make a note of the servlet port configured. This information is
required during the installation of OFSAA Applications Pack.

Configuring SSL Port

If you need to configure and access your OFSAA setup for HTTPS access, ensure that
the following connect tag under Define a SSL HTTP/1/1 Connector on port 8443 in
<Tomcat_installation_ folder>/conf/server.xml file is uncommented for SSL
Configuration. (By default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note:

¢ Make a note of the servlet port configured. This information
would be required during the installation of OFSAA Applications
Pack.

¢ To enable https configuration on Infrastructure, assign value 1 to
HTTPS_ENABLE in OFSAAI_Instal IConfig.xml file for
Silent mode OFSAAI installation.

For more information related to SSL Configuration on Tomcat, see
http://tomcat.apache.org/.

Configuring Apache Tomcat Memory Settings
To configure the Apache Tomcat Memory Settings, follow these steps:

1. Locate the catalina.sh file that resides in the <CATALINA HOME>/bin folder.

2. Edit this file for customizing the memory settings and garbage collector settings
depending on the available hardware configuration.

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.
For example:
if [ -z "S$SLOGGING_MANAGER" ]; then
JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m
-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"
else
JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m SLOGGING_MANAGER"

fi
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Configuring Axis API

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_
4 /webapps/axis/WEB-INF/1ib and place it in the <Tomcat Installation
Directory>/1ib folder and restart the Tomcat Server.

Configuring Tomcat for User Group Authorization

Users with system authorization roles can access User Group Authorization. However,
to make it available on Tomcat web server, you have to perform the following
configuration steps:

1. Navigate to the $SCATALINA_HOME/conf folder and open web.xml file.
2. Enter the following in the web.xml file.
<init-param>
<param-name>mappedfile</param-name>
<param-value>false</param-value>
</init-param>

3. Save and close the file.

Uninstalling WAR Files in Tomcat
To uninstall WAR files in tomcat, see Uninstalling WAR Files in Tomcat.
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Configuring Resource Reference in Web

application servers

This section covers the following topics:

Configuring Resource Reference in WebSphere Application Server
Configuring Resource Reference in WebLogic Application Server

Configuring Resource Reference in Tomcat Application Server

Configuring Resource Reference in WebSphere Application

Server

This section is applicable only when the Web application server type is WebSphere.

This section covers the following topics:

Creating JDBC Provider
Creating Data Source
Creating J2C Authentication Details

Defining JDBC Connection Pooling

Creating JDBC Provider

1.

Open the WebSphere admin console in the browser window:
http://<ipaddress>:<administrative console port>/ibm/console. (https if
SSL is enabled). The Login window is displayed.

Login with the user id that has admin rights.

Expand the Resources option in the LHS menu and click JDBC > JDBC Providers.
The JDBC Providers window is displayed.
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Figure 6-12 JDBC Providers

JDEC providars 7=

JDBC providers

Use this page to adit properties of a JDBC provider, The JDBC provider object encapsulates the specific JDBC driver
implamentation class for azcess to the specific vendor database of your environment. Learn mare about this task in a
guided activity. A guided activity provides a list of task steps and more general information about the togic.

Bl Scope: Cell=GXS130REV-ZonelNodedSCell. Node=GXS150REV-Zone2Nodels, Server=serverl

Scope specifies the leval at which the rescurce definition is visible. For detallad
information on what scope is and how it works, see the scope settings help,

| ﬁoﬂc=ﬁ‘.f$1SC‘REV-Zone.’.NonﬂS, Server=serverl 'll“

[ EPreferences
l l] Dalata
R

ES!PI{!E Hame & | Scopa O Description O

! You can administer the following rescurces:

ey IDEC Provider HodemGXS1S0REV- Dearby emb ad non-XA JDEC

O d b add

Zoneilcdeldl, Sarvar=sarvarl Provider
FICMASTER Node=GXS150REV- Cracle JDEC Driver

O d I
ZonelNodals, Server=sarvarl

D r b ivar Node=GNS150REV- Oracle IDEC Driver
Zona2Nodall, Sarver=sarvarl

D RORFFW Hode=GXS150REV- RORFFW
Zona2Nodals, Sarver=sarvarl

D RORPNG Hode=GX5150REV- RORPHNC
Zone2Nodals5, Servarssarverl

D UBGSOFT Hode=GX5150REV- UPGSEFT
Zane2Nodels, Serverssarcarl

|:| YUPGEROR hode=GXS150REV- UPGSROR
ZoneZliodels, Servarssarvarl

D o A Hode=GX5150REV- UPGSSAND
Zane2hodels, Servarssarvarl

4. Select the Scope from the drop-down list. Scope specifies the level at which the
resource definition is visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create
new JDBC provider window is displayed.
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Figure 6-13 Create a new JDBC Provider

Create a new JDBC Provider -

Create a naw JOBEC Provider

Step 1: Creabte new

JDBC provider
= = Sat the basic configuration values of a JDOBC provider, which encapsulates the specific
Step 2: Enter . vendar IDBC driver implementatian classes that are required ta Beeass the d
database class path The wizard fills in the name and the description fields, but you can type different
information valuas,

Step 3: Summary Scopa

cells 1 GXS150REV-
Zone2Nodel5Cellinodes: GXS150REV-
Zonae2NodelS:sarvarsisarvarl

* Database type

| Cracle ™

* Provider type .
[Ormsle JRRL Ordvar 1
* Implementation type
| Connection pocl data source (¥

* Nama
[oracle JOBC Griver

Cescripkion
Oracle JOBC Driver [:l

._ CancePI

6. Enter the following details:

Table B-1 Fields and their description

Field Description

Database Type Oracle

Provider Type Oracle JDBC Driver

Implementation Type Connection pool data source

Name The required display name for the resource
Description The optional description for the resource

7. Click Next.
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Figure 6-14 Enter database class path information

ate a new IDBC Provider -

Create a new JOBC Provider

Step 1: Create new Enter database class path information |
JDBT provider =

Set the envirenment variables that represent the JOBC driver class files, which
WebSphere(R) Application Server uses to define your JDBE provider. This wizard page
displays the fila names: you supply only the directory locations of the files. Use
cemplete directory paths whan you type the JDBC driver file locations. For eaxample:
Ci\SQLLIEjava on Windova(R) or /homae/db2instl/sallib/jave on Linux(TM].

Step 2: Enter
database class path
information

Step 3: Summary

If a value iz specified for you, you may click Next to accept the value,

Class path:

=
B

Directory location for "cjdbes.jar” whith is saved as WebSphare variable
5{ORACLE JDEC_DRIVER_PATH}

|.l' cracle/orajdbc/app/orajdbe/ product/11.2.0/dient_1/jdbe/lib

i .ﬁrevi;:us_] 'Next || t.:-:-mce-l--'l:

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do
not use the trailing slash file separators.

The Oracle JDBC driver can be downloaded from the following Oracle Download
site:

® Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers
e Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server.

Note: See Appendix N for identifying the correct
ojdbc<version>.jar version to be copied.

9. Click Next. The Summary window is displayed.
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Figure 6-15 Summary

Step 11 Create new
JDEC providaer

Step 2! Enter
database dass path
information

Step 3: Summary

Create & new JDBC Provider -

Create 8 new JOEC Brovider

Sl.ll'ﬂl'rllf‘r of actions:

Opﬁnnl ] 'U'nluru |
|5w;w I;’l“—l GX5150REV- Zcﬂt'zﬂﬁdlUECI“lﬂod‘l GXS150REV- |

| ona2hiadals: & |
| JDEC pravider name ' |
| Dascription | oraca J06C Driver |
[ Clazs path | ${CRACLE_JDBC. DRIVER_PATH}/ojdbet jar |
_S{B;.AELE-_JEIEC DRIVER, I-*ATHJ' ..'mulq"orl};'::.;-npp. 'orajdbe/product/11. 2 ! unlg_l.fjdb{,-’lnb|
l Implamantation cll 55 Nama | ocracle.jdbc.pool. Drldtl:onn-lctl-nnpuofnotaSUUIu

| Previcus ]_:_.'l Finish || Cancel ]

10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Creating Data Source

The steps given below are applicable for both config and atomic data source creation.

1. Open this URL in the browser window: http: //<ipaddress>:<administrative
console port>/ibm/console. (https if SSL is enabled). The Login window is
displayed.

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > Data sources
option. The Data sources page is displayed.

Figure B—1 Data Sources

Step 1: Enter basic
data source
information

Step 2: Select JIDBC

providaer

Step 3: Enter
databaszse specific
proparties for the
dats source

Step 4: Setup
sacurity aliases

Step 51 Summanry

Create a data source -

Craate & cata source

Enter - basic data source information

Sat the basic configuration values of a datasource for asscciation with your JDBEC
provider. A datasource supplies the physical connections between the application
servar and the database.

Reguiremant: Use the Datasources (WebSphera{R} Application Server V4] conscle
pages if your spplications are based on the Enterprise JavaBesns[TM) (EIE) 1.0
specification or the Java(TM) Serviet 2.2 specification.

Seape

cells:GXS15OREV-
Zone2ModedSCallinodesGXS150REY-
Zona2ModelSizsarvars:sarvarl

# Data source namae
|Mu-rnT

* JNDI name
ligbe/DRYMOCK
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4. Select the Scope from the drop down list. Scope specifies the level at which the
resource definition is visible.

5. Click New. The Create a Data Source window is displayed.

Figure B—2 Create Data Source

Create a data source =

Cranté 5 dats source

Step 1: Enter basic mm-ﬁ;h;ﬂﬂmmﬂ
data source .
information

Sat the basic configuration values of a datasource for asscciation with your JOBC
provider. A datasource supplies the physical cannactions between the application

Step 2: Select I08C server and the database.

provider
= Regquirement: Use the Dataseurces (WebSphere(R) Application Server V4) consele
Stap 3: Enter : oages if your applications are based on the Enterprise JavaEBaans{TM) (EIB] 1.0
d“ﬂbﬂlﬂ specific spacification or the Java(TM) Serviet 2.2 spacification.
proparties for the
duts saurce Scope
cellz:EXS1S0REV-
Step 4: Satup Zone2NodelSCallinodes: GX51 S0REY-
sacurity aliases Zone2NodelFiserversisarverl
Step 51 Summary 4 Data source name
|-¢-tn-mT

* JHOI nama
ligbe/DRYMOCK

[es] _concei|

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive and ensure that JNDI name is
same as the "Information Domain" name.

7. Click Next. The Select JDBC provider window is displayed.

Figure B-3 Select JDBC provider

Create & data source

Step 1: Enter basic

data sourca

oo Specify a JDEC provider to support the datasource. If you choose to create a new
JOBC provider, It will be created at the same scope as the datasource, If you are
selecting an existing JDBC provider, only those providers at the current scope are
availatle fram the list,

Step 31 Enter
database specific .
proparties for the O Craate naw JDEC providar

dats saurce
'G]' Select an axisting JDBEC provider

Step 4: Satup
sacurty alissas

[Cracle JoEC Driver 3]

Step 3: Summary

8. Select the option Select an Existing JDBC Provider and select the required JDBC
provider from the drop-down list. Click Next.
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Figure B—4 Enter database specific properties

Create 3 data source

Step 1t Enter basic Select JDBC provider
data sourca m o e e
infoarmation

Spacify a JDBC providar to support the datasource. If you choosas to craate a naw
JOBC provider. it will be created at the same scope as the datasource. If you are

Step ;" Select JDBC selecting an existing JDBC provider, only those providers at the current scope are
provider

availatla from the list,

Step 31 Enter
database specific
properties for the
data source

{0 Craate new IDBC pravidar

@ Select an axisting JDEC provider
Step 4: Setup
sacurity alisses

[Oracle JDEC Drivar ]

Step 51 Summary

":_Im | Next|  Cancel |

9. Specify the database connection URL.
For example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID>

10. Select Data Store Helper Class Name from the drop-down list and ensure that the
checkbox Use this data source in container managed persistence (CMP) is
selected.

Note: For RAC configuration, provide the RAC url specified during
installation.

Example: jdbc:oracle:thin: @ (DESCRIPTION= (ADDRESS_

LIST= (ADDRESS= (PROTOCOL=TCP) (HOST=10.11.12.13) (port=1521)) (ADDRESS= (PRO
TOCOL=TCP) (HOST=10.11.12.14) (PORT=1521)) (LOAD_

BALANCE=no) (FAILOVER=yes) ) (CONNECT_DATA= (SERVICE_NAME=pgadb)))

11. Click Next.

Figure B-5 Enter Database specific properties

Create a dats source =

Creste a data source

Step 1: Enter basic Enter ' d,ltl bm ‘ll'ﬂdfh I t ,fu :-ZHI: n-m sou
data source A : 5C Specl properties he data Irce
Infarmation

Seak these database-specific properties, which are reguired by the database vender

b
Stap 2: Selact JDBEC JOBEC driver to support the connections that are managed through the datasource.

provider

Step 3: Enter Name | Value
database specific

properties for the * URL
dats source

| [10.184.108.91 11521 arl11g]

% Dats store helper clags name
: Oraclellg data store halper (V|

Stap 4: Setup
sacurity aliases

Stap 5: Summary [¥] Use thiz data source in container managed persistance (CMP)

| Previous I .5 Next I | Cancel I
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12. Map the J2C authentication alias, if already created. If not, you can create a new
J2C authentication alias by accessing the link given (Global J2C authentication
alias) or you can continue with the data source creation by clicking Next and then
Finish.

Figure B-6 Summary

Craate a data source

Stap 1t Enter basic Summary
data source 2

information =
Summary of actions:

Step 2: Select JDBC I COptions \f-.|-u.;
prowider

cells:GX5130REV-ZoneZNodedSCell:nodes GXS1SOREV-

Step 3: Enter Scope ZoneZNodelS:servars:sarverl
H ifi |

ﬁ:::ﬁﬁ;::ﬂ.ﬁﬁ: Data scurce name | AtarmT

data source JNDI name | jese/orRYMOCK

Stap 4: Satup Selact an _axisting Cracle IDBEC Driver

security aliases JDBC provider E

=3 Step 5: Summary :_‘T:_‘l:m.ﬂhﬁgﬂ class | oracle.jdbe.pool.CracleConnectionPeolbataSource

URL | jdbcioracla:thini@10.184,108.91:152110rcl11gr2

Data store helper class

S com.ibm.websphere.rsadapter.Oraclel OgDataStoreHelpar

Usze thiz datas zourze in
centainer managed true
persistence (CMP)
Component-managed
authentication alias

(mone)

Mapping-configuration

-."“ (mane)

Centainer-managed [
authaentication alias

| {nens)
]

You can also create and map J2C authentication alias after creating the data
source.

13. You must create another Data source by following the above procedure with
jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of
Infrastructure.

Creating J2C Authentication Details

The steps given below are applicable for creating both config and atomic J2C
Authentication.

To create J2C Authentication details, follow these steps:

1. Select the newly created Data Source and click JAAS - J2C authentication data
link under Related Items.

JAAS- J2C authentication data
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Figure B—7 JAAS- J2C authentication data

Data sources > Default Datasource > JAAS - 12C authentication data

Specifies a list of user identities and passwerds for Java(TM) 2 connecter security to use,

Ei Prafix new alias names with the node name of the cell (far compatibility with earier relessaz)

 Apply
B Praferances

| [Now] [ouieea |

ek

| Salact| Alias = |UserID 2 | Description &
| You can administer the following resources:
B GXS1T0REY- upgsconf FICMASTER
n& EICMAST]
[] |Sxs1508Ev-Zone2NodedS/RORFFW | rorffw
D -, b= FErgNG
D XS 1 SOREV-Zang2H PET | upgspft upgspft
El X U upgsprod upgsprod
fin]= =
D 3 REW: upgsror UpgEror
Tl )=
D 1 upgssand upgssand
ngah = &N
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2. Click New under the Preferences section.

Figure 6-16 JAAS- J2C authentication data- New

Data sources > Default Datasource > JAAS - 12C authentication data > New

Specifies a list of user identities and passweords for Java(TM) 2 connector security to use.
General Properties

+* 2liaz
[atm |

* Usar ID
||,|pgi‘-"3

* Passwerd
|I.‘l.. L]

Descrigtion
|Af¢mi: IrAstance

Iipnlyl E‘k Ront[ Cancal I

3. Enter the Alias, User ID, Password, and Description. Ensure the following;:

® User ID is the Oracle user ID created for the respective Config and Atomic
Schema for the "Information Domain".
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* Specify the Config database user ID and password information for the
jdbc/FICMASTER data source, and specify the Atomic database user ID and
password information for the Atomic schema data source that you created
earlier.

4. Click Apply and save the details.

Defining JDBC Connection Pooling
To define the JDBC connection pooling ensure that you have created JDBC Provider
and Data source to access the data from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources
option. The Data sources page is displayed.

2. Click the newly created Data Source $DATA_SOURCES and navigate to the path Data
sources>S$DATA_SOURCES>Connection pools.

Figure B-8 Connection pools

Data sources. =

Dats sources > GAFUSION DATA SOURLE > ConnectHon pools

Use this page to set properties that impact the timing of connedion management tasks, which can affect
the parformance of your application, Considar the default values carafully; vour application requiramants
right warrant changing these values,

Configuration

Lensral Properties

Additional Properties

Scope P
[zal ZEdart n1c e dort Advancad
callz:ipsZEderNodeDiCallinadesiipal2bdarNadallisarvars isarverl 2 =
sonnaction pool
propariss

* Connection timeout

seconds Connadtion pogl
storm propart
* MEximum sennactions

|1D0 connactions

* Minirmurm connactions

|10 connactions
*Ruaplrd

|i=0 seconds

* Unused timeout
|1800 seconds

+ Aged timeout
o saconds

Purga policy .
EntiraPool el

npply] ﬂ Rt:n| Gam:ul|

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100
connections, and Minimum connections to 10 connections as shown in the above
figure. You can also define Reap Time, Unused Timeout, and Aged Timeout as
required.

Configuring Resource Reference in WebLogic Application
Server

This section is applicable only when the Web application server type is WebLogic.This
section includes the following topics:
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Creating Data Source

Creating GridLink Data Source

Configuring Multi Data Sources

Configuring Advanced Settings for Data Source

Defining JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:

"For a Non RAC Database instance, Generic Data Source has to be created. See
Create Data Source.

"For a RAC Database instance, Gridlink Data Source has to be created. See Create
GridLink Data Source.

"When Load Balancing/Fail over is required, Multi Data Source has to be created.
See Configure Multi Data Sources.

Creating Data Source

The steps given below are applicable for both config and atomic data source creation.

1.

Open the following URL in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSL is
enabled). The Welcome window is displayed.

Login with the Administrator Username and Password.

Figure B-9 Welcome

ORACLE
WebLogic Server® 11g

Administration Console

3.

Welcome

oG I 10 ek vth S WehLoms Sarver diman
Username:
Passwaord:

From the LHS menu (Domain Structure), click Services > Data Sources. The
Summary of JDBC Data Sources window is displayed.
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Figure B-10 Summary of JDBC Data Sources
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4. Click New and select Generic Data Source option. The Create a New JDBC Data
Source window is displayed.

You can also select GridLink Data Source or Multi Data Source while creating a
Data Source. For more information, see Creating Data Sourceor Configuring Multi
Data Sources.

Figure 6-17 Create a New JDBC Data Source

Create a New JDBC Data Source
Moot | Cancet
! !

JDEC Data Source Properties
The followeng propertes wil be used to denbfy your new JOBC da'la source.

" bneficates nequared felds

‘What would you like to name your new JOBC data source?
o] * Mame: ATOMSTSOL

What JM0% name would you ikt 10 sssign to your new J0BC Data Source?

5] INDT Hame:
Jdbo/RTCHSTSOL

‘What database type would you like to select?

Database Type: Oracle -
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5. Enter JDBC data source Name, JNDI Name, and select the Database Type from
the drop-down list. Click Next.

Ensure the following:
¢ The JNDI Name field should be in the format "jdbc/informationdomain”

* Same steps needs to be followed to create a mandatory data source pointing to the
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name.

¢ JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.
¢ Required "Database Type" and "Database Driver" should be selected.

Figure B—11 JDBC Data Source Properties

Create a New JDBC Multi Data Source
Back  Hext | Lance

Select Data Source Type

Fleass selart typs (XA or Mor-XA) of a1 souree you vwoubd e t5 add B your nesw J0BC MUt Dats Soures
) XA Driver
& Non-XA Driver

Sack  Phaxt | Camcal

6. Select the Database Driver from the drop-down list. You need to select the
Database Driver depending on database setup, that is, with or without RAC. Click
Next.

Figure B—12 Transaction Options

Create a Bew JDBC Data Source
Back | | higsd Cancei

Transaction Options
ol Flie salastad foni-NA I0BC driver B reste Aatahass Sanceshin N your ney DAL Srds,
Does thes St source support giobal transactons? IF yes, please choose the ransacton protoco! for this data sauroe.

[¥] Supports Global Transactions

Salact this cotion f you want to enable non-X& J0BC connections from the data source io parbooate n global ransactions Leng the Loppng Last Aesouree (LLR) ranesction cotmizabon,
Recommended in place of Emudate Two-Phesse Commit.

) Logging Last Resource

Seiect this option If you want to enable non-XA JOBC connections from fhe data source to emulale parbopation in giobal ransbctons usng JTA. Sefect the cpbion only if your apphzation can
Ioerale et CONGROnS.

) Emulate Two-Phase Commit

Salact this opson o you want to snable fon-Xa JDBC tonnections from the dats sourcs to parbcpats n gobal ransastioes usng e one-phass comimi ANEACHIN Profsssng. With this option, no
other resources can partiopate in the giobal transaction.

&) One-Phase Commit

Back | | Nexd Cangel
I

7. Select the Supports Global Transactions checkbox and the One-Phase Commit
option.
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8. Click Next. The Connection Properties window is displayed.

Figure B—13 Connection Properties

Create a liew JDBC Data Source

Back | | Mext.| | | Canced
| ¥

Connection Properties

Define Connecion Properbes.
WWhate the name of the databpss you would ke o cornect 1B?
Database Name: fgghu
WWhatis the rame or [P address of the catsnase saryer?

Hosk Hame; 10 184,74 80
What s the port on the database ferver used to cornect to e database?

e 1521
‘What database account user name da you want in use to create datsbase conneciions?
Database User Rame:

ggatam

Whatis the database BECHUNT DESSHINT 10 LUSe 1D Craabe SATALASS OONNECTions?

Password: —
Confirm Password: ssnnna
Back | | et | | cancsi

9. Enter the required details such as the Database Name, Host Name, Port, Oracle
User Name, and Password.

10. Click Next. The Test Database Connection window is displayed.
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Figure B—14 Test Database Connection

Create a New JDBC Data Souroe
TestConfguration. | Back | liext | | Finish| | Cancel

Test Database Connection
Test the databicce sradshiity and the connection propertes you pronvided.

Wit i the £l paciage name of JDBC drever dass used to reats database CoMnechiond in e cornection pool?

Drhver Chase Name: oracle jdbe OracleDmer
“What 5 the URL of the databass to connect in? The format of the LRL vanies by JOBC driver.

URLS jdbe oracle thin @10 164, ]
WAt databass aooourt user name do yOu WANT 10 Lse B CeRss databise Cormechons?

Database User Name: saatom

What o the database acoount passydnd 1o use to reate database conmectors?

Password: SRR EERERRR R

Confirm Password: BEdERRRERRR R R RN

What are the propertes to pass to the JIDEC driver when créating database connechons?

Properties:

uamI~asatem |

The sat of driver propertes whosae values ane derived a1 runtine from the named system property,

System Froperties:

Whal tabie name of SO S185Emant woikd you Bke 10 use 1 t851 databags Jonnetons?

Test Table Hame:

S0L SILECT 1 FROM DUAL |

Teas Configuraten | | Back | Nest |an |Cl‘.|!ﬂ

11. Verify the details and click Test Configuration and test the configuration settings.
A confirmation message is displayed stating "Connection test succeeded.”

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.
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Note:

e "User ID" is the Oracle user ID that is created for the respective
"Information Domain".

e "User ID" to be specified for data source with "FICMASTER" as
"INDI" name should be the Oracle user ID created for the
"configuration schema".

13. Select the new Data Source and click the Targets tab.

Figure B—15 Select Targets

Create a New JDBC Data Source
Sack Finish | | Cance
Select Targels

Wil CAN SAlCT one o morne targats to deplay your nevw JOBC clats sourcs, If you don't salect & targat, the date scurce will be created but ot deploped. Yoo wil reed 1o deploy the data source

&E B laber bme.

Servers

[ AdminServer

Back Fmisn Cancel

14. Select the AdminServer option and click Finish.

Creating GridLink Data Source

If you have selected the option, New > GridLink Data Source while creating the "Data
Source", you can directly specify the JDBC URL as indicated.
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Figure 6-18 Create a New JDBC GridLinkData Source

Create a New JOBC Gridiink Data Source
Back Toeut Cancel
Connection Properties
Diafine Corvacban Propartes,

Enber Complets J08C URL for Gridunk database

Comphete 1080 URL:

Wit database acoount user name O ol want [0 use to Treate dalabase CONPRCTong!

Database User Name:

wWhat &5 the databage account password B use to creabe database cormections?

Password:
Confirm Password:

Back | leaxt | Cancel

1. Enter Data Source Name, and JNDI Name.

Ensure that the "INDI Name" field is specified in the format "jdbc/infodomname" and
the XA Driver checkbox is not selected. Click Next.

Figure 6-19 JDBC GridLinkData Source- Connection Properties

Create a lew JDEC Gridiink Data Source

Next | | Cancal

JDBC Gridlink Data Source Properties

The foliowing properties vl be Lsad to identfy your new JDBC Griclink dats source

VWhat would you lke: o name your new JOBC Gridlink data source?

= * hame:

15 * name itrd

Vihat PO name woukd you Be 10 33500 fo your e JDEC Gridlink dats souwnce?
-!:—-J JHDT lame:

jdbe/xya

What catabpss type would you lie to salect?
Database Type: Crade
Is hes XA driver?

[] xADriver

e | | Cangel
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2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish.
The created "Data Source" is displayed in the list of Data Sources.

Configuring Multi Data Sources

A JDBC multi data source is an abstraction around a group of data sources that
provides load balancing and failover between data sources. As with data sources,
multi data sources are also bound to the JNDI tree. Applications can look up a multi
data source on the JNDI tree and then reserve a database connection from a data
source. The multi data source determines from which data source to provide the
connection.

When the database used is Oracle RAC (Real Application Clusters) which allows
Oracle Database to run across a set of clustered servers, then group of data sources can
be created for instances running on a set of clustered servers and a JDBC multi data
source can be created so that applications can look up a multi data source on the JNDI
tree to reserve database connection. If a clustered server fails, Oracle continues
running on the remaining servers.

1. Open WebLogic Admin Console in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSL is
enabled). The Login window is displayed.

2. Login with the "User ID" that has admin rights.

3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data
Sources. The Summary of JDBC Multi Data Sources window is displayed.

Figure 6-20 Summary of JDBC Multi Data Sources

Summary of IDBC Multi Data Seurces

Use this page 10 creabe or view muld data sourdes in your domain.

P Customize this tabie
Hulti Data Sources{Filtered - More Columns Exist)

New

i alaneng and fadeuer Detueen dAT8 SoUFoas, A8 with SNLS SoUF8E, MUl dATA SOURCEE e Bis Baund
repirve & datsbass conrection fom & cats surcs, The mull fats soures determines fom which dats

LIS B $5TE S B A0 GON AFOUNT B Oroud o ANtE S0UrTed ThAY prohs
DL tras, Aandeations cin look up & At dats shures on the IND] tree aod o
trade e COMMeChon.

Showing 1o 2of 2 Previous | Hext

O | wame < JHDI Rame Algorithm Type Targets
O |rustonns oo FUSIONRHEL Load-Balancing AdmnSaragr
O |rosos FOrROARHELQT Loag-Batancng AdmenSarver

Haw

Shoming Lta 2af 2 Frevious | Next

4. Click New. The New JDBC Multi Data Source screen is displayed.

Note: Ensure that the Data Sources which needs to be added to new
JDBC Multi Data Source has been created.
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Figure 6-21 Configure the Multi Data Source

Create a New J06OC Mults Data Source
Pig] Cange:
Configure the Multi Data Source
The faloving properiss be usad b identify pour e JDBC st Gt suroe
Vit wiouid you Bee fo nevme your new JDBC muls OBt sowrTe?
'g Plamie: Il o a
JOBC Multi Data Source-0
hat INDLname veousd you o to B2sgn bo your few IDBC muit data Sauroe?
15] IHD1 Name:
gbg/ infodomname
''''' it tvpe for this JOBC Muls Dats Source vwould wou o to sele
A5 Algorithm Type: Load-Balancing ¥
Ml Canice

5. Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from
the drop-down list. Click Next.

Note:

e The JNDI Name has to be specified in the format
jdbc/infodomname.

e JNDI Name of the Data Sources that will be added to new JDBC
Multi data source should be different from the JNDI name
specified during Multi Data Source.

* Same steps needs to be followed to create a mandatory data
source pointing to the "configuration schema" of infrastructure
with jdbc/FICMASTER as JNDI name for Data Source.

e JNDI Name provided in multi data source should be the same
name that will be mentioned in the web.xm1 file of OFSAAI
Application.

* You can select the Algorithm Type as Load-Balancing.
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Figure 6-22 Select Targets

Create o New JDBC Multi Data Source

Bac | hexd | Cancal

Select Targets

VoL CBN SRR 0Nl OF MHONE TANC DS RO DDy wOLE ety JOBC WU Dtk Source,
Servers

AdminServer

Back || Nest | | Cancal

6. Select the AdminServer check box and click Next.

Figure 6-23 Select Data Source Type

Create a New JDBEC Multi Data Source
Back | Hext | Camcai

Select Data Source Type
Flease selazt type (KA or hoa<iA) of data sounoe you would loe to add 1o your new J0SC Mut Data Source

) XA Driver
(%) Non-XA Driver

Back bt | Eancal

Select the type of data source which will be added to new JDBC Multi Data
Source. Click Next.

7.

Figure 6-24 Add Data Sources

Create a Hew JDBC Multi Data Source

Sack Firsah Gancel
Add Data Sources
What JOBC Cata Sounces would you e 10 a0¢ o your ey JOSC Mult Data Sounce?

Data Sources:

Available Chosen

Cranis a feeve Dala Bource

Sack Finsh | | Cancai

8. Map the required Data Source from the Available Data Sources. Click Finish.

The New JDBC Multi Data Source is created with added data sources.
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Configuring Advanced Settings for Data Source

Perform the following steps for advanced settings for Data Source:

1. Click the new Data Source from the Summary of JDBC Data Sources window. The
Settings for <Data Source Name> window is displayed.

2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the page, and check the Test
Connection of Reserve checkbox (Enables WebLogic Server to test a connection
before giving it to a client).

To verify if the data source is valid, select "Data Source name". For example,
FICMASTER.

Figure 6-25 Settings for <Data Source Name>

Settings for FICMASTER
Configuration = Targets | Monitoring | Control = Security | Notes

Stabstcs | Testing

Usa this paga to test database connections in this JOBC data source.

¥ Customize this table
Test Data Source (Filtered - More Columns Exist)

Showng 1to 1of 1 Previous | Next

Showing 1to 1of 1 Previous | Mext

4. Select the server and click Test Data Source.
A message is displayed indicating that the test was successful.

5. Once the "Data Source" is created successfully, the following messages are
displayed:

* All changes have been activated. No restart is necessary.
* Settings updated successfully.

If not, follow the steps given above to recreate the data source.

Defining JDBC Connection Pooling

To define the JDBC connection pooling, ensure that you have created JDBC Provider
and Data source to access the data from the database.

1. Click the newly created Data Source $DATA_SOURCES$ and navigate to the path
Home >Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC
Data Source-<INFODDOM_NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity
Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.
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3. Click Save.

Configuring Resource Reference in Tomcat Application

Server

This section is applicable only when the Web application server type is Tomcat.
This section covers the following topics:

¢ Creating Data Source

* Defining JDBC Connection Pooling

e Configuring Class Loader for Apache Tomcat

Copy the Oracle JDBC driver file, "ojdbc<version> jar" from <Oracle Home>/jdbc/lib
and place it in <Tomcat Home>/1lib.

Note: See Appendix N for identifying the correct
ojdbc<version>.jar version to be copied.

Creating Data Source

To create "data source" for Infrastructure application, navigate to <Tomcat Home>/conf
and edit the following block of text by replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the
prefix of setupinfo depending on the value set for PREFIX_SCHEMA _
NAME in <<APP Pack>>_SCHEMA _IN.XML file of Schema Creator
Utility.

For example: if the value set for PREFIX_SCHEMA_NAME is DEV
and the schema name was mentioned as ofsaaconf, then the actual
schema created in the database would be DEV_ofsaaconf.

<Context path ="/<context name>" docBase="<Tomcat Installation
Directory>/webapps/<context name>" debug="0" reloadable="true"
crossContext="true">

<Resource auth="Container"
name="jdbc/FICMASTER"
type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the configuration schema>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxActive="100"
maxIdle="30"
maxWait="10000"/>

<Resource auth="Container"
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name="jdbc/< INFORMATION DOMAIN NAME >"
type="javax.sqgl.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the atomic schema>"

password="<password for the above user id>"

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

Note:

® The <Resource> tag must be repeated for each Information
Domain created.

e After the above configuration, the "WAR" file has to be created
and deployed in Tomcat.

Defining JDBC Connection Pooling
To define the JDBC connection pooling, do the following:

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path $TOMCAT
DIRECTORY/1ib/.

Note: See Appendix N for identifying the correct ojdbc<version>jar
version to be copied.

2. Edit the server.xml present under the path $STOMCAT_DIRECTORY/conf/ with the
below changes, which is required for connection pooling.

<Context path="/ SCONTEXTNAMES" docBase=" $APP_DEPLOYED_PATHS " debug="0"
reloadable="true" crossContext="true">

<Resource auth="Container"

name="7jdbc/ S$INFODOM_NAMES"
type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username=" SATOMICSCHEMA_USERNAMES"
password="$ATOMICSCHEMA_PASSWORDS"
url="$JDBC_CONNECTION_URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"
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logAbandoned="true" />
</Context>

Note the following:

Note:

e $APP_DEPLOYED_PATHS should be replaced by OFSAAI application
deployed path.

e $INFODOM_NAMES$ should be replaced by Infodom Name.

e SATOMICSCHEMA_USERNAMES should be replaced by Atomic schema
database user name.

e SATOMICSCHEMA PASSWORDS should be replaced by Atomic schema
database password.

e $JDBC_CONNECTION_URL should be replaced by JDBC connection
string jdbc:Oracle: thin:<IP>:<PORT>:<SID>. For example,
jdbc:oracle:thin 10.80.50.53:1521:s0luint

®  The User-IDs for configuration/ atomic schemas have the prefix of
setupinfo depending on the value set for PREFIX_SCHEMA_NAME in
<<APP Pack>>_SCHEMA_IN.XML file of Schema Creator Utility.
For example: if the value set for PREFIX_SCHEMA_NAME is DEV and
the schema name was mentioned as ofsaaconf, then the actual schema
created in the database would be DEV_ofsaaconf.

Configuring Class Loader for Apache Tomcat
1. Edit the server.xml available in $TOMCAT HOME/conf/ folder .
2. Add tag <Loader delegate="true" /> within the <Context> tag, above the

<Resource> tag. This is applicable only when the web application server is Apache
Tomcat 8.

Note: This configuration is required if Apache Tomcat version is 8.
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Creating and Deploying EAR/ WAR File

This section covers the following topics:
* Creating EAR/WAR File
* Deploying EAR/WAR File

Creating EAR/WAR File
To create EAR/WAR File, follow these steps:
1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server.
2. Execute ./ant.sh to trigger the creation of EAR/ WAR file.

3.  On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time
taken" message is displayed and you will be returned to the prompt.

Figure C-1 Creating EAR/ WAR File

4. The EAR/ WAR file - <contextname>.ear/ .war -is created.
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Note: The <contextname> is the name given during installation. This
process overwrites any existing version of EAR file that exists in the
path.

In case of OFSAA configured on Tomcat installation,
<contextname>.war is created.

Deploying EAR/WAR File

Note: Remove the existing Admin Tools deployment (which is
integrated with OFS ECM pack).

This section covers the following topics:
¢ Deploying EAR/WAR Files on WebSphere
¢ Deploying EAR/WAR files for WebLogic

¢ Deploying Tomcat WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment
of Applications Pack Web Archive. This is applicable to all Web
servers (WebSphere, WebLogic, and Tomcat). For more information,
see Clearing Application Cache section.

Deploying EAR/WAR Files on WebSphere
To deploy Infrastructure application in WebSphere:

1. Start WebSphere Profile by navigating to the path "/<WebSphere_Installation_
Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Name>/bin/" and
execute the command:

./startServer.sh serverl

2. Open the following URL in the browser: http://<ipaddress>:<Administrative
Console Port>/ibm/console. (https if SSL is enabled). The login screen is
displayed.
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Figure C-2 Login Window

. ‘ WebSphere Integrated
Solutions Console

User ID:
admin

Password:

b ..'..|
@

Licensed Materials - Property of IBM (c) Copyright IBM Carp. 1997, 2011 All Rights Reserved.
1BM, the IBM logo, ibm.com and WebSphere are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide. Other
product and service names might be trademarks of IBM or other companies. A current list of
IBM trademarks iz available on the Web at Copyright and trademark information.

o

3. Enter the user credentials which has administrator rights and click Log In.

4.  From the LHS menu, select Applications and click New Application. The New
Application window is displayed.

Figure C-3 New Application

MNew Applicatian

New Application

This page provides links to create new applications of different types,
Install a New Application

—
Mew Enterprise Applicatien

% Mew Business Level Application

L —

-I N

5. Click New Enterprise Application. The Preparing for the application installation
window is displayed.
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Figure C—4 Preparing for the application installation

Preparing for the application installation

Specify the EAR, WAR, JAR, or SAR medule to upload and install,

Path to the new application

) Local file system

@ Remote file system

Full path
|.|"scratch.-'uraclefwas855.-’pruﬁ|es.n’TE5T80MI.-'MISI1I Browse... I

M | Cancel

6. Select Remote File System and click Browse. Select the EAR file generated for
OFSAAI to upload and install. Click Next.

Figure C-5 Installation Options

Preparing for the application installation

How do you want to install the application?

@ Fast Path - Prompt anly when additianal infarmation is required.

) Detailed - Show all installation options and parameters,

& Choose to generate default bindings and mappings

Previous I NE-CI:| Cancel |

7. Select the Fast Path option and click Next. The Install New Application window is
displayed.
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Figure C—6 Install New Application
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= Step 1: Select Select installation options
installation options
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Deploy Web services
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Application Build ID
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8. Enter the required information and click Next. The Map Modules to Servers

window is displayed.
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Figure C—7 Map Modules to Servers

Install New Application

Step 1 Select
installation options

= Step 2: Map modules
to servers

Step 2 Summary

Specify options for installing enterprise applications and modules,

Map modules to servers

Specify targets such as application servers or clusters of application servers where you want to install the modules that are
contained in your application, Modules can be installed on the same application server or dispersed among several application
servers. Also, specify the Web servers as targets that serve as routers for requests to this application. The plug-in
configuratien file (plugin-cfg.xml) for each Web server is generated, based on the applications that are routed through,

Clusters and servers:

| WehSphere:cell=ofss2311701Nade02Cell node=ofs523117 01 Nade02,server=serverl Apply

B0

Select| Module URI Server
OFSAAIT AAIS0.war,WEB- WehSphera:cell=ofs523117 01Node02Cell,node=0fs523117 01 Node02, server=serverl
Web
5 INFfweb.xml
Application

Previous | Mext | Cancel |

9.

Select the Web Application and click Next. The Map Resource References to
Resources window is displayed.
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Figure C-8 Map Resource References to Resources
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Resource
authorization:
Shaal BDS01Q. war, WEB- | | | | Container
™| Web e e jdbefBDEOLOT Brawse... L
Application R Authentication
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10. Map each resource defined in the application to a resource JNDI name defined

11.

12.

earlier.

method created earlier.

Click Modify Resource Authentication Method and specify the authentication

You can specify "config" for FICMASTER resource or "atomic" for atomic resource
as the authentication method.

hosts for Web Modules window is displayed.

Select the OFSAAI Web Application check box and click Next. The Map Virtual
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Figure C-9 Map Virtual host for Web Modules

Install New Application

Specify options for installing enterprize applications and modules.

installation option

- 2. Specify the virtual host where you vant to install the Web modules that are contained
Step 2 Map in your application. You can install Web modules on the same virtual host or disperse
modules to servers them among several hosts.

Step 2 Map

B Apply Multiple Mappings

[s]

resource references
to resources

Step 4: Map virtual Salect Wab module Virtual host

hosts for Web

modules [+l OFSAAI Web Application dafault_host ¥

13. Select the Web Application check box and click Next. The Summary page is
displayed.
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Figure C-10 Summary
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14. Click Finish and deploy the Infrastructure Application on WebSphere.
On successful installation, a message is displayed.

15. Click Save and save the master file configuration. The details are displayed in the
Master File Configuration window.

Start the Application
To start the application, follow these steps:

1. Expand Applications > Application Type > WebSphere enterprise applications.
The Enterprise Applications window is displayed.
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Figure C-11 Enterprise Application

Enterprise Applications
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2. Select the installed application and click Start.

Note:

¢ <profile name> is the profile name given while creating the
WebSphere profile.

¢ <cell name > is the cell name given during profile creation.

*  <contextname> is the context name given during installation.

Deploying EAR/WAR files for WebLogic

Following are the steps for deploying Infrastructure application that would be created

during installation:

1. Navigate to the path "<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin" in the machine in which WebLogic is
installed.

2. Start WebLogic by executing the command:
./startWebLogic.sh -d64 file

3.  Open the URL in the browser window: http:/ /<ipaddress>:<admin server
port>/console. (https if SSL is enabled). The Sign in window of the WebLogic
Server Administration Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing
"./startofsaai.sh" as mentioned in Starting Infrastructure Services
section.

4. Log on to the WebLogic Server by entering the user credentials having privileges

to deploy the EAR file.
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5. From the Domain Structure LHS menu, click Deployments. The Summary of
Deployments window is displayed.

Figure C-12 Summary of Deployments
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Change Center @ Home Log Out Preferences Record Help Q Welcome, upg7273 !Comec'hed to:

upg?273

View changes and restarts

Configuration editing is enabled. Future

changes will automatically be activated as you Depio
madify, add or delete items in this domain, Sumemary.of yments

Home =Summary of Deployments

Control = Manitoring
Domain Structure

upa7273
This page displays a kst of Java EE appbcations and stand-slone application modules that have been instaled to this
domain. Installed applications and modules can be started, stopped, updated (redeployed), or deleted from the domain by
first selecting the application name and using the controls on this page.

_;‘_"Setwlt‘r' Reaims To install a new application or module for deployment to targets in this domain, dick the Install button.
- Interoperability
B}-Diagnostics
¥ Customize this table
Deployments
Install | ¥ i Showing 1to 1of 1 Previous | Next
] | name & State | Health | Type gﬁﬁ?m“*
How do L.. kS _ = i
O | ® BRupgrzzz actve |Pox [E "w':;‘:‘ 100
System Status @
| Install | Y X Showing 1to 16f 1 Previous | Next

6. Click Install. The Install Application Assistant window is displayed.

~

Select the Exploded EAR directory after browsing to the directory where it is
saved and click Next.

Explode EAR File
To explode EAR, follow these steps:

1. Create the "applications” folder under domain name. For example, "/Bea/user_
projects/domains/ <Domain _name>/applications'.

2. Create <context_name>.ear folder under "applications" folder.

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear.

4. Explode the <context_name>.ear file by executing the command:
jar -xvf <context_name>.ear

5. Delete the <context>.ear and < context >.war files (recently created)
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_
NAME>/applications/<context_name>.ear.

6. Create a directory <context_name>.war under <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear.

7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear/<context_name>.war.
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8. Explode the <context_name>.war file by executing the following command to get
the directory structure:

jar -xvf <context_name>.war

Install Application
To install Application, follow these steps:

1. Open the Install Application Assistant.

Figure C-13 Install Application Assistant

Install Application Assistant
et | | Cancel

Locate deployment to install and prepare for deployment

Select the fim path that represents the appbcation root drectary, archive fie, exploded archive drectory, or appbcation module descriptor that you want to instal, You can also enter the path of

the application directory or fie in the Path field,
Mote: Only vaid fle paths are displaved below, If you cannet find your degloyment fles, upload yeur flels) andfor confirm that your apphcation containg the requred deployment desoripters,

Path: foradata2’wi1035/0racle/Middleware/user_projects/domains/upg7 27 3/applications

Recently Used Paths: foradatadfvd 1035/Oracle Mddieware fuser_projects/domains jupg7273/applications
Middleware [user_projects [ domans [ upg 7273 [ appications

Current Location: 10,184, 134. 147 [ oradatad / wi1035 [ Orade |
O LW upg7 27 3.ear (open drectory)

Het | | | Cancei

2. Click Next.

Figure C-14 Install Application Assistant

Install Application Assistant
Back | | Mexi | cancai

Choose targeting style

Targets are the servers, dusters, and virtuad hosts on which this deployment will run. There are several ways you can target an application.
@ Install this deployment as an application
targeted to the same locations, This is the most common ugege.,

The sppbication nd its components will be

) Install this deployment as a library

Appication librares are deployments that are avadable for other deployments to share, Libraries should be available on al of the targets running ther referencng applications

Back | | Mext | | | Cance:
3. From the Choose targeting style section, select the Install this deployment as an

application option and click Next.

The Optional Settings window is displayed.
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Figure C-15 Optional Settings

Install Application Assistant
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Optional Settings
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General

What do you want to name this deployment?
Hame: upa7273

Security
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(%) DD Only: Use only roles and policies that are defined in the deployment descriptors.

) Custom Roles: Use roles that are defined in the Administration Consale; use policies that are defined in the deployment
descriptor.

() custom Roles and Policies: Use only roles and policies that are defined in the Administration Console.

3 Advanced: Use a custom model that you have configured on the realm’s configuration page.

Source accessibility

How should the source files be made accessbie?
(&) Use the defaults defined by the deployment’s targets

Recommended selecton.
) Copy this apphcation ento every target for me

Duning deployment, the fles will be coped automanically to the managed servers 1o which the apploaton is tangeted,
O 1will make the deployment accessible from the following location
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4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles
and policies that are defined in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location
option under the Source accessibility section.

7. Click Next to continue.

The Deployment Summary window is displayed.
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Figure C-16 Deployment Summary

Install Application Assistant
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Security Model: D0Only: Use only robes and polices that are defined in the depioyment descriptors,
Target Summary
Components <= Targets
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Back i Finish Cancel

8. Select the Yes, take me to the deployment's configuration screen option and click
Finish.

The Settings for <Deployment Name> window is displayed.
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Figure C-17 Settings for <Deployment Name>
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10.
11.

Review the general configuration details of the deployment. You can also update
the configuration of the deployment in this window. In the Overview tab, you can
view the complete deployment configuration.

Click Save to update the changes, if any.
From the LHS menu, click Deployments.

The Summary of Deployments window is displayed.
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Figure C-18 Summary of Deployments
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12. Select the newly deployed Infrastructure application and click Start > Servicing
all requests. Ensure that the Infrastructure server is up and running.

Figure C-19 Summary of Deployments
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13. The State of the deployed application will be displayed as Active if started
successfully.

Deploying Tomcat WAR Files on Tomcat

Before deploying the WAR files, ensure that the previously deployed applications of
Infrastructure are uninstalled. See Uninstalling Previously Deployed WAR Files in
Tomcat for the procedure to uninstall the previously deployed Infrastructure war files.

On the machine that hosts Tomcat, follow these steps to deploy Infrastructure
application:

1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to
<Tomcat Installation Directory>/webapps/ directory.
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Figure C-20 Tomcat Home Page
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2. Click Manager App. The Conne

3.

ct to dialog box is displayed.

Enter the User Id and Password that has admin rights and click OK. (For user

creation in tomcat, see Tomcat User Administration. The Tomcat Web Application
Manager window is displayed with the list of all the applications deployed.
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Figure C-21 Tomcat Web Application Manager
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4. In the Deploy section, enter the Context Path provided during the installation as

" /<context-name>".

5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_
HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.
6. On successful application deployment, a confirmation message is displayed.

Start the Tomcat server. See Starting Infrastructure Services for more details.
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Starting / Stopping Infrastructure Services

This section details about how to start and stop Infrastructure services. This appendix
covers the following topics:

e Starting Infrastructure Services
* Stopping Infrastructure Services

¢ (leaning up the environment

Starting Infrastructure Services

Once the installation of Infrastructure is completed successfully and the
post-installation steps are completed, the servers must be started. Log on to each
machine and run the .profile file. All servers mentioned must be started from the
same shell encoding. The following servers mentioned are dependent on each other. It
is mandatory to maintain the order in which the servers are started. Allow each of the
servers to initialize completely before starting the next server.

1. On the machine in which Infrastructure Application components have been
installed, navigate to $FIC_APP_HOME/common/FICServer/bin and execute the
following command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the
command "nohup ./ startofsaai.sh &". Starting the process using
"nohup" and "&" will return the command prompt without having to
wait till the process completes. However, this command cannot be
used when you are starting the server for the first time or starting
after changing user password in the configuration database schema.

2. Start ICC server:

¢ On the machine in which Infrastructure default Application components have
been installed, navigate to $FIC_HOME/ficapp/icc/bin

e Execute the command:

./iccserver.sh

Note: Only Infrastructure Default Application Server would hold
ICC component.
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3. Start Back-end Services:

®  On the machine on which Infrastructure Database components have been
installed, navigate to $FIC_DB_HOME /bin and execute the command to start

"Agent server":

./agentstartup.sh

Or

e Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP
data server and AM services:

Starting Web application servers
Start the Web application server depending on the type from the following table.

Table D-1 Webserver start up options

Start up Option

Description

Starting WebSphere profile

On the machine in which Web sphere is installed, navigate to
[Webshpere_Install_Directory]
/AppServer/<profiles>/<profile name>/bin and execute the
command: . /startServer.sh serverl

Starting WebLogic Domain

On the machine in which WebLogic is installed, navigate to
<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin and execute the
command: startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic
Admin Console. Stop and start the application <context
name>.ear

Starting Tomcat
Application

On the machine in which Tomcat is installed, navigate to
<Tomcat_Install_ Directory>/bin and execute the command:
./catalina.sh run

Stopping Infrastructure Services

To stop Infrastructure services, follow these steps:

1. On the machine in which Infrastructure Application components have been
installed, navigate to $FIC_APP_HOME/common/FICServer/bin and execute the

command:.

./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application
components have been installed, navigate to $FIC_HOME/ficapp/icc/bin and

execute the command:

./iccservershutdown.sh

Note: Only Infrastructure Default Application Server would hold

ICC component.
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3. To stop Back-end server, on the machine in which Infrastructure database
components have been installed, navigate to $FIC_DB_HOME/bin and execute the
command:

. /agentshutdown.sh

Cleaning up the environment
To clean up the enviornment, follow these steps:
Navigate to $FIC_HOME
Execute . /Uninstall.sh.

When prompted, enter OFSAAI configuration schema password.

Navigate to ftpshare folder.

1.
2.
3
4. This will delete SFIC_HOME and drop all the objects from configuration schema
5
6. Delete the infodom folders $ rm -rf <INFODOM>.

7

Drop configuration and atomic schemas from the database
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Accessing OFSAA Application

This section gives details the steps to be performed to access OFSAA Application.

Access the OFSAA Application

1. From your desktop, open the browser and enter the URL in the following format:
<scheme>:/ /<IP address/ hostname>:<port>/<context-name>/login.jsp
For example, https:/ /111.222.333.444:5555/ ofsaa/login.jsp
The OFSAA login screen is displayed.

Figure E-1 OFSAA Login Window

Language US-English v
User ID |
Password

&
[:“’g‘" ORACLE

2. With installation of every OFSAA Applications Pack, there are two seeded user
profiles configured in the system:

"SYSADMN - System Administrator
"SYSAUTH - System Authorizer
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Note: For SYSADMN and SYSAUTH, the default password is
password0.

1. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I"
in the SYSADMN login USER ID). Enter the password that was provided during
installation. On the first login, you will be prompted to change the password.
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Cloning OFSAA Instance

There is a consistent need for a faster and effective approach of replicating an existing
OFSAA instance for further project developments, that is, setting up OFSAA instances
that are exact copies of the current OFSAA instance. For more information on cloning,
see OFSAA Cloning Reference Guide.
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OFSAA Landing Page

This section includes the following topics:
e OFSAA Landing Page
* Enabling a Product within an Applications Pack

OFSAA Landing Page

On successful authentication, the OFSAA Landing Page is displayed. This is a
common landing page for all users until a preferred application landing page is set by
the user in his preferences.

The landing page includes multiple tabs and each tab has specific links to OFSAA
Infrastructure and/or Application modules. The tabs and links are displayed based on
the OFSAA Application accessed and the access roles mapped to the logged in user.

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules
in a tree structure. The RHS Menu holds link(s) to modules in a navigational panel
format.

The following tabs are available in the Landing Page:
e Applications Tab

* Sandbox Tab

* Object Administration Tab

¢ System Configuration and Identity Management Tab

Applications Tab
This tab lists the various OFSAA Applications that are installed in the setup.

The "<Select Application>" dropdown lists the OFSAA Applications based on the user
logged in and User Group(s) mapped to OFSAA Application. Selecting an Application
from the drop down refreshes the menus/ links.

Sandbox Tab
This tab lists the various OFSAA Sandboxes created in the setup.

The "<Select Sandbox>" dropdown lists the OFSAA Sandboxes based on the user
logged in and User Group(s) mapped to OFSAA Application.

Selecting a Sandbox from the drop down would refresh the menus/ links.

OFSAA Landing Page G-69



Enabling a Product within an Applications Pack

Object Administration Tab

This tab lists the various OFSAA Information Domains created in the setup.

The "<Select Information Domain>" dropdown lists the OFSAA Information Domains
based on the user logged in and User Group(s) mapped to OFSAA Application.

Selecting an Information Domain from the drop down refreshes the menus/ links.

System Configuration and Identity Management Tab

This tab lists the OFSAA Infrastructure System Configuration and Identity
Management modules. These modules work across Applications/ Information
Domains and hence there are no Application/ Information Domain dropdown list in
this tab.

Note: NOTE: See the AAI User Guide for more details on how to
operate on each tab.

Enabling a Product within an Applications Pack

You can also enable a product/ application within an Applications Pack post
installation at any point of time.

To enable a product through the application Ul, follow these steps:

1. Login to the application as SYSADMN user or any user with System
Administrator privileges.

2. Navigate to System Configurations & Identity Management tab and expand
Financial Services Analytical Applications Infrastructure >> Administration and
Configuration >> System Configuration.

3. Click Manage OFSAA Product License(s)

4. The Manage OFSAA Product License(s) page is displayed as below.
This page includes the following sections:
e INSTALLED Applications Packs
e PRODUCTS IN THE Applications Pack
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Figure G-1 Manage OFSAA Product License(s) Page

Financial Services Analytical Applications Infrastructure > n and Configuration > System Ct > Manage OFSAA Product License(s)

SAA APPLICATION PACK LICENSE

» INSTALLED APPLICATION PACKS

APPLICATION PACK ID APPLICATION PACK NAME DESCRIPTION INSTALL DATE
@ OFS_AAALPACK Financial Services Advanced Analytics Infrastructure Pack ’;fﬁ::f:ﬁﬂﬂ,’:;ig“““” Analyics using Oracle R, Modeling & Stress Testing Framewiork and Inline 0., 1 05 4400339
9
; . Apphcations for Basel Basic, IRB & Analylic, Operational Risk Economic Capital & Analytc and Retail .

OFS_CAP_ADQ_PACK Financial Services Capital Adequacy Applications Pack Portiolio Risk Models and Pooling in Banking and Financial Services Domain 2014-12.02 17:59:58.0
» PRODUCTS IN THE APPLICATION PACK
ENABLE | PRODUCT ID PRODUCT HAME DESCRIPTION ENABLE DATE

OFS_AAAI Financial Services Enterprise Modeling Base Infrastructure for Advanced Analytical Applications 2014-12-02 14:22:33.0

il OFS_IPE Financial Services Inline Processing Engine Framework for Inline Processing Engine

RESET |

5. The following fields are displayed in the INSTALLED Applications PackS section:

Table G-1 Installed Applications Pack - Field Description

Field Description
Applications Pack ID Displays a unique Applications Pack ID related to the
Applications Pack.

Select the appropriate Pack id using the radio button. The
Products in the Applications Pack will be displayed below in
the PRODUCTS IN THE Applications PackS section.

Applications Pack Name Displays the name of the Applications Pack.

Description Displays the description of the Applications Pack.

Install Date Displays the date when the Applications Pack was installed.

6. The following fields are displayed in the PRODUCTS IN THE Applications Pack
section:

Table G-2 products in the Applications Pack - Field Description

Field Description

Enable Select the checkbox to enable a product within an Applications
Pack.

Product ID

Displays a unique product id for the product.

Product Name

Displays the name of the Product.

Description

Displays the description of the product.

Enable Date

Displays the date when the product was enabled.

7. Select an Applications Pack by clicking the radio button next to the Applications
Pack ID field.
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8. Selecting an Applications Pack will display below the products within the
Applications Pack.

9. Products which were enabled at the time of installation will have the checkbox
“ENABLE” disabled. You can enable any product within the selected Applications
Pack by clicking the “ENABLE” checkbox against the respective Product ID.

10. Click on RESET button to cancel the operation and refresh the screen.
11. Click VIEW LICENSE AGREEMENT button.

The License Agreement section is displayed.
Figure G-2 License Agreement

» LICENSE AGREEMENT
Oracle Financial Services Enterpnse Modeling Option (OFS AAAI) product is a separately licensable product and would not be enabled unless it has been licensed. Oracle ~
Financial Services Enterprise Modeling Option (OFS AAAI) product is only part of the Oracle Financial Services Advanced Analytics Infrastructure Pack and specific OFSAA
Application Packs that require the advanced analytical features of this product. Oracle Financial Services Enterprise Modeling Option (OFS AAAI) product gets pre-selected
automatically on selecting any of the ofsaa products within a specific Application Pack that require this product to be enabled and configured
Multiple products being grouped together under a Application Pack, mandate installation and configuralion of these products by default. However, during the Application Pack
instaliation, based on the products that are being selected, it would get enabled and would be licensed for. It is important to note that products once selected (enabled) cannot be
disabled at a later stage. However, products can only be enabled at any later stage using the OFSAA Infrastructure "Manage Application Pack License” feature.

Enabling a product within a Application Pack automatically implies you agree with this license agreement and the respective terms and conditions.

@) | ACCEPT THE LICENSE AGREEMENT
| DO NOT ACCEPT THE LICENSE AGREEMENT.

ENABLE

12. Select the option I ACCEPT THE LICENSE AGREEMENT.
13. Click ENABLE.

14. An appropriate pop-up message confirmation is displayed showing that the
product is enabled for the pack.

Note: To use the newly enabled product, you need to map your
application users to the appropriate product specific User_Group(s)
and subsequently, authorize the actions by logging in as System
Authorizer.

Note:

¢ For more information see Mapping/Unmapping Users section in
the Oracle Financial Services Analytical Applications
Infrastructure User Guide.

* To identify the newly enabled product specific UserGroups/
Applications Pack specific User_Groups, see the respective
Applications Pack specific Installation and Configuration Guide/
User Manual.
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Additional Configuration

This section gives detailed information about the Additional Configuration regarding
OFSAA Installation.

Additional Configuration

This section covers the following topics:

Adding FTP/SFTP Configuration for File Transfer
Configuring Infrastructure Server Memory
Configuring Internet Explorer Settings

Setting OLAP Data Server Configuration

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance
Executing OFSAAI Setup Information Fetching Tool
Executing Encryption Changer

Setting Infrastructure LDAP Configuration
Configuring OFSAAI Web Services

Deploying OFSAAI Web Services

Configure Message Details in Forms Designer
Clearing Application Cache

Configuring Password Changes

Configuring Internal Service (Document Upload/ Download)

Adding FTP/SFTP Configuration for File Transfer

In OFSAA, certain modules require transfer of files from the web application server to
the OFSAA server over SSH.

Follow these steps to ensure the OFSAA server recognizes the web application server
during file transfers.

1.
2.
3.

Login to the web application server.
Type sftp <user>@<OFSAA Server>

Specify Yes when prompted for permission.

Are you sure you want to continue connecting (Yes/No)?
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This adds an entry into the "known_hosts" file.
4. A confirmation message is displayed:

Permanently added <OFSAA Server> RSA) to the list of known hosts.

Configuring Infrastructure Server Memory

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and
WebLogic can be edited for customizing memory settings and garbage collector
settings depending on the available hardware configuration as explained below. These
settings are base minimum and has to be incremented considering the deployment
metrics into account. The increments are usually handled in multiples of 128 MB for
heap and 64 MB for stack.

Configuring Infrastructure Application Server Memory Settings
You can configure the Infrastructure Application Memory settings as follows:

1. Locate .profile file.

2. Edit X_ARGS field in this file for customizing memory settings and garbage
collector settings depends on the hardware configuration.

This has a default value X_ARGS="-Xms200m"

X_ARGS=" "$X_ARGS" $DELIM -Xmx2048m"

Note: This parameter is modified in 7.3.2 IR and you need to modify
X_ARGS_APP variable in the .profile file to customize Java Memory
Settings for Model Upload based on the Data Model size.

For Run and Rule executions, the following value is recommended:

X_ARGS_RNEXE="-Xmslg -Xmxlg -XX:+UseAdaptiveSizePolicy
-XX:MaxPermSize=512M -XX:+UseParallelOldGC
-XX:+DisableExplicitGC"

X_ARGS_RLEXE="-Xmslg -Xmxlg -XX:+UseAdaptiveSizePolicy
-XX:MaxPermSize=512M -XX:+UseParallelOldGC
-XX:+DisableExplicitGC"

Configuring Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet
Explorer, that is, 100%.
Cookies should be enabled.

The following browser settings must be specified at every client machine prior to
accessing the Infrastructure application.

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options
window is displayed.

2. Click Settings. The Settings window is displayed.
3. Select Every time I Visit the webpage and click OK.
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Figure H-1 Internet Options
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4. In the Internet Options window, select the Security tab and select the Internet
option under Select a zone to view or change the security settings.
5.

Click Default Level under Security level for this zone.
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Figure H-2 Internet Options - Security Tab
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Click Apply to save.

Click Internet Explorer >> Tools >> Compatibility View Settings.

Enter the OFSAA setup URL in the Add this website field.

Click Add.

10. Ensure the URL is listed under Websites you've added to Compatibility View.

© © N o

11. In the Internet Options window, select the Privacy tab and select the Turn on
Pop-up Blocker option under Pop-up Blocker settings.
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Figure H-3 Internet Options- Popup Blocker Settings
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12. Click Settings. The Pop-up Blocker Settings window is displayed.

13. Enter the URL of the OFSAA Application in the Address of website to allow:
field.

14. Click Add. The OFSAA URL is displayed in the Allowed sites section.
15. Click Close.
16. Click OK in the Internet Options window.

Retrieving Patch Information
To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.
2. Navigate to Object Administration tab.

3. Click System Ultilities.

4. Click Patch Information.
5

The page displays the list of patches installed on the OFSAA setup across
Applications/ Platform.

Setting OLAP Data Server Configuration
This section is applicable if you are using the OLAP feature of OFSAAL

The following parameters must be set to ensure that the system limitations are not
exceeded at any stage. The values for these OS parameters should be specified based
on the expected load at each implementation site.
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For example:

Process Memory Limit

Max Thread Stack Size

Max Number of Threads per Process

* Sort Buffer settings: This must be set at the Essbase application level appropriate
to the anticipated load.

¢ Shutdown and Restart: During shutdown of OFSAAI Server that has an instance
of Data Services that is communicating with an OLAP Data Server, it is imperative
to ensure that the cleanup of the old instance is completed on the OLAP Data
Server before restarting the OFSAAI Server. Pause for a period of time based on
the load the system was subjected to, before restarting the Data Services
subsystem.

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance

For information on this section, see OFS Analytical Applications Infrastructure
Administration User Guide in OTN.

Executing OFSAAI Setup Information Fetching Tool

Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve
the related information about the OFSAAI Set up such as Operating System Name and
Version, Database Type and Version, OFSAAI architecture, Log file locations and so
on.

To execute "SetupInfo.jar" in console, follow these steps:
1. Navigate to the path $FIC_HOME.
2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Executing Encryption Changer

This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the
encrypted values of the OFSAAI setup according to the new key.

To execute EncryptC. jar in console, follow these steps:
1. Navigate to the path $FIC_HOME.
2. Enter the command:
java -jar EncryptC.jar
A confirmation message is displayed after execution.

Once executed, you need to create and deploy the EAR / WAR file depending on the
configured Web application server. For more information, see Appendix C.

Setting Infrastructure LDAP Configuration

For more information on LDAP configuration, see OFSAAI Administration Guide.
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Configuring OFSAAI Web Services

Web Services in OFSAALI is meant for exposing a web service to "asynchronously" or
"synchronously" execute requested tasks offered by OFSAAI The configuration steps
given below are to be done only if you are using the Web Services feature of OFSAAL

Configuring DynamicWSConfig.xml File

For each third party web service that needs to be accessed using the OFSAAI Web
services framework and the operations to be invoked, corresponding entries are to be
made in the DynamicWSConfig.xml template file.

The variable <WebServer> denotes any one of the application server, i.e. WebSphere,
WebLogic, or Tomcat.

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation
Directory>/EXEWebService/ <WebServer>/ROOT/conf directory. This file can be
placed in any directory that is accessible by the application and this location must be
specified in the web.xml file, as WSCONFIGFILE parameter.

The DynamicWSConfig.xml template file will be in <WebServer Deployment Path>/
EXEWebService.ear/EXEWebService.war/conf directory

This template is given below:
<XML>
<WEBSERVICES>
<WEBSERVICE CODE="$CODE"
ENDPOINT="$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE"
XMLNS_XSD="$XMLNS_XSD" ENCODINGSTYLE="$ENCODINGSTYLE"
SERVICENAME="$SERVICENAME" PORTTYPENAME="S$PORTTYPENAME"
SESSION_MAINTAIN_PROPERTY="$SESSION_MAINTAIN_PROPERTY"
USERNAME="SUSERNAME"
PASSWORD="$PASSWORD" STYLE="$WEBSERVICESTYLE"
STUBIMPLEMENTATION="$STUBIMPLEMENTATION" >
<OPERATION CODE="S$SCODE"
NAME="S$NAME"
SOAPACTION="$SOAPACTION"
STYLE="$STYLE"
PACKAGENAME="$PACKAGENAME " >
<INPUT ORDER="S$ORDER"
PARAMNAME="$PARAMNAME"
ARGTYPE="$ARGTYPE"
CLASSNAME="$CLASSNAME" />
<OUTPUT PARAMNAME="S$PARAMNAME"
RETURNTYPE="$RETURNTYPE"
CLASSNAME="$CLASSNAME" />

</OPERATION>
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</WEBSERVICE>
</WEBSERVICES>

</XML>

The DynamicWSConfig.xml has the placeholders as tabulated below. These have to be
updated depending on the web service chosen and the mode of accessing it. For each
Web service to be accessed, the entire webservice tag in the DynamicWSConfig.xml file
must be repeated. The placeholders tabulated below should be set in accordance to the
parameters published in the third party wsdl files (webservices) to be accessed. The
stub class specified must implement the "com.iflex.Oracle
Reveleus.execution.webservice.EXEWebIF" interface.

Attributes of WEBSERVICE tag
Table H-1 WEBSERVICE tag Attributes

Placeholder Description

$CODE Unique number within the xml file and cannot be 999 or 0.

$ENDPOINT soap: address location in the wsdl: service name tag of
the wsdl file.

$TARGETNAMESPACE The attribute value for the targetNamespace of the wsdl:
definitions tag.

$XMLNS_XSD The attribute value for the xmlns:s of the wsdl:definitions
tag

$ENCODINGSTYLE The attribute value for the xmlns: soapenc of the
wsdl:definitions tag.

$SERVICENAME Name of the service found under the wsdl : service name tag
of the wsdl file.

$PORTTYPENAME wsdl port type name as mentioned in the wsdl file.

$SESSION_MAINTAIN_PROPERTY |This could be given as " also.

$USERNAME User name to access the web services. Enter "" if no user
name is required.

$SPASSWORD Password to access the web services. Enter "" if no password
is required.

SWEBSERVICESTYLE This can take either "rpc” in case of DII mode of invoking
web services or "stub" in case of static mode. This is a
mandatory parameter.

$STUBIMPLEMENTATION Fully qualified class name (package name. classname).

Attributes of OPERATION tag
Ensure that the OPERATION tag attributes are repeated for each of the OPERATION

tags.

Table H-2 OPERATION tag Attributes

Placeholder Description

$CODE Should be unique within the Webservice tag.

SNAME The name of the Function that is to be called by the wsdl file.

$SOAPACTION The URL for the Operation to access. This is associated with
the Operation tag of the wsdl file.
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Table H-2 (Cont.) OPERATION tag Attributes

Placeholder Description

$STYLE This can take "rpc" if the web services invoking is in
DII mode or "stub" if it is in static mode. This is a
mandatory parameter.

$SPACKAGENAME Represents the JAXB package of input object.

Attributes of INPUT tag
Table H-3

INPUT tag Attributes

Placeholder Description

SORDER The sequential number of the INPUT tag. Should
start from 0. This is in line with the input order of
the arguments that the API accepts which is called
by this operation.

$PARAMNAME Input parameter name to be called by the wsdl file.

$ARGTYPE Input Parameter Data Type. If the input argument
type is complex object, specify $ARGTYPE as
"xmlstring".

$SCLASSNAME Represents class name of input object parameter.

Attributes of OUTPUT tag

Table H-4 OUTPUT tag Attributes

Placeholder Description

$PARAMNAME Output parameter name to be returned by the web
service.

SRETURNTYPE Output parameter Data Type. If the web service response is
a complex object, then specify SRETURNTYPE as "object".

$CLASSNAME Represents class name of output object parameter.

Adding web.xml Entries

This step is optional and required only if the web application server used is Tomcat.
In case of any other application server, skip and proceed with next step.

1. Navigate to $FIC_HOME/webroot/WEB-INF/ and edit the web.xml file. Set parameter
value DOCSERVICEAPP to EXEllebServiceAXIS.
2. Navigate to <OFSAAI Installation

Directory>/EXElWebService/<WebServer>/RO0OT/WEB-INF/ and edit the web.xml
file as explained below.
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Note: In case of Java 7 when WebLogic is used as web application
server replace following line of <OFSAAI Installation
Directory>/EXEWebService/WebLogic/ROOT/WEB-INF/web.xml file:

<?xml version='1.0"' encoding='UTF-8'?>

<web-app id="WebApp_ID" version="3.0"
xmlns="http://java.sun.com/xml/ns/javaee"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://java.sun.com/xml/ns/javaee

http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd"
metadata-complete="true">

with
<?xml version='1.0"' encoding='UTF-8'?>
<web-app xmlns="http://java.sun.com/xml/ns/j2ee"

xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

Configuring WSConfig File

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer
Deployment Path>/ EXEWebService.ear/EXEWebService.war/conf directory. This
file can be placed in any directory that is accessible by the application.

The path where the WSCONFIG file is placed must be specified in place of
$WSCONFIGFILELOCATIONS in the below block of text in web.xml.

<context-param>

<description>WebServices Configuration File</description>
<param-name>WSCONFIGFILE</param-name>
<param-value>$WSCONFIGFILELOCATIONS</param-value>
<!--Specify the Location of DynamicWSConFig.xml-->

</context-param>

Configuring Proxy Settings
The following block of text in web. xm1 file, replace the <param-value> given in bold
below with appropriate values.

If no values are required, leave the <param-value> blank.
<context-param>
<description>http Proxy Host</description>
<param-name>http.proxyHost</param-name>
<param-value>$PROXYHOSTS$</param-value>
<!-- Specify the IP address or hostname of the http proxy server-->
</context-param>

<context-param>
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<description>http Proxy Port</description>
<param-name>http.proxyPort</param-name>
<param-value>$SPROXYPORTS</param-value>
<!--Port Number for the Proxy Server-->
</context-param>
<context-param>
<description>http proxy UserName</description>
<param-name>http.proxyUserName</param-name>
<param-value>$PROXYUSERNAMES$< /param-value>
<!-- User ID To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http proxy Password</description>
<param-name>http.proxyPassword</param-name>
<param-value>$SPROXYPASSWORDS</param-value>
<!-- User Password To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http non-ProxyHosts</description>
<param-name>http.nonProxyHosts</param-name>
<param-value>$NONPROXYHOSTS$< /param-value>

<!--Hosts for which the proxy settings should get by-passed (Note:
Separate them by "|" symbol) -->

</context-param>

Configuring OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAAI
installation and should be accessible.

Replace SFIC_HOMES in the following block of text in web.xml with <WebServer
Deployment Path>/EXEWebService.ear/EXEWebService.war.

<context-param>
<description>OFSAATI Web Home</description>
<param-name>FIC_HOME</param-name>
<param-value>$FIC_HOME$</param-value>
<!--OFSAAI Installation Folder-->
</context-param>
<context-param>
<description>0OFSAAI Web Home</description>

<param-name>FIC_PHYSICAL_HOME</param-name>
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<param-value>SFIC_HOMES</param-value>
<1--OFSAAI Installation Folder-->

</context-param>

Configuring DynamicWSConfig.xml File

For each third party web service that needs to be accessed using the OFSAAI Web
services framework, and the operation to be invoked, make corresponding entries into
this file. This file is to be placed in the location that is specified in the web.xml, as
WSCONFIGFILE parameter.

Deploying OFSAAI Web Services

You can deploy OFSAAI Web Services separately if you had not configured OFSAAI
Web Services as part of the installation.

1. Complete the manual configuration of OFSAAI Web Services.

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer>
and execute the command:

./ant.sh

This will trigger the EAR/WAR file creation, which is required for the
deployment.

3. Deploy the generated EXEWebService.EAR/EXEWebService.WAR file into the
WebServer.

If you have already configured OFSAAI Web Services as part of the installation,
deploy the generated EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI
Deployment area in WebServer profile.

Enabling Parallel Execution of DML statements

A configuration file, OracleDB.conf has been introduced to accommodate any
configurable parameter related to operations on oracle database. If you do not want to
set a parameter to a specific value, then the respective parameter entry can be
removed /commented off form the OracleDB.conf file which resides in the path $FIC_
DB_HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_
PARALLELISM. This parameter indicates the degree of parallelism to be used for a DML
operation if parallel DML is explicitly enabled in the session with the ENABLE
PARALLEL DML clause of the ALTER SESSION statement. The default mode of a
session is DISABLE PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not
set, then the default degree, as decided by Oracle will be used.

Configure Message Details in Forms Designer

You can configure the Message Details in Forms Designer under Data Entry Forms
and Queries module by updating the details of mail server in the
NotificationConfig.cfy file which resides in the path SFIC_APP_
HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message
details are included in Administration > Security Management > User Administrator
> User Maintenance window.
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Update the following parameters in the "NotificationConfig.cfg" file:

Table H-5 NotificationConfig.cfg File

Parameter Description
SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server.
SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to

'true’, otherwise set value to 'false’.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be

authenticated, otherwise set to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if

authentication is not required use a dummy value.

SMTP_PASSWORD Password required for logging into SMTP server, if

authentication is not required use a dummy value.

SMTP_MAILID If the Messages has to go from a Particular ID that

ID need to be added. Exchange server forces you set
a valid ID that is there in the exchange server.
(Based on Security settings)

Ensure that the authorized User details are included in Administration > Security
Management > User Administrator > User Maintenance window.

Clearing Application Cache
This is applicable to all Web servers (that is, WebSphere, WebLogic, and Tomcat).

Prior to the deployment of Infrastructure or Application Service Packs / One-off
patches, clear the cache. Navigate to the following path depending on the WebServer
configured and delete the files:

Tomcat: <Tomcat installation
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

WebLogic: <WiebLogic installation location>/domains/<Domain
name>/servers/<Server name>/tmp/_WL_user/<Application name>/gaelce/jsp_
servlet

WebSphere: <WebSphere installation
directory>/AppServer/profiles/<Profile name>/temp/<Node
name>/serverl/<Application name>/<.war file name>

Configuring Password Changes

This section explains about how to modify the OFSAA Infrastructure Config Schema
and Atomic Schema passwords.

Modifying OFSAA Infrastructure Config Schema password

To change the Config Schema password, perform the following steps:

1.
2.
3.

Change the Config schema User Password in the database.
Delete the $FIC_HOME/conf/Reveleus.SEC file.

Shutdown the OFSAAI App service:

cd SFIC_APP_HOME/common/FICServer/bin

./stopofsaai.sh
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4.

Start the Infrastructure Server in foreground directly on the server or through
X-Windows software using the command:

./startofsaai.sh

At the prompt, enter System Password. Enter the "new Config schema" password.
The service will start and initialize itself if it is able to successfully connect to the
DB.

Post successful startup of the service, if required, the Infrastructure server may be
shut down and restarted in the background using nohup mode.

Modifying OFSAA Infrastructure Atomic Schema password
To change the Atomic Schema password, perform the following steps:

1.
2.

6.

Change the Atomic schema User Password in the database.

Login to the application from the browser using SYSADMN account or any user
id, which has System Administrator role mapped.

Navigate to System Configuration > Database Details window. Select the
appropriate connection and edit the password.

Navigate to Data Management Tools >Data Sources> Source Designer window.
Update the password of the appropriate Source

If you are using Apache Tomcat as Web server, update the <Context> ->
Resource tag details in Server.xml file from the SCATALINA HOME/conf folder.
(In case of Tomcat only Atomic <Resource> will exist).

If you are using WebSphere as Web server:
a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be
populated on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this
case, both Config and Atomic data sources will need to be modified).

If you are using WebLogic as Web server:
a. Login to the WebLogic Administration Console, from the left side menu

b. Under Domain Structure list box, expand the appropriate Domain and
navigate to Services > JDBC >Data Sources. A list of data sources will be
populated on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this
case, both Config and Atomic data sources need to be modified).

Restart the OFSAALI services.

Configuring Internal Service (Document Upload/ Download)

This step can be ignored if it has already been configured as part of any previous IR
/ML installation.

The Document Upload /Download feature has undergone a change and can now be
configured to use Internal service for document upload / download instead of the
earlier ExeWebService.

To facilitate Internal service for document upload/ download, perform the following
configurations:
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1. Create the folders download, upload, TempDocument and Temp in the local path
of Web application server and provide Read/Write permission.

¢ To find the exact location, execute the following query in CONFIG schema:
select localpath from web_server_info

* To create folders with Read /Write permission, execute the command:
mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide
Read/Write permission.

¢ To find the exact location, execute the query in CONFIG schema:
select ftpdrive from app_server_info

* To create folder with Read /Write permission, execute the command:
mkdir -m 777 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to
FALSE in the Configuration table in CONFIG schema and hence the application
“ExeWebService” will not be used. It is recommended that the value to be set to
FALSE and use the Internal service for document upload/ downloads. If you intend to
continue using the External ExeWebService, set the value to TRUE.

Navigate to $F1C_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB
tier and type ./ant.sh. This triggers the creation of EAR/WAR file
EXEWebService.ear/.war. The EAR/WAR file EXEWebService.ear/.war will be
created in $FIC_HOME /EXEWebService/ <WEBSERVER_TYPE> directory of WEB
tier. Redeploy the generated EAR/WAR file onto your configured web application
server.
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Patching OFSAA Infrastructure Installation

Oracle strongly recommends installing the latest available patchset so as to be up to
date with the various releases of the OFSAA product.

See http://support.oracle.com for more information on latest release.

Patching OFSAA Infrastructure Installation 1-89
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Grants for Atomic/ Config Schema

This section mentions about the various grants required for the CONFIG, ATOMIC

schemas.

This section discusses the following sections:

* Configuring Grants for Atomic Schema

* Configuring Grants for Config Schema

* Configuring Grants for Config Schema Entities for Atomic Users

Configuring Grants for Atomic Schema

Atomic Schema creation requires certain grants for object creation. This can be located
in SFIC_HOME/privileges_atomic_user.sgl file.

The following are the Grants for Atomic Schema:

grant create

/

grant create

/

grant create

/

grant create

/

grant create

/

grant create

/

grant create

/

SESSION to &database_username

PROCEDURE to &database_username

SEQUENCE to &database_username

TABLE to &database_username

TRIGGER to &database_username

VIEW to &database_username

MATERIALIZED VIEW to &database_username

grant olap_user to &database_username

/

grant select

/

on SYS.V_S$PARAMETER to &database_username
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grant create SYNONYM to &database_username

/

Note:

If you intend to use Oracle OLAP feature, execute the below

grant on all ATOMIC schema(s) grant olap_user to &database_
username

Configuring Grants for Config Schema

Config Schema creation requires certain grants for object creation. This can be located
in $FIC_HOME/privileges_config_user.sql file.

The following are the Grants for Config Schema:

grant create SESSION to &database_username

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

create

create

create

create

create

create

PROCEDURE to &database_username

SEQUENCE to &database_username

TABLE to &database_username

TRIGGER to &database_username

VIEW to &database_username

MATERIALIZED VIEW to &database_username

olap_user to &database_username

select

create

on SYS.V_$PARAMETER to &database_username

SYNONYM to &database_username

Configuring Grants for Config Schema Entities for Atomic

Users

Atomic Schema creation requires certain grants for config schema object access. This
can be located in $FIC_HOME/config_table_privileges_for_atomic_user.sql file.

The following are the Grants for Config Schema entities for Atomic Users:

grant select on CSSMS_USR_PROFILE to &database_username

/
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grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

select

select

select

select

select

select

select

select

select

select

select

select

select

select

select

select

select

select

select

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

CSSMS_ROLE_MAST to &database_username

CSSMS_GROUP_MAST to &database_username

CSSMS_FUNCTION_MAST to &database_username

CSSMS_USR_GROUP_MAP to &database_username

CSSMS_USR_GROUP_DSN_SEG_MAP to &database_username

CSSMS_ROLE_FUNCTION_MAP to &database_username

CSSMS_GROUP_ROLE_MAP to &database_username

CSSMS_SEGMENT _MAST to &database_username

CSSMS_USR_DSN_SEG_MAP to &database_username

CSSMS_USR_ROLE_MAP to &database_username

CSSMS_METADATA_SEGMENT MAP to &database_username

BATCH_RUN to &database_username

PR2_FILTERS to &database_username

PR2_TASK_FILTER to &database_username

PR2_TASK_FILTER_DETAIL to &database_username

ST_STRESS_MASTER to &database_username

ST _SCENARIO_MASTER to &database_username

ST_SHOCK_MASTER to &database_username

BATCH_MASTER to &database_username
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grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

select

select

select

select

select

select

select

select

select

delete

insert

update

select

delete

insert

update

select

select

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

ICC_MESSAGELOG to &database_username

PR2_MASTER to &database_username

PR2_RUN_REQUEST to &database_username

MF_MODEL_SCRIPT MASTER to &database_username

MF_INPUT VALUES to &database_username

MF_MODEL_OUTPUT_VALUES to &database_username

DB_MASTER to &database_username

DSNMASTER to &database_username

pr2_rule_map to &database_username

pr2_rule_map_pr

pr2_rule_map_pr

pr2_rule_map_pr

pr2_rule_map_pr

to

to

to

to

&database_username

&database_username

&database_username

&database_username

pr2_rule_map_pr_tmp to &database_username

pr2_rule_map_pr_tmp to &database_username

pr2_rule_map_pr_tmp to &database_username

pr2_rule_map_pr_tmp to &database_username

pr2_rule_map_exclude to &database_username
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grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

delete

insert

update

select

delete

insert

update

select

select

select

select

select

select

select

select

select

select

select

select

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

pr2_rule_map_exclude_pr to &database_username

pr2_rule_map_exclude_pr to &database_username

pr2_rule_map_exclude_pr to &database_username

pr2_rule_map_exclude_pr to &database_username

pr2_rule_map_exclude_pr_tmp to &database_username

pr2_rule_map_exclude_pr_tmp to &database_username

pr2_rule_map_exclude_pr_tmp to &database_username

pr2_rule_map_exclude_pr_tmp to &database_username

pr2_run_object to &database_username

pr2_run_object_member to &database_username

pr2_run_map to &database_username

pr2_run_execution_b to &database_username

pr2_run_execution_filter to &database_username

pr2_firerun_filter to &database_username

pr2_filters to &database_username

configuration to &database_username

batch_parameter to &database_username

component_master to &database_username

MDB_OBJECT_TYPE_ATT LAYOUT to &database_username
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/

grant select on REV_OBJECT_ATTRIBUTE_DTL to &database_username
/

grant select on FORMS_LOCALE_MASTER to &database_username

/

grant select on mdb_object_dependencies to &database_username

grant select on mdb_execution_details to &database_username

/

grant select on REV_STAT DATA to &database_username

/

grant select on REV_OBJECT_REPOSITORY_B to &database_username
/

grant select on REV_OBJECT_REPOSITORY_TL to &database_username
/

grant select on REV_OBJECT_ATTRIBUTE_DTL_MLS to &database_username
/

grant select on REV_OBJECT_APPLICATION_MAP to &database_username
/

grant select on MDB_OBJ_EXPR_DETAILS to &database_username

/

grant select on MDB_EXECUTION_DETAILS to &database_username

/

grant select on REV_OBJECT_TYPES_CD to &database_username

/

grant select on REV_OBJECT_TYPES_MLS to &database_username

/

grant select on REV_APPLICATIONS_CD to &database_username

/

grant select on REV_APPLICATIONS_MLS to &database_username

/

grant select on METADATA_BROWSER_LOCALE to &database_username
/

grant select on MDB_STAT DATA to &database_username

/

grant select on MDB_OBJECT_TYPE_LAYOUT to &database_username

/
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grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

select

select

select

select

select

select

select

select

select

select

select

select

select

delete

insert

update

select

select

select

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

ofsa md _id ref to &database_username

MDB_ETL_MAPPING to &database_username

setupinfo to &database_username

LOCALEREPOSITORY to &database_username

MF_MODEL_MASTER to &database_username

MF_SANDBOX_MASTER to &database_username

MF_VARIABLE_MASTER to &database_username

MF_TECHNIQUE_MASTER to &database_username

MDB_RULE_SOURCE_HEADER to &database_username

MDB_RULE_TARGET_HEADER to &database_username

MDB_RULE_TARGET MEMBER_HEADER to &database_username

MDB_RULE_GRID_DATA to &database_username

MDB_MODEL_MAPPING to &database_username

AAT _MAP_ MAPPER to &database_username

AAT _MAP_ MAPPER to &database_username

AAT _MAP_ MAPPER to &database_username

AAT _MAP_ MAPPER to &database_username

RTI_UI_EXCLUDE_PDM_LIST to &database_username

RTI_VIR_PHY TBL_NAME to &database_username
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/
grant select on infodom patches to &database_username

/

J-98 Oracle Financial Services Enterprise Case Management Application Pack



K

Configuring Applications Pack XML Files

This section explains configuration of OFS_ECM_PACK.xml and OFS_ECM_SCHEMA_
IN_xml files.

This section includes the following topics:
¢ Configuring OFS_ECM_PACK xml File
¢ Configuring OFS_ECM_SCHEMA_IN.xml File

Configuring OFS_ECM_PACK.xml File

The OFS_ECM_PACK . xml file holds details on the various OFSAA products that are
packaged in a particular Applications Pack.

The following table gives details about the various tags/ parameters available in the
file and the values that need to be updated. Prior to installing the OFSAA Applications
Pack in Silent mode, it is mandatory to update this file.

Note: If you are installing in the GUI mode, then this file need not be
updated.

Table K-1 OFS_ECM_PACK.XML Parameters

Tag Name/ Attribute Default Value/
Name Description Mandatory (Y/N) Permissible Value | Comments
APP_PACK_ID Unique Y Unique Seeded DO NOT modify
Applications Value this value.
Pack Identifier
APP_PACK_NAME Unique Y Unique Seeded DO NOT modify
Applications Value this value.
Pack Name
APP_PACK_ Unique Y Unique Seeded DO NOT modify
DESCRIPTION Applications Value this value.
Pack Description
VERSION Unique Y Unique Seeded DO NOT modify
Application Value this value.
Pack release
version
APP Unique Y Unique Seeded DO NOT remove
Application Value these tags.
Entries
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Table K-1 OFS_ECM_PACK.XML Parameters

Tag Name/ Attribute

Default Value/

Name Description Mandatory (Y/N) Permissible Value | Comments
APP_ID Unique Y Unique Seeded DO NOT modify
Application Value this value.
Identifier
APP_ID/ PREREQ Prerequisite Y Unique Seeded For most
Application/ Value applications
Product Infrastructure
would be the
prerequisite set. For
certain other
applications, an
appropriate
Application ID
would be set.
DO NOT modify
this value.
APP_ID/ DEF_SEL_ Default Selected | Y Default - YES In all Applications
FLAG Flag Packs,
Infrastructure
would have this
value set to "YES".
DO NOT modify
this value.
APP_ID/ ENABLE Enable YES if installing in | Default - Set this
Application/ Silent mode. YES for attribute-value to
Product Infrastructure YES against every
APP_ID which is
NO for Others licensed and should
Permissible - YES be enabled for use.
or NO Note: Application/
Product once
enabled cannot be
disabled. However,
Application/
Product not enabled
during installation
can be enabled later
through the
Administration Ul
APP_NAME Unique Y Unique Seeded DO NOT modify
Application/ Value this value.
Product Name
APP_DESCRIPTION Unique Y Unique Seeded DO NOT modify
Application/ Value this value.
Product Name
VERSION Unique release | Y Unique Seeded DO NOT modify
version Value this value.

Configuring OFS_ECM_SCHEMA_IN.xml File

Creating database schemas, objects within schemas and assigning appropriate grants
are the primary steps in the installation process of OFSAA Applications. The OFS_
ECM_SCHEMA_IN.xml file contains details on the various application schemas that
should be created prior to the Applications Pack installation.
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The following table gives details about the various tags/ parameters available in the
file and the values that need to be updated. Prior to executing the schema creator
utility, it is mandatory to update this file.

Table K-2 OFS_ECM_SCHEMA_IN.XML Parameters

Tag Name/
Attribute Name

Description

Mandat
ory
(YIN)

Default Value/
Permissible Value

Comments

APP_PACK_ID

Unique Applications Pack
Identifier

Y

Unique Seeded Value

DO NOT modify this
value.

<JDBC_URL>

Enter the JDBC URL

Note: You can enter RAC
and NON-RAC enabled
database connectivity
URL.

Y

Example,

jdbc:oracle:thin:@<HOST /
IP>:<PORT>:<SID>

or

jdbc:oracle:thin:@/ /[HOS
T][:PORT]/SERVICE

or

jdbc:oracle:thin:@DESCRI
PTION=(ADDRESS_
LIST=(ADDRESS=(PROT
OCOL=TCP)(HOST=[HO
ST])(port=[PORT]))(ADD
RESS=(PROTOCOL=TCP)
(HOST=[HOSTT)(PORT=[
PORT]))(LOAD_
BALANCE=yes)(FAILOV
ER=yes))(CONNECT_
DATA=(SERVICE_
NAME=[SERVICE])))

For example,
jdbc:oracle:thin:@/ /dbhos
t.server.com:1521/service
1

or

jdbc:oracle:thin:@/ /dbsho
st.server.com:1521/scan-1

or

jdbc:oracle:thin:@(DESCRI
PTION=(ADDRESS_
LIST=(ADDRESS=(PROT
OCOL=TCP)(HOST=dbho
stl.server.com)(port=1521
))(ADDRESS=(PROTOCO
L=TCP)(HOST=dbhost2.s
erver.com)(PORT=1521))(
LOAD_
BALANCE-=yes)(FAILOV
ER=yes))(CONNECT_
DATA=(SERVICE_
NAME=servicel)))

Ensure to add an entry
(with SID/ SERVICE
NAME) in the
tnsnames.ora file on the
OFSAA server. The entry
should match with the
SID/SERVICE NAME
used in the JDBC URL.

<JDBC_
DRIVER>

By default this driver
name is seeded.

Note: Do not edit this
attribute value.

Example,

oracle.jdbc.driver.OracleD
river

Only JDBC Thin Driver is
supported.

DO NOT modify this
value.
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Table K-2 OFS_ECM_SCHEMA_IN.XML Parameters

Tag Name/
Attribute Name

Description

Mandat
ory
(YIN)

Default Value/
Permissible Value

Comments

<HOST>

Enter the Hosthame/ IP
Address of the system on
which you are installing
the OFSAA components.

Y

Host Name/ IP Address

<SETUPINFO>/
NAME

Enter the acronym for the
type of implementation.
This information will be
displayed in the OFSAA
Home Page.

Note: On executing the
schema creator utility, this
value will be prefixed
with each schema name.
For example: dev_
ofsaaconf, uat_ofsaaatm.

Accepts strings with a
minimum length of two
and maximum of four.

Example,
DEV, SIT, PROD

This name would appear
in the OFSAA Landing
Page as "Connected To:
XxXxx"

The schemas being
created would get this
prefix. For E.g. dev_
ofsaaconf, uat_ofsaaconf
etc.

<SETUPINFO>/
PREFIX_
SCHEMA _
NAME

Identifies if the value
specified in
<SETUPINFO>/ NAME
attribute should be
prefixed to the schema
name.

YES or NO

Default value is YES.

<PASSWORD>/
DEFAULT*

Enter the password if you
want to set a default
password for all schemas.

Note: You also need to set
APPLYSAMEFORALL
attribute as Y to apply the
default password for all
the schemas.

The maximum length
allowed is 30 characters.
Special characters are not
allowed.

<PASSWORD>/
APPLYSAMEFO
RALL

Enter as Y if you want to
apply the password
specified in DEFAULT
attribute for all the
schemas.

If you enter as N, you
need to provide
individual passwords for
all schemas.

Note: In case you have
entered Y in
APPLYSAMEFORALL
attribute and also have
specified individual
passwords for all the
schemas, then the
specified individual
passwords will take
precedence.

Default - N
Permissible - Y or N

If set to N, need to specify
PASSWORD value for
every SCHEMA.

Note: Setting this attribute
value is mandatory, If
DEFAULT attribute is set.
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Table K-2 OFS_ECM_SCHEMA_IN.XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<SCHEMA>/ The different types of Y ATOMIC/CONFIG/SAN | Only One CONFIG
TYPE schemas that are DBOX/ADDON schema can exist in the
supported in this release Note: file.
are ATOMIC, CONEFIG, ' This schema identifies as
SANDBOX, and ADDON. SANDBOX AND the CONFIGURATION
B ADDON schemas are not
y default, the schemas . schema that holds the
t ded based on apph'cabI.e for OFS AAAL OFSAA setup details and
ypes are see Applications Pack. p
the Applications Pack. pp other metadata
Note: Do not edit this information.
attribute value. Multiple ATOMIC/

SANDBOX/ ADDON
schemas can exist in the
file.

ATOMIC schema refers to
the Information Domain
schema. SANDBOX
schema refers to the
SANDBOX schema.
ADDON schema refers to
other miscellaneous
schema (not applicable for
this Applications Pack).
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Table K-2 OFS_ECM_SCHEMA_IN.XML Parameters

Tag Name/
Attribute Name

Description

Mandat
ory
(YIN)

Default Value/
Permissible Value

Comments

<SCHEMA.>/
NAME

By default, the schemas
names are seeded based
on the Applications Pack.

You can edit the schema
names if required.

Note:

The Schema Name will
have a prefix of the
SETUPINFO/ NAME
attribute.

SCHEMA NAME must be
same for all the ATOMIC
Schemas of applications
within an Applications
Pack.

Y

The permissible length is
15 characters and only
alphanumeric characters
allowed. No special
characters allowed except
underscore '_'

SETUPINFO/ NAME
attribute value would be
prefixed to the schema
name being created.

For E.g. if name is set as
'ofsaaatm’ and setupinfo
as 'uat' then schema being
created would be 'uat_
ofsaaatm’'.

NAME should be same
where APP_GRP=1 for all
SCHEMA tags (Not
applicable for this
Applications Pack).

Note:
For example:

<Variable
name="DATABASE
NAME">KYCDB.oracle.com
</Variable>

A TNS entry must be
made in tnsnames.ora
with tnsname same as the
value provided for KYC
Database Name. If
sqlnet.ora is configured
with a value in
NAMES.DEFAULT_
DOMAIN then ensure to
use the same domain
while defining Database
Name. It is required for
KYC Batch processing.

This name should be
unique

The same above steps to
be done for FATCA and
CTR.

A restart of web and app
servers are necessary
whenever any changes are
done to config schema

<SCHEMA>/
PASSWORD*

Enter the password of the
schema to be created.

Note:

If this attribute is left
blank, then the password
specified in the
<PASSWORD>/DEFAUL
T attribute is applied as
the Schema Password.

The maximum length
allowed is 30 characters.
Special characters are not
allowed.

Note: You need to
mandatorily enter the
password if you have set
the <PASSWORD>/
APPLYSAMEFORALL
attribute as N.

Takes precedence over
DEFAULT attribute value
of <PASSWORD> tag.
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Table K-2 OFS_ECM_SCHEMA_IN.XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<SCHEMA>/ By default, the Y Unique Seeded Value Identifies the
APP_ID Application ID is seeded Application/ Product for
based on the Applications which the schema is being
Pack. created.
Note: Do not edit this DO NOT modify this
attribute value. value.
<SCHEMA>/ Enter the available default | N Default - USERS Modify this value to
DEFAULTTABL | tablespace for DB User. Permissible - Anv existing | 2sS0ciate any valid
ESPACE Note: ermissive y exasting tablespace with the
ote: valid tablespace name.
schema.
If this attribute is left
blank, then USERS is set
as the default tablespace.
<SCHEMA>/ Enter the available N Default - TEMP Modify this value to
TEMPTABLESP | temporary tablespace for Permissible - A st associate any valid
ACE the DB User. CrmssIbie = Any exasting tablespace with the
valid temporary h
schema.
Note: tablespace name.
If this attribute is left
blank, then TEMP is set as
the default tablespace.
<SCHEMA>/ Enter the quota tobeset | N Example, Modify this value to grant
QUOTA on 600M/m the specified quota on the
DEFAULTTABLESPACE mentioned tablespace to
attribute for the schema/ 20G/g the user.
user. By default, the quota -
cive i5 st to SOOM. UNLIMITED/ unlimited
Minimum: 500M or
Unlimited on default
Tablespace
SCHEMA/ Infodom Name Y Enter the name of the Valid string with up to 11
INFODOM Associated with each Information Domain to characters.
Atomic Schema and associate this schema. .
ADDON. B Mandat(?ry for Silent
The schema creator utility | Installation Mode
automatically derives an
Information Domain
Name based on the
Applications Pack if no
value is specified for this
attribute.
Permissible length is 16
characters and only
alphanumeric characters
allowed. No special
characters allowed.
<TABLESPACE | Parent tag to hold N NA Uncomment the tag and
S> <TABLESPACE> edit. ONLY if tablespaces
elements are to be created as part of
the installation.
<TABLESPACE | Logical Name of Y Name if specified should
>/ NAME tablespace to be created. be referred in the

<SCHEMA
DEFAULTTABLESPACE=
"HINAME##"> attribute.

Note the ## syntax.
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Table K-2 OFS_ECM_SCHEMA_IN.XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<TABLESPACE | Physical Name of the Y NA Value if specified will be
>/ VALUE tablespace to be created the actual name of the
TABLESPACE.
<TABLESPACE | Specifies the location of Y NA Enter the absolute path of
>/ DATAFILE the data file on the server the file to be created.
<TABLESPACE | Specifies if the tablespace | Y ON or OFF Set to ON to ensure that
>/ should be extensible or the tablespace does not
AUTOEXTEND | have a hard limit run out of space when
full.

Note:

<TABLESPACES>

<TABLESPACE NAME="OFS_ECM_DATA_CM_TBSP"

CM_TBSP"

Below is the example of xml file:

VALUE="DATA__

DATAFILE="/scratch/oraofss/app/oradata/Ti26012L64/ca

se_data_01.dbf"

<TABLESPACE NAME="OFS_ECM_IDX_ CM_TBSP"

CM_TBSP"

SIZE="512M"

AUTOEXTEND="OFF" />

VALUE="IDX_

DATAFILE="/scratch/oraofss/app/oradata/Ti26012L64/ca

se_idx_01.dbf"

SIZE="512M"

AUTOEXTEND="OFF" />

<TABLESPACE NAME="OFS_ECM_DATA_CONF_TBSP"
VALUE="DATA_CONF_TBSP"
DATAFILE="/scratch/oraofss/app/oradata/Ti26012L64/co

nf_data_01.dbf"

</TABLESPACES>

<SCHEMAS>

<SCHEMA TYPE="CONFIG"
APP_TID="OFS_AAT"
CONF_TBSP##"

<SCHEMA TYPE="ATOMIC"
APP_ID="OFS_IPE"
TEMPTABLESPACE="TEMP"

CM_TBSP##"

SIZE="1024M"

TEMPTABLESPACE="TEMP"

NAME="ofsaaconf"
DEFAULTTABLESPACE="##0FS_ECM_DATA_
QUOTA="10G" />

NAME="ofsaaecm"
DEFAULTTABLESPACE="##0FS_ECM_DATA_
QUOTA="10G"

INFODOM="ECMINFO" />

<SCHEMA TYPE="ATOMIC" NAME="ofsaaecm"

AUTOEXTEND="OFF" />

PASSWORD=""

PASSWORD=""

PASSWORD=""

APP_ID="OFS_NGECM" DEFAULTTABLESPACE="##O0OFS_ECM_

DATA_CM_TBSP##" TEMPTABLESPACE="TEMP"

INFODOM="ECMINFO" />

</SCHEMAS>

QUOTA="10G"
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Configuring OFSAAI_InstallConfig.xml File

This section gives details about the OFSAAI_Instal IConfig.xml file.

Configuring OFSAAI_InstallConfig.xml file
To configure the OFSAAI_Instal IConfig.xml file, follow these steps.
1. Navigate to OFS_AAAI_PACK/OFS_AAl1/cont/ directory.
2. Open the file OFSAAI_Instal IConfig.xml in text editor.
3. Configure the OFSAAI_InstalIConTig.xml as mentioned in Table L-1:
4

You must manually set the InteractionVariable parameter values as mentioned in
the table. If a value is not applicable, enter NA and ensure that the value is not
entered as NULL.

Table L-1 OFSAA Infrastructure Installation Tasks and Descriptions

Interaction Variable
Name Significance and Expected Value Mandatory

<Layer name="GENERAL">

WEBAPPSERVERTYP (Identifies the web application server on which the OFSAA Infrastructure |Yes
E web components would be deployed.

The below numeric value should be set depending on the type:
¢ Apache Tomcat =1

e IBM WebSphere Application Server =2

*  Oracle WebLogic Server = 3

For example, <InteractionVariable
name="WEBAPPSERVERTYPE">3</InteractionVariable>

DBSERVER_IP Identifies the hostname or IP address of the system on which the Yes
Database Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable name="DBSERVER_
IP">14.15.16.17</InteractionVariable> or <InteractionVariable
name="DBSERVER_IP">dbhost.server.com</InteractionVariable>

ORACLE_ Identifies the Oracle DB Instance SID or SERVICE_NAME Yes
SID/SERVICE_
NAME

Note: The Oracle_SID value should be exactly the same as it is mentioned
in JDBC_URL.

For example, <InteractionVariable name="ORACLE_SID/SERVICE_
NAME">ofsaser</InteractionVariable>
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Table L-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

Interaction Variable
Name

Significance and Expected Value

Mandatory

ABS_DRIVER_PATH

Identifies the directory where the JDBC driver (ojdbc<version>. jar)
exists. This would typically be the SORACLE_HOME/jdbc/1ib

For example, <InteractionVariable name="ABS_DRIVER_
PATH">">/oradata6/revwb7/oracle </InteractionVariable>

Note: See Appendix N for identifying the correct "ojdbc<version>.jar"
version to be copied.

Yes

OLAP_SERVER_
IMPLEMENTATION

Identifies if the OFSAA Infrastructure OLAP component needs to be
configured depending on whether you intend to use the OLAP feature.
The below numeric value should be set depending on the choice:

e YES-1
¢ NO-0

No

in.profile:

ARBORPATH, HYPERION_HOME and ESSBASEPATH.

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set

SFTP_ENABLE

Identifies if the SFTP (Secure File Transfer Protocol) feature is to be
enabled. The below numeric value should be set depending on the
choice:

e SFIP-1
e FIP-0

Yes

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using
SFTP instead of FTP because SFTP is considered more secure. However, a client may choose to ignore this
recommendation and to use FTP by setting SFTP_ENABLE to 0. This selection may be changed later by using the
OFSAAI administration interface.

release of the OFSAA Infrastructure supports only US English.

For example, <InteractionVariable name="LOCALE">en_
US</InteractionVariable>

FILE_TRANSFER_ Identifies the port used for the file transfer service. The default value Yes
PORT specified is 22 (SFTP). Specify value as 21 or any other PORT value if
value for SFTP_ENABLE is 0.
For example, <InteractionVariable name="FILE_TRANSFER_
PORT">21</InteractionVariable>
LOCALE Identifies the locale information to be used during the installation. This Yes

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default values
mentioned below are set in the installation. If you intend to specify a different value, update the parameter
value accordingly and ensure this port value is in the range of 1025 to 65535 and the respective port is enabled.

JAVAPORT 9999 Yes
NATIVEPORT 6666 Yes
AGENTPORT 6510 Yes
ICCPORT 6507 Yes
ICCNATIVEPORT 6509 Yes
OLAPPORT 10101 Yes
MSGPORT 6501 Yes
ROUTERPORT 6500 Yes
AMPORT 6505 Yes
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Table L-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

Interaction Variable
Name

Significance and Expected Value

Mandatory

Note: If value for HTTPS_

the same is configured on your web application server.

ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA and

HTTPS_ENABLE

Identifies if the Ul should be accessed using HTTP or HTTPS scheme.
The default value set is 0. The below numeric value should be set
depending on the choice:

e YES-1
¢ NO-0

For example, <InteractionVariable name="HTTPS_
ENABLE">0</InteractionVariable>

Yes

WEB_SERVER_IP

Identifies the HTTP Server IP/ Hostname or Web application server IP/
Hostname, to be used for accessing the UI. This IP would typically be the
HTTP Server IP.

If no separate HTTP Server is available, the value should be Web
application server IP/Hostname.

For example, <InteractionVariable name="WEB_SERVER_
IP">10.11.12.13</InteractionVariable>

or

<InteractionVariable name="WEB_SERVER_
IP">myweb.server.com</InteractionVariable>

WEB_SERVER_PORT

Identifies the Web server Port. This would typically be 80 for non SSL
and 443 for SSL. If no separate HTTP Server exists, the value should be
the port configured for Web server.

Note: The port value will not be accepted as 80 if HTTPS_ENABLE is 1 and
as 443, if HTTPS_ENABLE is 0.

For example, <InteractionVariable name="WEB_SERVER_
PORT">80</InteractionVariable>

CONTEXT_NAME

Identifies the web application context name which will be used to built
the URL to access the OFSAA applications. The context name can be
identified from a URL as below:

<scheme>: //<host>:<port>/<context-name>/login.jsp
Sample URL: https://myweb:443/ofsaadev/login. jsp

For example, <InteractionVariable name="CONTEXT
NAME">ofsaadev</InteractionVariable>

Yes

WEBAPP_
CONTEXT_PATH

Identifies the absolute path of the exploded .ear file on the web
application server.

For Tomcat, specify the Tomcat directory path till /webapps, such as
/oradatab/revwb7/tomcat/webapps/.

For WebSphere, enter the WebSphere path as <WebSphere profile
directory>/installed Apps/ <NodeCellName>. For example,
/data2/test//WebSphere/AppServer/profiles/<Profile_
Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host name.

For WebLogic, provide the WebLogic home directory path as /<WebLogic
home directory path>/bea/wlserver_10.3

Yes

WEB_LOCAL_PATH

Identifies the absolute path to any directory on the web application
server that can hold temporary files being uploaded as part of the
applications usage.

Note: In case of a clustered deployment, ensure this path and directory is
same on all the nodes.

Yes
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Table L-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

Interaction Variable
Name Significance and Expected Value Mandatory
WEBLOGIC_ Identifies the WebLogic Domain Home. Yes Specify
DOMAIN_HOME For example, <InteractionVariable name="WEBLOGIC_DOMAIN_ E)}Illel;?flue
HOME">/home/WebLogic/bea/user_ projects/domains/mydomain WEBSERV
< /InteractionVariable> ERTYPE is
set as 3
(WebLogic)
OFSAAI_ Identifies the absolute path to the directory identified as file system stage |Yes
FTPSHARE_PATH area.
Note:
e The directory should exist on the same system on which the OFSAA
Infrastructure is being installed (can be on a separate mount).
*  The user mentioned in APP_SFTP_USER_ID parameter below
should have RWX (read, write, and execute)permission on the
directory.
For example, <InteractionVariable name="APP_FTPSHARE_
PATH">">/oradata6/revwb?7/ftpshare</InteractionVariable>
OFSAAI_SFTP_ Identifies the user who has RWX permissions on the directory identified |Yes
USER_ID under parameter APP_FTPSHARE_PATH above.

L-110 Oracle Financial Services Enterprise Case Management Application Pack



M

Migrating for Excel Upload Functionality

This section provides detailed instructions to migrate excel upload functionality.

Prerequisites

The following are the prerequisites for migration.

"Data model in ATOMIC schemas should be same on the source and target setups

"OFS AAI (platform) patch level version should be same on the source and target
setups.

"PL/SQL Developer to connect and query the database.

"WinSCP to connect and access server file system.

Migrating Excel Upload

To migrate, follow these steps:

1.

6.

Open PL/SQL Developer and logon to the source setup's configuration (CONFIG)
schema by entering the appropriate username and password.

In a new SQL window query the data of table EXCEL_MAPPING_MASTER.

Open a new session in PL/SQL developer and logon to the target setup's
configuration (CONFIG) schema by entering the appropriate username and
password.

Insert the records from Step 1 above in to this table.

In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name
with the target infodom name.

Note: If all the mappings can work out of the single target Infodom,
update same Infodom value across all rows. If only few mappings will
work out of the target infodom, update the infodom value for
selective records. Kindly note, excel upload mappings will work only
if the target infodom has same data model entities as used in the
mappings defined on source setup.

Update V_CREATED_BY column with the name of any user present in the target
setup that has appropriate roles to perform Excel Upload tasks.
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10.

11.

12.

13.

Note: Itis mandatory to update values for V_INFODOM and V_
CREATED_BY columns.

Open WinSCP and login a new session by entering the host name, port number,
user name and password to access the source setup.

Navigate to the folder referred as FTPSHARE.

Copy the excel-entity mapping xml file(s) which are located in this folder
according to their folder structure on to your desktop. For example: /ftpshare
/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/SEXCEL_FILE NAME.xml

Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL_
NAME column of EXCEL_MAPPING_MASTER table.

Copy the excel templates (.xls/ .xIsx) file(s) which are located in this folder
according to their folder structure on to your desktop. For example:
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.x1ls or *.xlsx

Note: Ignore this step if files are not present at the location.

Login a new session in WinSCP by entering the host name, port number, user
name and password to access the target setup.

Copy the xml file(s) from Step3 to the below location in the target setup. For
example: /ftpshare/STAGE/ExcelUpload/$TARGET _INFODOM_NAME/SEXCEL_FILE_
NAME. xml

Note: S$TARGET_INFODOM_NAME should be target setup infodom in
which you have uploaded the appropriate data model and the name
should be same as the V_INFODOM column value updated in EXCEL_
MAPPING_MASTER table.

Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For
example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/*.x1ls or *.xlsx

Note: Ignore this step if files are not present at the location.
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JDBC Jar Files

The ojdbc<version>. jar file should be copied based on the Oracle Database version
and the supported Java (JRE/ JDK) versions. See Table N-1 for details.

Table N-1 JDBC Jar files version details

Oracle Database

JDK/JRE Version

JDBC Jar files specific to the

Version Supported release
12.1 or 12cR1 JDK 8,JDK 7 and JDK 8 0jdbc?7 jar for JDK 7/JDK 8
ojdbcé.jar for JDK 6
11.2 or 11gR2 JDK 6 & JDK 5 ojdbcé jar for JDK 7
JDK 7 supported in 11.2.0.3 | ojdbcé.jar for JDK 6
and 11.2.04 . .
ojdbc5.jar for JDK 5
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Upgrading an Existing OFSAA 8.0.x Java 7

Instance to Java 8

This section explains the configurations required to upgrade an existing OFSAA 8.0.x
Java 7 instance to Java 8. It consists of the following topics:

Prerequisites

Upgrading OFSAA 8.0.x Java 7 instance to Java 8

Configuring Web application server

Configuring User .profile Settings

Configuring OFSAA for New Web application server Installation

Prerequisites
The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java

8:

Java 8 should be installed on the OFSAA server and Web application server.

Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch
18729264 from http:/ /support.oracle.com/ for the same.

Upgrading OFSAA 8.0.x Java 7 instance to Java 8

To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1.

Configure Web application server to Java 8. For more information, see
Configuring Web application server.

Configure the OFSAA instance to Java 8. For more information, see Configurations
for Java 8. For a newly installed Web application server, see Configuring OFSAA
for New Web application server Installation

Restart the OFSAA services. For more information, see the Start/Stop
Infrastructure Services section in Appendix D

Generate the application EAR/WAR file and redeploy the application onto your
configured web application server. For more information on generating and
deploying EAR / WAR file, see Appendix C.
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Configuring Web application server

Configuring Web application server

This section describes the changes to be made in the Web application server.
Following are the two options to perform Web application server Configurations
which are listed as follows:

* Upgrade the existing Web application server installation to Java 8
¢ Install a new instance of the Web application server with Java 8
This section consists of the following topics:

* Upgrading Oracle WebLogic Server

* Upgrading Apache Tomcat Server

Upgrading Oracle WebLogic Server

Perform the following configurations to upgrade the existing WebLogic server
instance to Java 8:

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME,
JAVAHOME properties to the new Java path and java.vm.version to the new
Java version. For example,

JAVA_HOME=/usr/java/jrel_8.0_45
WLS_JAVA_HOME=/usr/java/jrel_8.0_45
JAVAHOME=/usr/java/jrel.8.0_45
jJava.vm.version=1.8.0_45

3. Navigate to <WLS_HOME>/Middleware/Oracle_Home/user_
projects/domains/<domain>/bin. Update SUN_JAVA_HOME, DEFAULT_
JAVA_HOME, JAVA_HOME in the setDomainEnv. sh file to point to the new Java
path. For example,

SUN_JAVA_HOME="/usr/java/jrel_8.0_45"
DEFAULT_SUN_JAVA HOME="/usr/java/jrel._8.0_45"
JAVA HOME=""/usr/java/jrel.8.0_45"
4. Clear the Application cache. Navigate to the following path and delete the files:

<WebLogic installation location>/domains/<Domain name>/servers/<Server
name>/tmp/_WL_user/<Application name>/gaelce/jsp_servlet

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps:
1. Install Oracle WebLogic Server 12.1.3.x on Java 8.

2. Perform the configurations for the newly installed WebLogic server. For more
information, see Configuring Resource Reference in WebLogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be
set same as that of the existing Domain.

Note down the new Domain path to perform OFSAA Configurations.
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Upgrading Apache Tomcat Server

Perform the following configurations to upgrade the existing Apache Tomcat Server
from Java 7 to Java 8:

1.
2.

Login to the Apache Tomcat Server as a non-root user.

Edit the user . profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8.
For Example,

JAVA_HOME=/usr/java/jrel.8.0_45
Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application
name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:

1.
2.

Install Apache Tomcat Server 8 with Java 8.

Perform the configurations for the newly installed Tomcat server. For more
information, see Configuring Resource Reference in Tomcat Application Server.

Note: Update the Connector Port in
/apache-tomcat-8.0.21/conf/server.xml file to that of the
existing Tomcat instance.

Note down the new deployment path to perform OFSAA
Configurations.

Configuring User .profile Settings

Perform the following configurations:

1.
2.

Login to the OFSAA Server as a non-root user.

Edit the user.profile. Update the value for PATH variable from JRE 1.7 to JRE
1.8. For Example,

PATH=/usr/java/jre 1.8.0_45/jre
JAVA_BIN=/usr/java/jre 1.8.0_45/jre/bin

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jre 1.8.0_
45/jre/lib/amd64/server

Configuring OFSAA for New Web application server

Installation

This configuration is required only if you have freshly installed Oracle WebLogic
12.1.3 or Apache Tomcat Server 8.0. Follow these steps:

1.

Modify the following param

eters in the Configuration table present in the Config Schema with the new
Domain Path in case of WebLogic or with the new deployment path in case of
Tomcat:

e DeFiHome
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e REV_IMG_PATH
e EMBEDDED_ JSP_JS PATH
2. Login to the OFSAA Server as a non-root user.

3. Navigate to $FI1C_HOME/Ficweb/webroot/WEB_INF and update the following
parameters in the web.xml file with the new Domain path in case of WebLogic or
with the new deployment path in case of Tomcat:

e FIC_PHYSICAL_HOME_LOC
e FIC_HOME
e ICC_SERVLET_LOG_FILE

4. Navigate to $F1C_HOME/Ficweb/webroot/conf and update the Domain path
in case of WebLogic or with the new deployment path in case of Tomcat:

e OFSAALogger .xml

e MDBLogger.xml

e RevLog4jConfig.xml

e RFDLogger.xml

e ExportLog4jConfig.xml
e RFDLogger.xml

e PR2Logger.xml
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Removing OFSAA

This chapter includes the following sections:
* Uninstalling OFSAA Infrastructure

* Uninstalling EAR Files in WebSphere

* Uninstalling EAR Files in WebLogic

* Uninstalling WAR Files in Tomcat

Uninstalling OFSAA Infrastructure

This section will guide you through the necessary steps to uninstall the OFSAA
Infrastructure product.

Before you start the uninstallation process, ensure that no open connections exist to
the OFSAA Infrastructure Config and Atomic Schemas and Infrastructure services are
brought down.

To uninstall OFSAA Infrastructure:

1. Log in to the system as non-root user.

2. Navigate to the SFIC_HOME directory and execute the command:
./Uninstall.sh

3. Enter the password for OFSAAI Configuration Schema when prompted as shown
in the following figure.

Figure 6-26 Uninstalling OFSAA Infrastructure

fzoratchd/of zaadb0FSAAL:, Alhinstall,sh

Ininztallation Started [time @ Tue Jun 10 14:20:27 I5T 2014 1
S5 e
%% Driver loaded with Driver oracle, jdbc,driver.Oraclelriver

Pleaze enter Configuration schema Password @

Connected to Config Schema

Cleaning config schema ...

config schema cleaned ...

Cleaning up Infrastructure Home Dir |

Please wait ..

hinstallation Completed | Thank You [time 3 Tue Jun 10 14:21:53 IST 2014 ]
AR R R R R R R R R R R R
/zoratchdof saadb OFSAAT ]
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Note:

¢ Uninstallation does not remove the Infrastructure application
from the Web application server. This has to be done manually.

* The entries in the .profile file will have to be removed manually.

» The files/ folders under the file system staging area (ftpshare)
have to be deleted manually.

e All the Database objects from Atomic Schemas have to be
dropped manually.

Uninstalling EAR Files in WebSphere

Following are the steps to uninstall any previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<Administrative
Console Port>/ibm/console (https if SSL is enabled). The Login window is
displayed.

2. Login with the user id that has admin rights.

3. Expand Applications > Application Types > WebSphere enterprise applications
from the LHS. The Enterprise Applications window is displayed with all the
deployed applications.

Figure 6-27 Enterprise Applications

Enterprise Applications =

Enterprise Applications

Use this page to manage installed applications. A single spplication can be deployed onto multiple servers.
[ FPreferences
Start | Stop || Install Uninstall Update j Rollout Update Remeove File Export Export DDL Export File
4
il w)iei
Salect| Nama O Application Status ().

You can administer the following resources:

[ | Rafaultaolication Y
O | it2oo E
O |eusw Y
[ |uess?s +
Total 4

4. Select the checkbox adjacent to the application to be uninstalled and click Stop.
5. Click Uninstall. The Uninstall Application window is displayed.
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Figure 6-28 Uninstall Application

Chck OK to remave the following sppbcation(s). If you do not want tO remove the sppications, chck Cancel 10 retumn
to the prévious page

Name
AIXGAST

o] concel

6. Click OK to confirm.

7. Click Save to save the master file configuration.

Uninstalling EAR Files in WebLogic

On the machine that hosts WebLogic, perform the following steps to uninstall any
previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<admin server
port>/console (https if SSL is enabled). The Login window of the WebLogic
Server Administration Console is displayed.

2. Login with the WebLogic user credentials having administrator privileges.

3. From the Domain Structure LHS menu, click Deployments. The Summary of
Deployments screen is displayed.

Figure 6-29 Summary of Deployments
Summary of Deployments

Control | Monitoring

This page displays a list of Java EE applications and stand-alone application modules that have been instaled to this domain, Instafed applications and modules can be started, stopped, updated
(redeployed), or deleted from the domain by first selecting the apolication name and using the cantrols on this page.

To install a new appication or module for deployment to targets in this domain, dick the Install button.

W Customize this table

Deployments
insial | | Update | | Delete |_s:mv Showing 1to 10f 1 Frevious | Hext
When work completes
W
Hame s State Health Type Deployment Order
= ::su':"; 7273 Stop, but continue servicing administration requests Active & oK Enterprise Application 100
install || Update | | Delete | Startv | | Stop v Showing 110 1of 1 Previous | Mext

4. Select the checkbox adjacent to the application to be uninstalled and click Stop>
Force Stop Now.

5. Click Yes in the confirmation dialog to stop the selected deployment.
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Figure 6-30 Summary of Deployments- Messages

Select the checkbox adjacent to the application and click Delete to delete the
selected deployment.

Click Yes in the confirmation dialog to remove the selected deployment from the
domain configuration.

Uninstalling WAR Files in Tomcat

On the machine that hosts Tomcat, perform the following steps to uninstall any
previously deployed application:

1.

Comment out Context path section from server.xml file in $CATALINA_HOME/conf
directory to avoid conflict during undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:
<l--

<Context path ="/pr2test"
docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" debug="0"
reloadable="true" crossContext="true">

<Resource auth="Container"

name="7jdbc/PR2ATM"

type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="pr2atm"

password="pr2atm"
url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"
maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>
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-=>

Restart the Tomcat service by doing the following:

d. Login to the "Unix server" through a terminal emulator.

e. Navigate to $catalina_home/bin directory.

f.  Stop the tomcat services using the command . /shutdown. sh
g. Start the tomcat services using the command . /startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server
port>. (https if SSL is enabled). The Tomcat home window is displayed.

3. Click the Manager App. The Connect to window is displayed.

4. Login with the user credentials having admin rights. The Tomcat Web Application
Manager window is displayed with the list of all applications deployed in Tomcat.

Figure 6-31 Tomcat Web Application Manager

S Apache

Software Foundation
http://www.apache.org/

Tomcat Web Application Manager

HTIL Manangr Help (anager Hal Servat Status

Path Display Name Ru L= d
Start Stop Heload Lndepioy

Stari Slon Beiged Lodeoioy

Véeicome to Tomcat true

5}

igocs Tomeat Documentation true 2 vt e 230 mutes
Start 5o Beloag Lndecloy

e S S i P i e 230 -
Start Stoo Raicag Undeplov

| Most-mangger Temcat Manager Appication true 2 Esxpire sassions with ile x| 30 e
Start Stop Relcad Undeploy

—— Toricet Hanager Avpicaton 2 wansn 2[30 s

| lfeanmt Reveleus web Applcation true 1 Start Siog Heioad Undeploy

5. Click the Undeploy link against the deployed Infrastructure application. A
confirmation message is displayed on the application /Infrastructure being
uninstalled.
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Tunable Database Parameters

This appendix contains the Tunable Database Parameters.

Note: Review the Oracle recommended guidelines in setting the
SGA_TARGET, SGA_MAX_SIZE and PGA_AGGREGATE_TARGET parameters.
The values for these memory parameters can vary significantly based
on database server specifications and estimated data volume. For
values of PGA_AGGREGATE_TARGET parameters Oracle recommends that
they be kept at a minimum of 1024 MB.

Table Q-1 Database Tunable Parameters

Tunable Database Parameters Parameter Values
Oracle
Oracle Recomme
Recomme | nded for
Category Parameter Name Type Default nded Exadata
Parameters CHARACTER SET string AL32UTF8 | AL32UTF8 | AL32UTF8
affecting )
database NLS_LENGTH_ string byte byte byte
SCHEMATICS
creation (not - . -
tunable NLS_SORT binary binary binary binary
through the | MAXDATAFILES integer | 254
init.ora MASXINSTANCES | integer | 1
file) MAXLOGFILES | integer |32
MAXLOGHISTORY | integer | 24794
MAXLOGMEMBER | integer 2 4 4
S
REDO LOG SIZE integer 10M 3G 16G
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Table Q-1 Database Tunable Parameters

Tunable Database Parameters Parameter Values
Oracle
Oracle Recomme
Recomme | nded for
Category Parameter Name Type Default nded Exadata
Parameters DB_BLOCK_SIZE integer | 2048 8192 8192
affecting I/O X
operation DB_FILE _ integer The 32 32
MULTIBLOCK _ default
READ_COUNT value
correspon
ds to the
maximum
1/0 size
that can be
efficiently
performed
and is
platform-d
ependent.
DB_FILES integer 200
DISK_ASYNCH_IO | boolean | TRUE
TAPE_ASYNCH_IO | boolean | TRUE
DB_WRITER _ integer 1 4 4
PROCESSES
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Table Q-1 Database Tunable Parameters

Tunable Database Parameters

Parameter Values

Oracle
Oracle Recomme
Recomme | nded for
Category Parameter Name Type Default nded Exadata
Parameters FAST_START_ string LOW HIGH HIGH
affecting PARALLEL_ROLLB
resource ACK
consumption ;
and parallel LOG_BUFFER integer ™M 10000000 10000000
operations | 1 G _ integer | 0 10000 10000
CHECKPOINT_
INTERVAL
LOG_ integer |0 0 0
CHECKPOINT_
TIMEOUT
OPEN_CURSORS integer 50 4096 4096
PARALLEL_ integer | 2148 16384 16384
EXECUTION_
MESSAG E_SIZE
PARALLEL_MAX_ | integer 10 * No of | Setif you Do not set
SERVERS CPUs are or change
configuring
DOP
manually at
site and
PARALLEL
_DEGREE_
POLICY is
set to
MANUAL.
PARALLEL_MIN_ | integer 0 Set if you Do not set
SERVERS are or change
configuring
manually at
site and
PARALLEL
_DEGREE_
POLICY is
set to
MANUAL.
PROCESSES integer 150 600 600
LARGE_POOL_ integer |0 512M
SIZE
PARALLEL_MIN_ | integer 0 Set if you Do not set
PERCENT are or change
configuring
DOP
manually at
site and
PARALLEL
_DEGREE_
POLICY is
set to
MANUAL.
PARALLEL_ integer 2
THREADS_PER_
CPU
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Table Q-1 Database Tunable Parameters

Tunable Database Parameters

Parameter Values

Oracle
Oracle Recomme
Recomme | nded for
Category Parameter Name Type Default nded Exadata
Additional OPTIMIZER_MODE | string ALL_ ALL_ ALL_
needed ROWS ROWS ROWS
parameters R .
COMPATIBLE string 11.2.0 (for 11.2.0 .3.0(f
Oracle using
11gR2) Oracle
11.2.0.3.0)
otherwise
11.2.0.2.0
GLOBAL_NAMES string FALSE TRUE TRUE
PRE_PAGE_SGA string FALSE TRUE TRUE
UNDO_ string AUTO AUTO AUTO
MANAGEMENT
UNDO_ string Set as Per Set as Per
TABLESPACE Site Values | Site Values
UNDO_ integer 900 10800 18000
RETENTION
TIMED_ boolean | TRUE TRUE TRUE
STATISTICS
OPTIMIZER _ integer 0
INDEX_CACHING
OPTIMIZER _ integer 100 30
INDEX_COST_ADJ]
QUERY_REWRITE_ | string TRUE FALSE FALSE
ENABLED
STAR_ string FALSE FALSE FALSE
TRANSFORMATIO
N_ENABLED
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FAQs and Error Dictionary

This section of the document consists of resolution to the frequently asked questions
and error codes noticed during OFSAALI installation.

¢ Frequently Asked Questions
* Error Dictionary

OFSAAl installer performs all the pre-requisite validation check during installation.
Any errors encountered in the process is displayed with an appropriate Error Code.
You can see the Error Dictionary to find the exact cause and resolution to rectify the
error.

Frequently Asked Questions

You can see the Frequently Asked Questions which has been developed with the
interest to help you resolve some of the OFSAAI Installation and configuration issues.
This intends to share the knowledge of problem resolution to a few of the known
issues. This is not an official support document and just attempts to share the
knowledge of problem resolution to a few of the known issues.

This section includes the following topics:
* OFSAAIFAQs
* Applications Pack 8.0.5.0.0 FAQs

e  Forms Framework FAQs

OFSAAI FAQs
What are the different components that get installed during OFSAAI?

The different components of OFSAAI are illustrated in Figure 1-2, "Components
of OFSAAT".

What are the different modes of OFSAAI installation?
OFSAALI can be installed in two modes, Silent Mode, and GUI mode.
Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on
multi-tier. By default, they will be installed on single-tier. However, OFSAA
Infrastructure can be deployed within the n-Tier architecture where the Database, Web
server and Web application server is installed on separate tiers.

Is DK (Java Development Kit) required during installation of OFSAA? Can it be
uninstalled after OFSAA installation?
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JDK is not required during installation of OFSAA and only a run time is needed
for details. See Hardware and Software Requirements, Java Runtime Environment
section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI
installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA
and cannot be uninstalled as the JRE is used by the OFSAA system to work.

How do I know what is the Operating system, webservers and other software
versions that OFSAA supports?

See OFSAA Technology Stack Matrices.
What are the different files required to install OFSAAI?

The following files are required:

* setup.sh.

¢ envCheck.sh

¢ preinstallcheck.sh

e Verlnfo.txt

e OFSAAlnfrastructure.bin

¢ validatedXMLinputs.jar

* MyResources_en_US.properties

¢ log4j.xml

* OFSAAI PostInstallConfig.xml

¢ OFSAAIL InstallConfig.xml

* privileges_config_user.sql

. privileges_atomic_user.sql

e XML_Utility jar

What should I do if I get the following error message during installation, "Execute
Permission denied”?

Please check whether all the files provided for OFSAAI installation has execute
permissions.

To give execute permissions,
* Navigate to the path OFSAAI_80000 and execute the command
chmod 755
"Graphical installers are not..”

If error resembles "Graphical installers are not supported by the VM. The console
mode will be used instead..." then check whether any of the X-windows software
has been installed.

Example: Hummingbird Exceed is started and configured to Graphical mode
installation.

Note: Type 'xclock' from prompt and this should display clock in
graphical mode.
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"No Java virtual machine could be...”

If the error message reads "No Java virtual machine could be found from your
PATH environment variable. You must install a VM prior to running this
program”, then

¢ Check whether "java path" is set in PATH variable. See the Table 3-1,
" Prerequisite Information"section in this document.

®  Check whether sufficient temporary space is available.

¢ Ensure that the movement of OFSAAI Installer text files to the target system is
done in the Text mode so that setup. sh file does not contain control line feed
characters ("M).

What should I do if I get the following error message during installation,
"OracleDriver Files Not Found, Please Choose the Right Path To Continue”?

Check whether the provided path for Oracle Driver files is correct and whether the
user has permissions to access the files.

What should I do if I get the following error message during installation, "User must
have CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX,
CREATE SEQUENCE, CREATE PROCEDURE" even though the oracle schema user
created has the mentioned privileges?

OFSAAl installer validates the database details provided during installation, so
ensure:

*  Whether the oracle schema user has the required set of privileges for
successful installation.

*  Whether the oracle schema user has been created with quota privileges on
tablespace to create database objects.

e See the Table 3-1, " Prerequisite Information" section in this document.
Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAAI installation, one has to perform the Post
Installation steps. See Chapter 5, "Post Installation Configuration".

What is to be done when OFSAAI Installation is unsuccessful?

OFSAAl installer generates log file OFSAAInfrastructure_Install.log in the
Infrastructure Installation Directory. There is also another log file created in the
path configured in Log43j .xml. The logs of any of these reported, Warnings/Non
Fatal Errors/Fatal Errors/Exceptions should be brought to the notice of the
OFSAAI Customer Support. It is recommended not to proceed, until the reported
problems are adequately addressed.

How do I completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in
Uninstalling OFSAA Infrastructure in the OFS AAAI Installation and
Configuration Guide Release 8.0.5.0.0.

Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same
database instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database
permissions) to the new Atomic schema.
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* Log into the database as sys and connect as sysdba user.

¢ Execute the file privileges_config_user.sqgl available under $FIC_HOME
directory

¢ Enter the database schema for which you want to grant privileges.
When should I run the MLLS utility?

See the Multiple Language Support (MLS) Utility section in OFS AAI
Administration Guide available on OTN.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAALI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0
and above.

What should I do if I get the following error message on the UNIX System terminal
while executing ./setup.sh, "Insert New Media. Please insert Disk1 or type its
location”?

1. Login as root user on the Unix machine where OFSA Al is getting installed.
2. Navigate to the path /etc/security/.

3. Edit the file 1imits.conf to add/edit a row for the unix user installing
OFSAA:

<Unix User> soft nofile 9216

4. After saving the changes, log in as unix user with which OFSA Al is getting
installed and execute the command:

ulimit -n
The command should return the value 9216.
How do 1 verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the
installation, a Pre-Install Check utility is available within the Install Kit archive
file. This utility can also be obtained separately by contacting Oracle Support
Services.

See Verifying System Environment section for additional information.
How do I know if the installation is completed successfully?

The OFSAA Infrastructure installation performs a post install health check
automatically on successful installation of the product. To rerun the post install
verification at a later time, perform the following steps:

1. Navigate to the path $FIC_HOME (Product Installation Directory).
2. Execute the command:
./piverify.sh
What should I do if the installation in GUI mode is not invoked?

There are set of configuration steps required to be performed during the
installation in GUI mode. Verify whether the steps mentioned under Configuring
for GUI Mode Installation section are done correctly.

What should I do if 1 get the following error message during OFSAAI installation on
Solaris 11 system?:

"Error: OFSAAI-1108
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ORA-00604: error occurred at recursive SQL level 1
ORA-01882: timezone region not found”

Or

"Time zone cannot be set as null or 'localtime’”

This happens if the time zone is not set, that is NULL or it is set as ‘localtime’. Set
the environment variable TZ to a valid time zone region in the .profile file. For
example,

TZ=Asia/Calcutta
export TZ

What should I do if there are any exceptions or errors in installation and how to
proceed?

1. Please backup the installation logs.
2. Share the backup logs with Oracle support.
What should I do if the installation process is abruptly terminated or aborted?

If the installation is abruptly terminated, then the installation process will be
incomplete. To recover from this, follow the below steps:

1. Drop the DB objects in the config schema created by OFSAAI installation.

2. Open the .profile and remove the entries made by the OFSAALI installation
which are made between the comment statements, #Beginning of entries by
OFSAA Infrastructure installation and #End of entries by OFSAA
Infrastructure installation.

3. Delete the OFSAA install directory created by the OFSA Al installer.
4. Perform the OFSAAI installation again.

Does OFSAA support any other web server types, other than the ones stated in tech
matrix and installation guide?

No, all the supported softwares and versions are stated in the OFSAA Technology
Stack Matrices.

What should I do if the database connection from connection pool displays the
following error message, "java.sql.SQLRecoverableException: 10 Error: Connection
reset”?

This happens while running several database intensive tasks in parallel. To correct this
error, add the line securerandom. source=file:/dev/./urandom in the java.security
configuration file available in $JAVA_HOME/jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where
the OFSAAI components are installed.

If the issue is not resolved even with the above settings, check the MTU(Maximum
Transmission Unit) settings on the linux box. For details on MTU settings and
updating them, contact your system Administrator.

What should I do when I get syntax errors/file not found error messages while
invoking setup.sh file from my install archive?

This could mostly happen:
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¢  When installer was not unzipped rightly or corrupted during unzip.

e setup.sh file which resides within the install archive was not transferred in
ASCII or text mode, which could have corrupted the file.

To correct this, follow the steps:

1. Copy the installer (in BINARY mode) to the system on which the OFSAA
Infrastructure components will be installed.

2. Unzip the installer using the command:
unzip <OFSAAI_Installer>.zip

3. The corrupted setup. sh file would have introduced certain ~M characters into
the file. You can remove M characters from setup.sh file by following the
below steps:

a. Login to the server where the installer is copied.
b. Navigate to the directory OFSAAI_80000.
c. Open the setup.sh file in the vi editor using the command: vi setup.sh.

d. Inside vi editor in Esc mode, type: %s/4M//g

Note: To enter “M, hold the CTRL key then press V and M in
succession.

e. Save the setup.sh file by typing: wq!
Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a
standard or enterprise edition. So, OFSAAI will work with standard edition as
well.

We do not recommend standard edition because it will not scale and does not
support partition pack, database security vault, or advanced analytics.

What should 1 do if I get the following error message while executing .Istartofsaai.sh
file on the UNIX System terminal "./startofsaai.sh: [java: Execute permission denied”?

e Ensure JAVA_BIN environment variable path is set on the "unix user"
terminal from where the . /startofsaai.sh file is invoked.

* Ensure the .profile where the environment/ path settings are made has
been executed successfully.

What should I do if the OFSAAI Login page does not open and I get the following
error message, "Could not retrieve list of locales”?

This could be due to 2 reasons:

¢ System is unable to resolve the hostname configured.
¢ Conflict with the ports configured.

To correct them, follow the below steps:

A. Steps to replace the hostnames with IP address:

1. Stop all the OFSAA services. For more information, see Stopping
Infrastructure Services.
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2. Replace all the hostnames with the IP address in all the places mentioned in
the document (Where to find port, IP address, HTTPS Configuration for
OFSAAI 7.2 Installation (DOC ID 1500479.1)).

3. Restart all the OFSAAI services. For more information, see Starting
Infrastructure Services section.

B. Steps to correct the port number conflicts
1. Stop all the OFSAA services.

2. See the port numbers stated in the document (Where to find port, IP address,
HTTPS Configuration for OFSAAI 7.2 Installation (DOC ID 1500479.1)) and
check on the discrepancy in the port numbers and correct them.

3. Restart all the OFSAAI services.

What happens when the OFSAAI Application Server does not proceed even after
providing the system password?

Ensure that, the System Password provided when prompted should match with
the "Oracle Configuration password" provided during installation. Also check
whether the connection to the "configuration schema" can be established through
sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers
are started, and the application URL is accessed, it gives an error message "the page
cannot be found or displayed” or "Could not retrieve list of languages from Server.
Please contact the system administrator”. What should one do?

Ensure OFSAAI servers have been started and are running successfully. On the
server start up parameters options, see Starting Infrastructure Services section.

For more details on the issue, see the Revappserver log in SFIC_APP_
HOME/common/FICServer/logs directory or the Web server log files.

Is it necessary to provide the specified grants to the Oracle schema user before
installation? If yes, can it be revoked after completing the installation?

The "Oracle schema" user requires the necessary grants specified before, during,
and after the installation process. Grants provided should never be revoked as the
application makes use of these grants all the time.

Can we have distributed OFSAAI Application Server for load balancing?

OFSAAI Application server can be scaled out/distributed across different JVM's
(machines) based on the various services and Information Domains, in other
words, Load balancing could be achieved with distribution of services.

Why do we need Ftpshare on all the layers? Can we have ftpshare on another machine
other than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the metadata related files used in
Infrastructure are stored in the ftpshare directory. The ftpshare contains folders for
each Information Domain, with each Information Domain folders holding Erwin,
log, and scripts folder. The transfer of data among the Web, Application, and
Database servers in Infrastructure takes place through FIP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers
by providing App server's FTP/SFTP credentials to the Web server and DB server
users.

Yes, we can have ftpshare on another machine other than the machines where
OFSAAL is installed.
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Is it mandatory to provide the ftp/sftp password?

Yes, OFSAAI needs credentials of the user which has complete permissions on
ftpshare directory, and should be able to independently login to the unix server.

What are the permissions required for ftpshare and when should I give them?

It is recommended to provide permissions on ftpshare in case of installations
done across different machines or VMs (multitier installation ).

In case of single tier installation, 770 permissions can be provided if the unix users
of OFSAAI and web server belong to the same unix group.

And on any new file that is created in the 'ftpshare' folder of any installation layer
should be granted specific/explicit permission.

Port Change utility could be used to have the Port number modified, which are
currently being used by the Infrastructure application. For more information, see
Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance section.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup

OFSAAL

e SYSADMN
e SYSAUTH
e GUEST

Does OFSAAI Application support both FTP and SFTP?
OFSAAI supports both FTP and SFTP configuration.
Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards
using the OFSAAL

OFSAAI Configuration: Unable to save the server details?
* Ensure the input User ID, Password, and Share Name are correct.
e Ensure FTP/SFTP services are enabled.
* Have a test FIP/SFIP connection made and confirm if they are successful.

What should I do if I get the following message while creating Information Domain,
"Please create a database and then create the information domain”?

Information Domain is mapped to only one Database; and thus before the creation
of Information Domain, at least one database details would need to exist.

What should I do if I get the following message during startup of backend engine
message server, "ConnectToDatabase: FatalError, could not connect to the DB server”?

Verity whether connection to the "configuration schema" can be established through
sqlplus.

* Verify "configuration schema" password is modified post installation.

e Ensure oracle database alias name created for oracle instance and oracle
service name are same.

e On a multi tier Installation mode, ensure TNSNAME and SID are the same in
both the Application and Database Layers.
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What should I do if I get the following message during the startup of backend engine
message servet, "Fatal Error, failed to get user ID from LibSmsConnect”?

Ensure Reveleus.sec file exist under the $FIC_HOME/ conf directory where the
Database components are installed.

Does OFSAAI Application support LDAP authentication?
OFSAAI supports LDAP configuration and authentication.
Does OFSAAI support multiple languages?
Yes, OFSAAI supports multiple languages.
Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is
recommended for back-up.

What kind of security features does the OFSAAI provide?
OFSAAI provides security at:
¢ Segment Level - Users can access only the segment they are mapped to.

* Application Level - Users can perform an operation only if mapped to
appropriate role and functions.

Does OFSAAI have the ability to enforce periodic password change?

OFSAAI provides configurable parameters to define number of days after which
the user password would expire and then the user is forced to change the
password after expiration period.

What is the password policy followed in OFSAAI?

OFSAAI enforces a minimum password length with a combination of Upper and
Lower case characters and alpha-numeric strings.

Which version of Erwin Data Modeler does OFSAAI support?

OFSAALI framework supports Data Modeler Erwin versions 9.0, 9.2, 9.6, and 9.7 for
backward compatibility. However, the data models shipped with version 8.0.5.0.0 of
the application packs are compatible with Erwin 9.5, 9.64, and 9.7.

Does OFSAAI provide the mechanism to upload Business Data model?
OFSAAI provides two mechanisms for business data model upload:

¢ Easy to use GUI based Model upload mechanism to upload the Business Data
Model through Unified Metadata Manager --> Import Model.

* OFSAAl also provides a model upload utility "upload.sh" for uploading the
business data model through the command line parameter by executing this
shell script file under the path <FIC_HOME>/ficapp/common/FICServer/bin.

See the section Run Model Upload Utility of the OFS Analytical Applications
Infrastructure User Guide available on OTN for details.

How do I apply incremental change to the existing model when the Business Data
model undergoes a change?

Modified data model can be uploaded into the system and OFSAALI has the ability
to compare the changes within the data model with respect to the one already
present in the system and enables propagation of incremental changes in a
consistent manner.

What are the different types of uploading a business data Model?
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OFSAAI supports uploading of business data model from client desktop and also
by picking up the data model from the server location.

Can the OFSAAI "Configuration Schema” password be modified post installation?

The OFSAAI "configuration schema" password can be modified post installation.
OFSAALI application stores the password in the database and few configuration
files, thus any changes to the "configuration schema" password would necessitate
updating in these. Contact OFSAAI support for more details.

Can the OFSAAI "Atomic Schema” password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application

stores the atomic schema password in the database and few configuration files,

thus any change to the atomic schema password would necessitate updating the
password.

To change the Atomic Schema password, follow the steps:
1. Login to OFSAA.

2. Navigate to System Configuration > Database Details window. Select the
appropriate connection, provide the modified password and save.

3. Navigate to Unified Metadata Manager > Technical Metadata> Data
Integrator > Define Sources window. Update the appropriate Source details.

a. If you are using Apache Tomcat as Web server:

*  Update the <Context> -> Resource tag details in server.xml file from the
$SCATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource>
will exist).

b. If you are using WebSphere as Web server:
*  Login to the WebSphere Administration Console from the left side menu.

*  Navigate to Resources >]JDBC >Data Sources. A list of data sources will be
populated on the right side.

*  Select the appropriate Data Source and edit the connection details. (In this
case, both Config and Atomic data sources need to be modified).

c. If you are using WebLogic as Web server:
*  Login to the WebLogic Administration Console from the left side menu.

*  Under Domain Structure list box, expand the appropriate Domain and
navigate to Services > JDBC >Data Sources. A list of data sources will be
populated on the right side.

*  Select the appropriate Data Source and edit the connection details. (In this
case, both Config and Atomic data sources need to be modified).

4. Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs
displays the message ORA-28000: the account is locked.

Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory
settings on the client and server machines. Java memory setting varies with the
data model size and the available RAM. Contact OFSAAI support for more details.

R-138 Oracle Financial Services Enterprise Case Management Application Pack



Frequently Asked Questions

Why do the Business Metadata Management screens (Business Processors screen) in
the User Interface, take more time to load than other screens?

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is
continuously being updated /refreshed to cache metadata. This can be observed
when you are starting startofsaai.sh and if any of the log file (Ex:
SMSService.log) in DynamicServices.xml is being continuously refreshed for
longer time.

By default, the Metadata Log file cache size is set to 1000. If in case the log is being
updated beyond this limit, retrospectively the preceding entries are overwritten.
For example, the 1001th entry is overwritten by deleting the first entry. This
results in the application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf,
depending on the currently logged count for the specific metadata.

1. Generate the Log report by executing the below query in config schema.
select count(l), t.metadata_name, m.dsn_id
from metadata_master m, metadata_type_master t
where m.metadata_type = t.metadata_type
group by t.metadata_name, m.dsn_id

2. The above query returns a list of codes with their respective metadata count.
You can see "metadata_type_master" table to identify the metadata name.

3. View the log report to identify the metadata which is being
updated/refreshed beyond the specified cache size limit. Accordingly increase
the cache size limit in Dynamicservices.xml depending on the currently
logged count for the specific metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total
measure reported in log is 1022, increase the limit to 2000 (approximately).

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.

What should I do if 1 get OutOfMemoryError while deploying EAR file in WebSphere
application server?

The Java memory needs to be increased in ejbdeploy . sh file which is present
under <WebSphere Install directory>/AppServer/deploytool/itp. For
example,

SJAVA_CMD \
-Xbootclasspath/a: Sejbd_bootpath \
Xms256m -Xmx1024m \
What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified
Metadata Manager- Import Model, you need to configure the required model size
in struts.xml file available in the path $FIC_WEB_

HOME /webroot /WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.
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For example, if you need to configure for model size of 2.5GB, then you can
approximately set the max size to 3GB (3221225472 bytes) as indicated below, in

order to avoid size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and
redeploy the application onto your configured web application server. For more
information on generating and deploying EAR / WAR file, see Appendix C.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes

to the underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the
underlying Hierarchy has been changed. This can occur in hierarchy maintenance,
where you have moved a member to another hierarchy branch, and that member
was explicitly selected in the Filter and is now a child of a node which is already

selected in the Filter.

See Support Note for the workaround.

Can I install an Applications Pack on an existing Atomic schemal Information

Domain created manually?

No, you cannot install an Applications Pack on existing Atomic schema /Information
Domain created manually. Applications Packs can be installed only on Atomic
Schemas/Information Domain created using schema creator utility and/ or the

Applications Pack installer.

What should I do if I get the following exception while trying to view the model
outputs in Model Outputs screen, "Exception ->Local Path/STAGE/Output file name

(No such file or directory)”?

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path"
in the web server details screen. This folder needs to be created under the local path on

every node, in case of web application server clustering.

What should I do if I get the following exception during OFSAA services startup,
"Exception in thread "main” java.lang.UnsatisfiedLinkError: net (Not a directory)”?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to

point to a physical JRE installed.

What is the optimized memory settings required for "New"” model upload?

The following table lists the optimized memory settings required for "New" model

upload.

Table R-1 Optimized Memory Settings for New Model Upload

X _ARGS_APP ENV
Size of Data Model Variable in OFSAAI
Model Upload Options XML File APP Layer
Pick from Server 106 MB "-Xms1024m
-Xmx1024m
36 MB "-Xms2048m
-Xmx2048m
815 MB "-Xms4096m
-Xmx4096m
1243 MB "-Xms6144m
-Xmx6144m
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Table R-1 Optimized Memory Settings for New Model Upload

X_ARGS_APP ENV
Size of Data Model Variable in OFSAAI
Model Upload Options XML File APP Layer

Model Upload Utility 106 MB "-Xms1024m
-Xmx1024m"-Xms2048
m -Xmx2048m

336 MB "-Xms4096m
-Xmx4096m

815 MB "-Xms4096m
-Xmx4096m

1243 MB "-Xms6144m
-Xmx6144m

Save New Erwin File In 106 MB "-Xms1024m
Server -Xmx1024m

336 MB "-Xms2048m
-Xmx2048m

"-Xms4096m
-Xmx4096m

"-Xms6144m
-Xmx6144m

What should I do if I get the following error message, "ORA 01792 maximum number
of columns in a table or view is 1000 during T2T execution”?

You should apply the below patch set from Oracle. Applicable only for 12c.
https:/ /support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1

I did not enable OFS Inline Processing Engine Application license during the
installation. However, I have enabled it post installation, using the Manage OFSAA
Product License(s) in the Admin UI. Are there any other additional configurations
that I need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine
Configuration Guide available on OTN.

I get an error when I try to build an Oracle OLAP cube. What should I do?

Execute the below grant on the appropriate ATOMIC schema
grant olap_user to &database_username

How do you turn off unused Information Domains (Infodoms) from caching?
Follow these steps to turn off unused infodoms from caching:

1. Navigate to $FIC_HOME/ conf in the APP layer of your OFSAAI installation.
2. Inthe DynamicServices.xml file, identify the section for <Service code="20">.
3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1).

Repeat the same in the WEB layer too. Generate the application EAR/WAR file
and redeploy the application onto your configured web application server. For
more information on generating and deploying EAR / WAR file, see Appendix C.

4. Restart the OFSAAI Services (APP and WEB). For more information, see the
Starting / Stopping Infrastructure Services. section
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Note: This setting helps cache the Infodom metadata only for the
infodoms that get accessed after user login. Infodoms which are not
accessed, are not cached.

Sample code is as follows:

<SERVICE CODE="20"
CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"
SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS>

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" />

<PARAMETER NAME="BACKUP_XML" VALUE="1" />

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" />

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" />

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" />
<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" />

<PARAMETER NAME="DATASET CACHE_SIZE" VALUE="2000" />

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" />

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" />

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" />

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" />

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" />
</PARAMETERS>

</SERVICE>

While creating an Excel Mapping, after specifying the excel worksheet, the target
table, and mapping each column in the worksheet to a target table, I click SAVE and
nothing happens. But when I click CANCEL, a message pops up informing me that all
changes will be discarded”, what is to be done?

Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on
machine. If so, upgrade the JRE plug in to 1.7+.

Can Multiple OFSAA Infrastructure instances share the same config schema?
No, only one OFSAA environment can be installed using one config schema.
Can Atomic schema be shared?

Yes, it can be shared between two OFSAA instances.
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While setting a firewall, which ports should be opened for communication between
the Web server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the
Web application server (WebSpherel WebLogic/ Tomcat) for OFSAAI to operate

properly?
The OFSAA Servlet port which is same as Web server port should be open. Also the
web application port should be open.

Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database
where older versions of OFSAA is Installed?

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not
intending to use multi language support.

Can I install already installed application in a different infodom?
No, it is not possible to install the same application in two different infodoms.
How can I configure the OFSAA application for High Availability??

OFSAA can have active-passive high availability. For more details, see Configuring
OFSAA in Clustered Environment Guide.

During OFSAA installation should I provide web application server’s IP [Hostname
and port or web server’s IP/[Hostname and port, if the Apache HTTP Server/ Oracle
HTTP Server/ IBM HTTP Server are configured?

In case the web server is configured, you should enter the Web server IP
Address/Hostname and Port details during OFSAA installation. Here the Servlet port
should be same as the Web server port.fl

If Web server is not configured, the Web application server's IP Address/ Hostname
and Port is required during the installation process. Here the Servlet port should
be same as the Web application Server port.

Is "ReveleusAdminConsoleAgent” applicable for OFSAAI 8.0.0.0.0 and higher
versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0.
There is a change in the way agentservers are managed through AGENTSTARTUP . SH
& AGENTSHUTDOWN . SH.

What should I do when the message server process does not open and I get the
following error message, "CI18NProvider::CI18NProvider, Error, unable to connect to
the config database”?

This error is displayed due to the following reasons:
* The Config Schema password is already expired.

¢ If the config schema password is going to expire soon and the message such
asflfl"ORA-28002: the passwordflflwill expire within 6 days" displays while
connecting to config schema through sqlplus.

¢ The Config schema password is Modified.

fliflTo resolve the error, re-set the config schema password to the old password. Else, if
the config schema password is modified to something else then follow the below steps:

1. Delete the $FIC_HOME/conf/Reveleus.SEC file.

2. Shutdown the OFSAAI App service: cd $FIC_APP_
HOME/Zcommon/FICServer/bin ./stopofsaai.sh
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3. Shutdown the OFSAAI App service: cd $FIC_APP_
HOME/common/FICServer/bin ./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through
XWindows software using the command: ./startofsaai.sh

5. Enter System Password.

6. Enter the new Config schema password. The service starts and initializes if it is
able to successfully connect to the DB and generates the Reveleus . SEC file.

7. Post successful startup of the service, if required, the Infrastructure server may be
shut down and restarted in the background using nohup mode.

What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under $FI1C_APP_HOME/common/FI1CServer/logs &
<OFSAAI_DEPLOYED_AREA>/<CONTEXT .war>/10gs is configurable in
RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max
backup log files (MaxBackupIndex) retained is set to 5, both of which are configurable.
Increasing these parameters to a higher value should depend on the server HW
configurations and may reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:
1. Navigate to $F1C_HOME/conT where OFSAA is installed.
2. Edit the following parameters in the file RevLog4jConfig.xml
* <param name="file" : Enter the path where the Logs are to be generated.
* <param name="MaxFileSize" : Provide the required file size.

* <param name="MaxBackupIndex" : Provide the required number of backup
files to be created.

Example:

<appender name="REVSERVERAPPENDER"
class=""org.apache.log4j.RollingFileAppender'>

<param name="file" value="$FIC_
HOME/ficapp/common/FICServer/logs/RevAppserver.log/>

<param name="Append" value=""true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackuplndex' value="5" />

<layout class="org.apache.log4j.PatternLayout'>

<param name="‘ConversionPattern" value=""[REVELEUSLOG] %m%n'/>
</layout>

</appender>

To configure the Deployed area logs file, follow these steps:

1. Navigate to <EAR/WAR Deploy area>/cont folder.

2. Repeat step 2 from the above section.

Can we modify the Log file path?

flYes, Log file path is configurable, it can be configured in
RevLog4jConTig.xml.default log file path (file) is set by the installer . This can be
configured to another path.
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Can I point the environment with HTTP enabled to HTTPS after installation and vice

versa?

Follow these steps:

1.
2.

6.

Create SSL related certificates and import to respective servers.

Enable SSL on a desired Port ( example 9443 ) on your existing and already
deployed web application servers.

Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) configured
and in all the URLSs specified on below files:

$FI1C_HOME/ficapp/common/FICServer/conf/FICWeb.cfg and $FIC_
HOME/ficweb/webroot/conf/FI1CWeb.cfg

$FIC_HOME/Ficapp/icc/conf/WSMREService.properties
$FIC_HOME/ficweb/webroot/conf/ModelExecution.properties
$FIC_HOME/ficdb/conf/MDBPubl ishExecution.properties
$FIC_HOME/Ficdb/conf/0ObjAppMap.properties
$FIC_HOME/utility/Migration/conf/WSMigration.properties
$FIC_HOME/utility/WSExecution/conf/WSExecution.properties

$FIC_
HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebServicelmpl
-wsdl

$FIC_
HOME/EXEWebService/Tomcat/ROOT/WEB- INF/wsdlI/EXEWebServicelmpl .ws
dl

$FIC_
HOME/EXEWebService/WebLogic/ROOT/WEB-INF/wsdl/EXEWebServicelmpl .
wsdl

Replace XML attribute/Node values as specified on below files:

$FI1C_HOME/ficweb/webroot/WEB-INF/web.xml
FIC_WEBSERVER_PORT=9443
FIC_WEBPROTOCOL=https

$FI1C_HOME/conf/LookUpServices.xml and $FIC_
HOME/ficweb/webroot/conf/LookUpServices.xml

PORT="9443" PROTOCOL=""https:"

Login to config schema and execute below SQL command to replace protocol and
SSL port.

SQL> update configuration cn set cn.paramvalue="9443" where
cn.paramname="SERVLET_ENGINE_PORT";

SQL> update configuration cn set
cn.paramvalue=replace(cn.paramvalue, "http: ", "https: ") where
cn._paramname="FormsManagerCacheReload" ;

SQL> update web_server_info ws set
ws.servletport="9443- ,ws.servletprotocol="https"~;

Create EAR/WAR file and Re-Deploy.

What should I do if the sliced data model upload takes a long time to complete?

If the metadata cache size is set to a lower value than the actual count of each
metadata type (hierarchy, dataset, dimension etc), then it gets into performance

FAQs and Error Dictionary R-145



Frequently Asked Questions

degrade issues. We have to increase the cache size for each metadata type according
to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on
the metadata count in your environment.

<PARAMETER NAME="HIERARCHY NODE_LIMIT" VALUE="2000"/>
<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="DATASET CACHE_SIZE" VALUE="2000"/>
<PARAMETER NAME="MEASURE_

CACHE_SIZE" VALUE="3000"/>

<PARAMETER NAME="HIERARCHY_

CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="DIMENSION_

CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE"

VALUE="2000"/>

<PARAMETER NAME="DERIVEDENTIT

Y _CACHE_SIZE" VALUE="1000"/>

Metadata count can be derived based on the following queries:

select count(l) from metadata master where metadata version=0 --- for all
metadata select count(l) from metadata _master where metadata_version=0
and metadata_type=1 --- for measure

select count(1l) from metadata _master where metadata_version=0 and
metadata_

type=2 --- for Dimension

select count(1l) from metadata _master where metadata_version=0 and

metadata_

type=3 --- for HCY

select count(1l) from metadata _master where metadata_version=0 and
metadata_

type=4 --- for DATASET

select count(l) from metadata_master wh
ere metadata_version=0 and metadata_

type=59 --- for BP's

select count(l) from metadata_master wh
ere metadata_version=0 and metadata_

type=54 --- for Alias

select count(l) from metadata_master wh

ere metadata_version=0 and metadata_
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type=5 --- for CUBES

select count(l) from metadata_master wh
ere metadata_version=0 and metadata_
type=856 --- for Derived Entit

For LDAP authentication, which server connects with the LDAP server, the
Application server (where ofsaai is installed), or Web Application server (where EAR
is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP
server.

The LDAP server in the setup listens on secure protocol ldaps ( port 636). I have the
root certificate of the LDAP server for SSL, and would like to know where to offload
this certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp
layer.

How to relocate FTPSHARE folder?

You can run the PortC jar utility. For more details, see Changing IP /Hostname, Ports,
Deployed Paths of the OFSAA Instance section in the OFSAAI Admin Guide available
on OTN.

How do we identify the list of ports that are used by/configured in an OFSAA
environment?

1. Navigate to $FIC_HOME folder on Target.
2. Run the PortC jar utitlity using the command:
java -jarPortC.jar DMP

A file with the name DefaultPorts.properties will be created under $FIC_HOME
directory which will contain the ports. For more information, see Changing

IP /Hostname, Ports, Deployed Paths of the OFSAA Instance section in the
OFSAAI Admin Guide available on OTN.

What should I do if I get the following error message, "Error while fetching open
cursor value Status : FAIL"?

This error occurs while executing envCheck.sh because the user does not have access
to V$parameter. This error does not occur due to sysdba or non sysdba privileges
provided they have access/grants to V$parameter.

Applications Pack 8.0.5.0.0 FAQs
What is an Applications Pack?

An Applications Pack is suite of products. For more information, see About OFSAA
Infrastructure.

Can I get a standalone installer for OFSAAI 8.0?

No. AAl s part of every Applications Pack and installs automatically.

How does OFSAA 8.0 Applications Pack relate to OFSAA 7.x series?

8.0 is a new major release consolidating all products from OFSAA product suite.

Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Applications Pack?
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There is no upgrade path available. However, we will have migration kit / path for
every product to 8.0 Applications Pack. Further details will be available with Oracle
Support Services.

Does OFSAA 8.0 Applications Pack UPGRADE automatically to existing
environments?

No. OFSAA 8.0 Applications Pack has to be installed in an new environment and
subsequently migration path / migration kit needs to be run to migrate from 7.x to 8.0.
Note that the objects can be migrated only from the previously released version of
OFSAA products..

Where can I download OFSAA 8.0 Applications Pack?

You can download the OFSAAI 8.0 Applications Pack from Oracle Software Delivery
Cloud (OSDC).

What are the minimum system and software requirements for OFSAA 8.0 Applications
Pack?

See installation guide section Hardware and Software Requirements.
Is my environment compatible with OFSAA 8.0 Applications Pack?

Environment Check utility performs the task. It is part of install and can also be run
separately.

Does the OFSAA 8.0.5.0.0 Applications Pack support all Operating systems?

OFSAA 8.0.5.0.0 Applications Pack supports the following Operating Systems: LINUX,
AIX, SOLARIS 10, 11. See Technology Matrix for the technology matrix that OFSAA
suite products are/ will be qualified on.

How can I install OFSAA 8.0.5.0.0 Applications Pack?

See Oracle Financial Services Advanced Analytical Infrastructure Installation And
Configuration Guide published in OTN for the Applications Pack installers.

Does this installation require any Third party Softwares?

Oracle Financial Services Advanced Analytical Infrastructure Installation And
Configuration Guide published in OTN lists the third party software that needs to be
installed.

What languages are supported during OFSAA 8.0.5.0.0 Applications Pack
installation?

US English is the language supported.

What mode of installations OFSAA Applications Pack supports? [i.e., Silent , GUI]
OFSAA Applications Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0.5.0.0 Applications Pack support Multi tier Installations?

OFSAA 8.0.5.0.0 supports only single tier installation. For more information see
OFSAAI FAQs section.

Does this Applications Pack validate all Pre-requisites required for this installation
i.e., Memory, Disk Space etc.?

Yes. The pre-requisite checks are done by the respective Applications Pack installer.

What happens if it aborts during installation of any application with in Applications
Pack?

You must restore the system and retrigger the installation
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Does this Applications Pack 'Roll Back' if any application installation fails due to
errors?

Rollback of installation is not supported.
Does the Applications Pack install all applications bundled?

All Applications Pack system files are installed but there is an option to enable the
licensed products.

Can I re-install any of the Applications Packs?
You can retrigger in case of failure.

Does this Applications Pack allow enabling | disabling any of the applications
installed?

Yes. You cannot disable once the product is enabled in an environment.

I have installed one application in an Applications Pack, can I install any of new
application within the Applications Pack later?

No, installation of additional applications is not required. If you wish to add an
application later, you can enable the application at that time.

How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAALI installations, each with their own
PFT/FTP installations and separate associated database instances and separate Web
server installations on the same server as long as adequate memory is allocated for
each instance and as long as each OFSA Al installation is installed using a separate
UNIX user and profile. Care should be taken if running multiple OFSA Al installations
on a single server. Adequate memory will be required for each installation as several
OFSAALI processes (model upload, DEFQ services, etc) take significant amounts of
memory. So it depends on your server memory.

Is it possible to Install OFSAA 8.0 Applications Pack on an existing 'Infodom’ where
another OFSAA 8.0 application is installed?

Yes. However, the Behavioral Detection Applications Pack and Compliance
Regulatory Reporting Applications Pack are the exceptions. They need to be installed
in a different INFODOM.

Can I select an Infodom in Applications Pack during installation?
Yes. You can select or change the required infodom.
Can I install all Applications Packs in a 'Single Infodom’?

Yes. But Behavioral Detection Applications Pack and Compliance Regulatory
Reporting Applications Pack are the exceptions. They need to be installed in a
different INFODOM.

Is it possible to install applications on different Infodom within the Applications
Pack? (For example, I want to install LRM & MR in two infodoms)

Applications within Applications Pack have to be installed in the same information
domain in the same environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.5.0.0?

You can install only one infodom during installation. But after installation, you can
create multiple infodoms.

Is the 'Data Model’ bundled specific to an Applications Pack or to an individual
application?
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A merged data model for all applications within the Applications Pack is bundled and
uploaded.

Is it possible to install OFS Enterprise Modeling later?

OFS Enterprise Modeling is a separate product and can be enabled as an option later
from any Applications Pack that bundles Enterprise Modeling.

Does the Applications Pack create sandbox automatically for the required
applications?

Yes, Sandbox creation is part of application install process.

Are upgrade Kits available for individual applications or the complete Applications
Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all
applications.

Can I upgrade AAI only?
Yes, you can upgrade AAI alone.

Can I upgrade one application within the Applications Pack? (For example, I want to
upgrade LRM in the Treasury Applications Pack, but not MR.)

No, an upgrade is applied to all applications in the Applications Pack.

Is it possible to uninstall any Application from the Applications Pack?

No, it is not possible to uninstall any Application from the Applications Pack.
Can I uninstall entire Applications Pack?

No, you cannot uninstall the Applications Pack.

Is it possible to uninstall only application and retain AAI in the installed
environment?

No, you cannot uninstall only the application and retain AAI in the installed
environment.

Does Applications Pack contain all Language Packs supported?
Language Packs need to be installed on 8.0 Applications Packs.

Can I install an Applications Pack over another Applications Pack (that is same
infodom or different infodom)?

Yes, you can install an Applications Pack over another Applications Pack in the same
information domain or different information domain. But Behavioral Detection
Applications Pack and Compliance Regulatory Reporting Applications Pack, Asset
Liability Management Applications Pack and Profitability Applications Pack are the
exceptions. They need to be installed in a different INFODOM.

Can I use an existing manually created schema as information domain for
Applications Pack installation?

No. Schemas required by OFSAA applications have to be created using Schema
Creator Utility.

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6
supports oracle 12c with some additional configurations. See the link
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_

12cdriver htm#JDBCA655 for additional configurations.
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What should I do if I get the following error message while running the schema
creator utility, "HostName in input xml is not matching with the local hostname”?

One possible reason could be the machine is configured for zonal partitioning. Ensure
all the known IP Addresses of the machine are present in the /etc/hosts file.

What are the Java versions supported in OFS AAAI Applications Pack version
8.0.5.0.0?

OFS AAAI Applications Pack supports Java 1.7.x and 1.8.x.
Is OFS AAAI Applications Pack version 8.0.5.0.0 supported on Java 8?

Yes. To install this release of the OFS AAAI Applications Pack version 8.0.5.0.0 on
Java 8. For more information, see specific notes mentioned in the sections Installer and
Installation Prerequisites, Configurations supported for Java 8, Configuring and
Executing Schema Creator Utility, Installing in GUI Mode, Installing in Silent Mode .

What should I do when I get "[ERROR] - Error : APP Setup bin file failed.” message
during OFS_Application_PACK installation?

This is a generic error message that appears during application installation failure.
You should check the installation log files for more information about what failed the
installation.

However, if the message is displayed and the log files are not generated, it could be
that it is a temp directory issue. The resolution is that your UNIX administrator has to
disable the NOEXEC option. The installers extract the installation files into the /tmp
directory, and if NOEXEC is enabled, execution of binaries will not happen in the
directory and the installation fails. Re-run the installer after the configuration is
changed. For detailed information, see the support note at

https:/ /support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.

Forms Framework FAQs
What should I do when I have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large
volume of data.

How do I export the columns added to the grid using Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field
Chooser option.

‘Expand Alll Collapse All’ button is not visible in the Hierarchy Browser window.
What should I do?

Expand All/ Collapse All button is enabled only if the number of hierarchy nodes is
less than 50. If it is more than that, it is considered as large hierarchy and the data will
be fetched dynamically when you expand each node.

What is the difference between the two Searches available in the Hierarchy Browser
window?

In the new Hierarchy Browser window introduced from 7.3.5.1.0 version, there are 2
search options available as highlighted in the following figure:
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* DB Search (Top search container): It will search the required node in database
and displays the result as shown below. This search is performed on full hierarchy
nodes.

e Ul search (Below the hierarchy): This search will find the required node in the Ul

and will show in tree structure.

Note: In case hierarchy nodes are more than 50 and if it is a
non-custom hierarchy, then the Ul search will not show the required
node in tree structure, until all the nodes are expanded and loaded
manually in the UL

What is a Custom Hierarchy?

Custom hierarchies will be having the parameter configuration customQuery as
shown below and the customized query will be taken from the HIERARCHY_FILTER_
MASTER table.

Configuration in xml:
<CONTROL 1D="1003" TYPE="'41">
<CONTROLPROPS>
<EXTRAPARAMETERS>
<PARAMETER NAME="customQuery" VALUE="'Yes'/>
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</EXTRAPARAMETERS>
</CONTROLPROPS>
</CONTROL>
For custom hierarchy, all the hierarchy nodes are loaded in UI without any limit.

So, even if the hierarchy nodes are more than 50, the Ul search will show the required
node in tree structure and ExpandAll and ExpandBranch images will be enabled.

Error Dictionary

This contents of this section has been created with the interest to help you resolve the
installation issues if any. There is a compilation of all the possible errors that might
arise during the installation process with the possible cause and the resolution to
quickly fix the issue and proceed further with the installation.

This section includes the following topics:
e Accessing Error Dictionary

e Error Code Dictionary

Accessing Error Dictionary

Instead of scrolling through the document to find the error code, you can use the pdf
search functionality. In the "Find" dialog available in any of the Adobe Acrobat version
that you are using to view the pdf document, follow the below instructions to quickly
find the error resolution.

1. With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on screen during Infrastructure installation.
4

Press Enter. The search results are displayed and highlighted as indicated below.

Figure R-1 Error Code

Error code - OFSAAI-1003

Catsa JAVA_HOME/bin ot found in PATH variable

Resolution | Import <JAVA_HOME>bin into PATH vanable

Example. PATH = SJAVA_HOMEbin SPATH export PATH

View the details of the issues, its cause, and resolution specific to the error code.
Repeat the step to find an answer to any other errors that you notice during
installation. If you are not able to resolve the issue even after following the steps
provided in resolution, you can contact support.oracle.com along with log files and
appropriate screen shots.
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Error Dictionary

Error Code Dictionary

Error code - OFSAAI-1001

Table R—-2 Error code - OFSAAI-1001

Cause Unix shell is not "korn" shell.
Resolution Change the shell type to "korn". Use chsh unix command to change
SHELL type.

Shell type can also be changed by specifying shell path for the Unix
user in /etc/passwd file.

Note: chsh command is not available in Solaris OS.

Error code - OFSAAI-1002

Table R—-3 Error code - OFSAAI-1002

Cause No proper arguments are available.
Resolution Provide proper arguments. Invoke Setup.sh using either Silent or
GUI mode.

Example: . /Setup.sh SILENT or ./Setup.sh GUI

Error code - OFSAAI-1004

Table R—4 Error code - OFSAAI-1004

Cause File .profileis not present in $HOME.

Resolution Create .profile in $HOME, i.e. in the home directory of user.

Error code - OFSAAI-1005

Table R-5 Error code - OFSAAI-1005

Cause File OFSAAInfrastructure.bin is not present in current folder.

Resolution Copy OFsAAInfrastructure.bin into installation kit directory.

Error code - OFSAAI-1006

Table R—6 Error code - OFSAAI-1006

Cause File CustReg.DAT is not present in current folder.

Resolution Copy CustReg.DAT into installation kit directory.

Error code - OFSAAI-1007

Table R—7 Error code - OFSAAI-1007

Cause File OFSAAI_InstallConfig.xml is not present in current folder.

Resolution Copy OFSAAI_InstallConfig.xml into installation kit directory.
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Error code - OFSAAI-1008

Table R—-8 Error code - OFSAAI-1008

Cause File validateXMLInputs.jar is not present in current folder.

Resolution Copy validateXMLInputs.jar into installation kit directory.

Error code - OFSAAI-1009

Table R-9 Error code - OFSAAI-1009

Cause File log4j.xml is not present in current folder.

Resolution Copy log4j.xml into installation kit directory.

Error code - OFSAAI-1010

Table R-10 Error code - OFSAAI-1010

Cause Unknown error occurred.

Resolution Make sure to provide proper argument (Silent or GUI) to the
Setup.sh file.

Error code - OFSAAI-1011

Table R-11 Error code - OFSAAI-1011

Cause XML validation failed.

Resolution Check InfrastructurePreValidations.Log for more details.

Error code - OFSAAI-1012

Table R-12 Error code - OFSAAI-1012

Cause Property file with locale name does not exist.

Resolution Copy MyResources_en_US.properties to the setup kit directory and
keep en_Us in LOCALE tag of OFSAAI_InstallConfig.xml.

Error code - OFSAAI-1013

Table R-13 Error code - OFSAAI-1013

Cause File OFSAAT_InstallConfig.xml/OFSAAI_PostInstallConfig.xml
not found.
Resolution Copy OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml

to the setup kit directory.

Error code - OFSAAI-1014

Table R-14 Error code - OFSAAI-1014

Cause XML node value is blank.

Resolution Make sure all node values except SMTPSERVER, PROXYHOST,
PROXYPORT, PROXYUSERNAME, PROXYPASSWORD,
NONPROXYHOST, or RAC_URL are not blank.
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Error code - OFSAAI-1015

Table R-15 Error code - OFSAAI-1015

Cause

XML is not well formed.

Resolution

Execute the command dos2unix OFSAAI_InstallConfig.xml to
convert plain text file from DOS/MAC format to UNIX format.

OR

Make sure that OFSAAI_InstallConfig.xml is valid. Try to open the
file through Internet Explorer for a quick way to check validity. If it
is not getting opened, create new OFSAAI_InstallConfig.xml using
the XML_Utility.jar.

Error code - OFSAAI-1016

Table R-16 Error code - OFSAAI-1016

Cause

User installation directory contain blank spaces.

Resolution

Provide an installation path that does not contain spaces. Check the
tag USER_INSTALL_DIR in OFSAAI_InstallConfig.xml file. This path
should not contain any spaces.

Error code - OFSAAI-1017

Table R-17 Error code - OFSAAI-1017

Cause

User installation directory is invalid.

Resolution

Provide a valid installation path. Check if you are able to create the
directory mentioned in USER_INSTALL_DIR tag value of OFSAAT_
InstallConfig.xml file.
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